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About this document

This document will help you find changes, or enhancements, in the new MetaSolv Solution 6.0 
release. The material is intended for current MetaSolv Solution users who are upgrading to the 
new release. 

This guide contains the following information for each enhancement (if applicable):

An overview that gives details about the enhancement
A reason for the change
How to find it in the software
Topics in Help that support the enhancement
New windows created for the enhancement

Using MetaSolv Solution Help
Context-sensitive Help can be used where ever you are in MetaSolv Solution. To access 
context-sensitive Help, click the Help link or Help button on the toolbar. Help displays 
information about the active window. You can select a procedure under the What do you 
want to do? heading, or if you need help with a specific field, you can click the field name to 
open a small window containing a description of the field.

If you want to view other Help topics, select from the menu on the left side of the Help 
window. You can drill down to specific procedures from the menu. When you make a 
selection, a list of related processes or procedures appears in the center of the window. These 
links either go directly to a procedure or expand into a hierarchy. The links that go to a 
procedure have a dot beside them. The links that expand have a plus sign beside them.

If applicable, each page contains a list of related concept, procedure, and FAQ links. These 
change depending on the subject matter. You can use the full text search to look up any 
information in Help. The Search field is located on every Help page except the field definition 
pages.
 What’s New ix



Additional information and help
To get additional information or help for MetaSolv Solution, refer to the following resources:

Oracle E-Delivery—Provides access to product software and documentation.
Visit the E-Delivery Web site at http://edelivery.oracle.com.
Software and product documentation are contained in the Oracle Communications 
MetaSolv Solution 6.0 Media Pack.
Developer documentation is contained in the Oracle Communications MetaSolv 
Solution Developer Documentation Pack. Access to developer documentation 
requires a password.

Oracle MetaLink—Provides access to software patches and a searchable Knowledge 
Base.

Visit the MetaLink Web site at https://metalink.oracle.com/, and log on using your 
User Name and Password.
Click the Patches & Updates tab to search for patches (efixes).
Click the Knowledge tab to search for technical bulletins, fixed issues, and additional 
product information. To narrow your search, click the Communication Apps link 
under Product Categories on the left side of the page.

Oracle Support
The preferred method of reporting service requests (SRs) is through MetaLink. MetaLink is 
available 24 hours a day, 7 days a week. 

Although it is Oracle’s preference that you use MetaLink to log SRs electronically, you can 
also contact Support by telephone. If you choose to contact Support by phone, a support 
engineer will gather all the information regarding your technical issue into a new SR. After the 
SR is assigned to a technical engineer, that person will contact you.

For urgent, Severity 1 technical issues, you can either use MetaLink or you can call Support. 
Oracle Support can be reached locally in each country. To find the contact information for 
your country, go to http://www.oracle.com/support/contact.html. 
x MetaSolv Software, Inc.



MetaSolv Solution 6.0 documentation set
MetaSolv Solution 6.0 documentation set
In addition to the What’s New guide, MetaSolv provides a set of documents that helps you 
understand and use MetaSolv Solution 6.0. Figure 1 shows the complete documentation set. 

Figure 1: MetaSolv Solution 6.0 documentation set

MetaSolv Solution books are delivered in Portable Document Format (PDF). You can view a 
book online using Adobe Acrobat Reader.

To view a document

Locate the document on the Oracle E-Delivery or Oracle MetaLink Web site and do one of the 
following:

Right-click the PDF file and select Open from the pop-up menu.
Double-click the PDF file.

This action starts Acrobat Reader and opens the PDF document you selected. The following 
figure shows how a document appears in Acrobat Reader:

Setup Guide API Reference

APIsInformation for ongoing
system maintenance

Initial installation
and configuration

Administration
Guide Online Help

Tasks performed by
individuals using the

product

MetaSolv Solution
Documentation Set

Security Windows
List

API Online
Reference

Planning Guide
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Figure 2: Finding information in a PDF document

Click here to search for a specific topics 
or words in the document

Click on topics in the 
Bookmarks tab to find 
specific topics in the 
document
xii MetaSolv Software, Inc.



1

Software architecture changes
This release has some basic software architecture changes. This section explains how 
MetaSolv Solution has changed for this release.

How MetaSolv Solution 6.0 is different from previous 
releases

The 6.0 release of MetaSolv Solution moves to new versions of the following third-party 
software:

Application server—BEA WebLogic Server 7 SP4 and a new version of the Oracle 
client, version 9.2.0.3. (In version 6.0.3, BEA WebLogic Server 8.1 SP3 and the 
Oracle client 9.2.0.3 are required.)

The Novell Extend (Silverstream) application server is no longer supported.

Database—Oracle Enterprise 9i Relational Database 

MetaSolv Solution 6.0 works with Oracle 9.2.0.3 or higher

Orb management—jBroker 4.0.2
Previously, the client workstation had a direct connection to the database in addition to the 
application server connection. This is no longer true. Client workstations connect to the 
database only through the application server for core (tbs.exe) functionality. This means 
that failover capability is important in keeping your system up and running in the event of 
hardware or software failure. MetaSolv recommends using clustered servers and load 
MetaSolv Solution What’s New 1



Chapter 1: Software architecture changes
balancing to ensure that your system has redundancy and can continue to operate if a 
server shuts down inadvertently during operation.

Figure 3: MetaSolv Solution data flow

About the client installation
The zero admin client, which is new with this release, is an automated way to fan out client 
workstation installations and to update existing MetaSolv Solution 6.0 installations when 
upgrades or service packs occur. The following list explains how it works and its benefits.

What is it?

The zero admin client is a software program that resides on the application server and 
automatically installs client files to a workstation when a user clicks a specified browser 
link. You can configure the client installation and provide the required links to users. 
When a user clicks the link, the zero admin client installs client files to the user’s 
workstation.

How does it work after the initial installation?

Users can copy their links to the workstation desktop and start the application from there. 
Each time a user clicks the link to start the client application, the client file versions are 
checked against the versions of files stored on the application server. If a difference exists, 
the application server files are downloaded to the client workstation, ensuring the client 
files always have the latest changes.

What are the benefits?
Initial installations can be distributed over the network.
Upgrades or changes to the software are downloaded automatically when the user 
starts the application through the browser link.

Is it optional?

Yes, using the zero admin client is optional. You can both install and upgrade the 
MetaSolv Solution client without using the zero system admin. Users can also start the 
application without using the browser link.

Database

Client

Application
 Server

Database

Client

Application
 Server

Before Release 6.0 Release 6.0
2 MetaSolv Software, Inc.



Documentation changes
Documentation changes
MetaSolv Solution 6.0 is different from previous releases due to its content, its installation, 
and the new releases of third-party software that it requires. Anticipating the need for more 
information for the installer and the administrator for MetaSolv Solution 6.0, MetaSolv 
Documentation split this information into two documents, the MetaSolv Solution Setup Guide 
and the MetaSolv Solution Administration Guide. 
MetaSolv Solution What’s New 3
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Usability changes

The MetaSolv Solution interface has been updated to reflect a browser-based look and feel. 
The update includes several navigation and interface controls that are becoming standard 
across Web and browser-based applications.

Figure 4: New home page for MetaSolv Solution 6.0

The overall navigation of the application has been improved in the following ways:

New navigation bar

Menu and toolbars were moved from the Windows model at the top of the screen to the 
new browser-based model of a navigation bar with panels on the left side of the screen. 
MetaSolv Solution What’s New 5



Chapter 2: Usability changes
Menu organization

Menus have been reworked and improved to reflect the operations and processes common 
in communications today.

Customization

Navigation bar customization lets you group commonly used links into one place for easy 
access. 

Navigation Bar

Figure 5: MetaSolv Solution navigation bar

The My Desktop link at the top of the navigation bar returns you to the home page.

The Hide Navbar/Show Navbar link at the top of the navigation bar expands and collapses to 
create more viewable space if you’re going to be in one area for awhile.

There are six sliding groups of links on the navigation bar. The standard navigation is 
available when you select the Navbar tab at the bottom of the navigation bar. 

Click here from anywhere in the 
application to return to the Home page

Click here to hide the toolbar to 
increase your work area, or click 
here to show the toolbar when 
you need it

The Navigation bar contains six 
groups. Each group slides open when 
you click it to reveal links that let you 
work in the application.
6 MetaSolv Software, Inc.



Navigation Bar
The Navbar groups include:

Home

This group contains commonly used links, like preferences, 
your work queue, and the background processor.

Inventory Management

This group contains links to work areas that were previously 
under the Engineering button. Included are links to Network 
Systems, Equipment Inventory, and IP Address Management.
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Order Management

This group contains links previously found under the Customer 
Care button. Included are links to Customers, Trouble 
Management, and Service Requests.

Application Setup

This group contains links to data setup that were previously 
found in the Infrastructure menu. The links include five setup 
pages, Structured Formats, and User Data.

Administration

This group contains links to general application features, 
including Security, Software Options, and Preferences.

Reporting

This group contains links to system reports.
8 MetaSolv Software, Inc.



Setup pages
Setup pages
Five setup pages replace the functionality of the Infrastructure menu that appeared in previous 
releases. The setup process is usually a one time event, and the new structure helps you set the 
MetaSolv Solution for your company’s specific business needs. These pages reduce the 
number of links on the navigation bar, simplifying it and making it easier to use. 

The setup pages are found in one location under the Application 
Setup group, and they include:

Inventory Management
Location and Geography
Order Management
Organization
Work Management

The following figures shows the setup pages. Each page is divided into a number of categories 
with links.

Figure 6: Inventory Management Setup
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Figure 7: Location and Geography Setup
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Setup pages
Figure 8: Order Management Setup
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Figure 9: Organization Setup
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Setup pages
Figure 10: Work Management Setup
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Find Links feature
This feature is useful if you don’t know exactly where a feature is in the interface or if you just 
want a faster route to the feature without using the navigation bar. 

Type the name of the feature or a topic for which you want to find a link in the Link field and 
press ENTER. 

Figure 11: Find Links

Customizing navigation
MetaSolv Solution 6.0 is shipped with the standard navigation you see on the Navbar tab, 
which is identified at the bottom of the navigation bar. You can select the My Navbar tab and 
customize this navigation bar to suit your needs. After you modify the navigation bar, the My 
Navbar tab is the default to appear, but you can still select the Navbar tab at any time to view 
the standard navigation.

On the My Navbar tab, you can create your own groups, which can contain any link on the 
Navbar tab or the setup pages. You can also create links to external files or applications on the 
My Navbar tab.

Click here to display the 
page in the right pane and 
search for a link

Type the name of a link or a topic 
that you want to find a link for and 
press ENTER
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Customizing navigation
The Allow Users to Customize My Desktop preference controls global user permission to 
customize the navigation bar and portlets on My Desktop. See the "My Desktop Portlets" 
section for more information on portlets. 

When the preference is set to Y, a user can customize his or her navigation bar and portlets on 
My Desktop. A system user can be defined in the gateway.ini file. If the system user creates a 
custom navigation bar, each user’s My Navbar reflects the system user changes. However, the 
individual user can further modify the My Navbar with changes that only he or she will see. If 
the system user has not customized the navigation bar, every user sees a blank My Navbar tab.

When the preference is set to N (default setting), users cannot customize the navigation bar or 
portlets on My Desktop. However, a system user set in the gateway.ini can customize the 
settings. In this case, every My Navbar and My Desktop matches the system user settings and 
an individual user cannot make changes.

From the Options menu, select Customize Navigation Bar to access these features.

Figure 12: Customize My Navbar
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Figure 13: Add a group and assign links to that group on the My Navbar tab
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Customizing navigation
Figure 14: Edit a group
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Figure 15: Create external links on the My Navbar tab
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My Desktop portlets
Figure 16: Change the order of My Navbar groups

My Desktop portlets
The MetaSolv Solution 6.0 home page is called My Desktop. My Desktop replaces 
QuickLinks and provides additional features. Out of the box, My Desktop provides direct 
access to service requests and tasks, the most frequently accessed areas of the software. In 
addition, a customizable links area is available where you can add links to any URL. This 
feature allows you to create an environment tailored to your individual tasks and preferences. 
In addition, you can add custom portlets with direct access to management reports or other 
information.

The Allow Users to Customize My Desktop preference controls user permission to customize 
the navigation bar and portlets on My Desktop. See the "Customize the Navigation" section 
for more information on navigation.
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When the preference is set to Y, each user can customize his or her navigation bar and 
portlets on My Desktop. A system user can be defined in the gateway.ini file. If the 
system user has created a custom navigation bar, each user's My Navbar reflects those 
changes. However, the user can further modify the My Navbar with changes only he or 
she will see. If the system user has not customized the navigation bar, every user sees a 
blank My Navbar tab.

When the preference is set to N (default), users cannot customize the navigation bar or 
portlets on My Desktop. However, a system user able to customize the settings can be 
set in the gateway.ini file. Then, every other user's My Navbar and My Desktop match 
the settings put in place by the system user.

From the Options menu, select Customize My Desktop to access these features.

Figure 17: Edit portlets layout
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My Desktop portlets
Figure 18: Add portlets to My Desktop
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Change Color Schemes feature
You can change the color scheme of MetaSolv Solution 6.0. From the Options menu, select 
Change Color Schemes. If you do not want the default color scheme, there are four additional 
color schemes you can select.

Figure 19: Change Color Schemes
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3

Enhancements
This chapter explains new enhancements that were added to the features in the MetaSolv 
Solution application.

New system administration features
MetaSolv Solution provides several new tools for system administration that make it possible 
to streamline day-to-day administration activities. The following sections describe these tools.

Using the Runtime Information page
A Runtime Information page can be accessed for each application server. The page provides 
standard information and also provides links to things such as the application server console, 
connection pools, and the new Log File Viewer, described below. For more on using the 
Runtime Information page, see the MetaSolv Solution Administration Guide.

Using the new log file viewer
MetaSolv Solution 6.0 has added a number of streamlined capabilities for using log files. 
Among these enhancements are:

Unnecessary shutdowns can be avoided now that logging can be activated or changed 
dynamically 
All modules are now tracked in one log file and each can have a different level of logging
A backup log file serves as a catch-all for development changes that have been 
accidentally omitted from the main log 
Alerts can be established through the log configuration file

For instructions on using the Log File Viewer, see the MetaSolv Solution Administration 
Guide.

Using an audit trail log file
Security administrators can use an audit trail log file to trace user logons and logouts on 
MetaSolv Solution.

For instructions on using the audit trail, see the MetaSolv Solution Administration Guide. 
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Setting alarms
SNMP protocol is now enabled through the logging configuration file, allowing our 
application to be reviewed by any SNMP-based application management console. 

For instructions on setting alarms, see the MetaSolv Solution Administration Guide. 

Application Setup 

End User Location Maintenance window Customer Accounts 
tab

The End User Location Maintenance window includes a new tab entitled the Customer 
Accounts tab. This tab displays each customer account with the location used on an order, the 
customer account number, and the status of the customer account.

The Address Change Impact window has also been modified as follows:

The window text was modified to indicate the decision being made concerns the way 
address changes are applied.
The current address (before your changes) appears on the window.
E911 impacts (telephone numbers) include the telephone number suffix, status, and 
location name.

To access this enhancement 

1. Select Application Setup on the navigation bar, and click Location and Geography 
Setup.

2. Click the End User Locations link.

The End User Location Maintenance window - Customer Accounts tab follows:
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Connection design engine
Figure 20: End User Location Maintenance window - Customer Accounts tab

Connection design engine
Unlike the multiple design engines used in the past, now there is one connection design engine 
for physical and virtual connections used for both ordered and unordered connections. You 
access the same design engine from network design, connection design, and the work queue 
manager. A graphical design is provided for all connections.

As a new capability in this release, optical networks are supported, which means you can use a 
new optical network block on the design lines, and you can reconcile optical network 
connections. 

You can print a CLR, DLR, GLR or other design output from this design engine.

To access this enhancement from connection design

1. Select Inventory Management on the navigation bar, and click the Connection Design 
link.

2. Enter search criteria and click the Retrieve button.

3. Double-click to open a connection.
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To access from network design

1. Select Inventory Management on the navigation bar, and click the Network Systems 
link.

2. Right-click a connection and select Properties from the pop-up menu.

3. Right-click an existing connection or create a new connection, and select Connection 
Maintenance from the pop-up menu.

To access this enhancement from the work queue

1. Select Home on the navigation bar, and click the My Work Queue link.

2. Double-click to open a design task.

3. Double-click to open a connection.

For more information on this enhancement, see the following topics in Help: 

Entering Connection Design Information
Designing a Virtual Connection

There are no new windows as a result of this enhancement, but the existing windows have a 
different look. Changed windows for both physical and virtual circuits include:

Connection Summary 
Additional Detail
Properties
CLR/DLR Design
Schematic Design

The following figure shows a Connection Summary for a physical connection. You can get to 
all of the windows in the previous list from links on the Connection Summary page. The 
windows for virtual circuits are similar and have the same links.
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Optical technology module
Figure 21: Connection Summary

Optical technology module
This enhancement provides network design and provisioning support for DWDM and meshed 
SONET networks through the Optical Technology Module, a new software option that can be 
purchased.

Traditional SONET networks including UPSR and BLSR will continue to be designed through 
the current SONET functionality, but that functionality will be accessed like any other 
network system. There is a graphical tool to facilitate navigation between SONET networks 
designed with the new technology module and those designed in the traditional SONET 
module. 

The new module also includes auto build functionality and a network connection hierarchy. 

For provisioning, the provisioning assistant, which includes path analysis, has been enhanced 
to aid the user in provisioning connections over networks built with the new Optical 
Technology module.

To access this enhancement from network templates

1. Select Inventory Management on the navigation bar, and click the Inventory 
Management Setup link.

Click one of these links to 
see windows associated 
with connection design. 
This layout is the same for 
both physical and virtual 
connections.
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2. Click the Network Templates link in the Network/Equipment section.

3. Expand Optical list.

4. Double-click the Optical Network or Optical Sub-Network.

To access from network design

1. Select Inventory Management on the navigation bar, and click the Network Systems 
link.

2. Expand the Optical list.

3. Do one of the following:

Select the optical template, right-click and select Add Network Design.
Expand Optical, and double-click to open an existing optical network.

To access this enhancement from the work queue

1. Select Home on the navigation bar, and click the My Work Queue link.

2. Double-click to open a design task.

3. Double-click to open a connection.

4. Click the Network link.

For more information on this enhancement, see the following topics in Help: 

Adding an Optical Assignment
SONET and Optical Overview
Provisioning Assistant

New windows include:

Provisioning Assistant: Search for Entry and Exit Drop Nodes
Provisioning Assistant: Select Entry Drop Node
Provisioning Assistant: Select Exit Drop Node
Provisioning Assistant: Select Working Path
Provisioning Assistant: Edit Working Path
Provisioning Assistant: Select Port Assignments
Provisioning Assistant: Select Connection
Provisioning Assistant: Select Channel Assignments
Provisioning Assistant: Select Protect Path
Provisioning Assistant: Edit Protect Path
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Optical technology module
Figure 22: Provisioning Assistant–Search for Entry and Exit Drop Nodes
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Figure 23: Provisioning Assistant–Select Entry Drop Node
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Optical technology module
Figure 24: Provisioning Assistant–Select Exit Drop Node
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Figure 25: Provisioning Assistant–Select Working Path
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Optical technology module
Figure 26: Provisioning Assistant–Edit Working Path
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Figure 27: Provisioning Assistant–Select Port Assignments
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Optical technology module
Figure 28: Provisioning Assistant–Select Connection
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Figure 29: Provisioning Assistant–Select Channel Assignments
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Optical technology module
Figure 30: Provisioning Assistant: Select Protect Path
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Figure 31: Provisioning Assistant–Edit Protect Path
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Inventory Management
Inventory Management

Engineering work order
This enhancement improves user productivity by reducing order and workflow overhead. It is 
a simple way to manage your inventory without requiring a customer order. It allows you to 
create and maintain connections with varying connection types, locations, and activities. You 
can install equipment, assign workflow for the order, and attach links.

To access this enhancement

1. Make sure the software option is turned on for Engineering Work Order.

2. Select Inventory Management on the navigation panel, and click Engineering Work 
Orders.

For more information on this enhancement, see the following topics in Help: 

User EWO Plan Preference
System EWO Plan Preference
Enter Engineering Work Orders

New windows include:

Engineering Work Order Search
Engineering Work Order
Engineering Work Order - Summary
Engineering Work Order - Manage Connections
Engineering Work Order - Manage Equipment
Engineering Work Order - Manage Tasks
Engineering Work Order - Manage Links
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Figure 32: Engineering Work Order Search
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Inventory Management
Figure 33: Engineering Work Order
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The following figure shows a Work Order Summary. You can get to most of the windows in 
the previous list from links on the Work Order Summary page. 

Figure 34: Engineering Work Order Summary

This enhancement created the following new preferences under Inventory 
Management>Engineering Work Order:

System EWO Plan
User EWO Plan

Click here to see additional 
pages of the work order 
summary.
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Filter equipment treeviews
This enhancement allows you to show only available mounting positions in the equipment 
treeviews. You can select this option while in the equipment treeview. Although you can set a 
preference to suppress occupied positions as the default, you can override the default from the 
equipment treeview. This a right-click menu option used on a per view basis, and changing the 
view while you are in the treeview does not affect the preference setting.

To access this enhancement 

1. Select Inventory Management on the navigation bar, and click Equipment Inventory. 

2. Enter search criteria and click the Search button. 

3. Right-click and select Suppress Occupied Positions from the pop-up menu.

For more information on this enhancement, see the following topics in Help: 

Preferences 
Viewing Equipment on a Relay Rack

This enhancement created the following new preference under Inventory 
Management>Equipment>Equipment Inventory:

Suppress Occupied Positions
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User-defined structure hierarchy
This enhancement allows a user to create user-defined structure hierarchies when performing 
equipment installs. The structure is viewable on the connection design.

To access user-defined structure hierarchy types

1. Select Inventory Management on the navigation bar, and click the Equipment 
Inventory link.

2. Enter search criteria in the Network Location drop-down and click the Search button.

3. Do one of the following:

Select Options>Structure Types from the menu to create a new structure type.

or

Right-click the canvas, and select Add Structure Item to add an existing structure type to 
a location.

For more information on this enhancement, see the following topics in the online Help: 

Adding an Equipment Structure Type
Adding a Structure Item to the Equipment Structure Hierarchy

New windows include:

Equipment Structure Type List window
Add an Equipment Structure Type window
Add Structure Item window
Equipment Inventory window
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Figure 35: Equipment Structure Type List window

Figure 36: Add an Equipment Structure Type window
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Figure 37: Add Structure Item window

Figure 38: Equipment Inventory window
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Inventory Management
Network element enhancements
In this release, with the implementation of the network element support, MetaSolv designed a 
centralized interface, where network elements, regardless of where they are created (SONET, 
Network Design, or standalone), can be viewed and manipulated, with an option to navigate to 
the network where the element resides. This aligns with the MetaSolv goal to make release 6.0 
more functionally consistent. The current SONET equipment constraint will be removed to 
allow more than one piece of equipment to be associated with a node.

This enhancement allows a user to create network element types and associate the types with 
equipment specifications. When you specify a network element type for an equipment 
specification, you are indicating that equipment installed from the specification should be 
associated with a network element.

You can also associate component types on network templates with multiple network element 
types. To create a network element for a component when designing a network, choose a value 
from the Network Element Type drop-down list.

Hybrid network elements will be supported. For example, some ATM switches support ATM 
and IP technologies. This model allows you to specify one or more technologies. For example, 
some ATM switches provide switch and routing functions. Use of role pattern allows you to 
add zero or more roles (switch, router). One technology network element can provide multiple 
technology interfaces.

You will see this enhancement in several areas of the application:

To access network element types

1. Select Inventory Management on the navigation bar, and click Inventory Management 
Setup.

2. Click the Network Element Types link.

To access network element type associations to components

1. Select Inventory Management on the navigation bar, and click Inventory Management 
Setup.

2. Click the Network Templates link in the Network/Equipment section.

3. Click the Component Types panel.

4. Right-click a component and select Properties from the pop-up menu.

5. Click the Element Types link.
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To access network element types to equipment specifications

1. Select Inventory Management on the navigation bar, and click Inventory Management 
Setup.

2. Click the Equipment Specifications link in the Network/Equipment section.

3. Do one of the following:

Click the Add New link.
Enter search criteria, click Retrieve, and open the specification.

4. On the Equipment Spec tab, select an element type in the Element Type drop-down. 

To access network element types in network system design

1. Select Inventory Management on the navigation bar, and click Network Systems.

2. Open or create a network with components.

3. Right-click a component, and select Properties from the right-click menu.

4. Select the General tab.

5. Select a network element type from the Network Element Type drop-down.

To access network elements

Select Inventory Management on the navigation bar, and click the Network Elements 
link.

To access network element from installed equipment

1. Select Inventory Management on the navigation bar, and click Equipment Inventory.

2. Search for a location.

3. Right-click a piece of equipment and select Edit.

4. Select the Equipment tab.

5. Click the Search button next to the Network Element field.

For more information on this enhancement, see the following topics in Help: 

Network Element Overview
Define Network Elements
Associate a Network Element Type to an Equipment Specification
Add a Network Element Type Association to a Component
Create a Network Element
Associate an Element with a Network
Copy a Network Element Type
View a Network Element Type
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Create a Network Element Type

New windows include:

Network Element Types window
Network Element Types – New window

Figure 39: Network Element Types window
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Figure 40: Network Element Type - New window

New words or acronyms include:

Components—The graphics on network design originally called elements.

LERG 
The LERG 6 files have been combined under the LERG 13 files. 

To access this enhancement

1. Run LERG and log on.

2. Click the Configure button on the main toolbar.

3. Expand the LERG13 files under the Select Files To Configure section of the File 
Configurations tab.
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Ordering

PSR usability changes
The PSR user interface has changed to make it easier to use. All the same functionality is still 
available. Many items which were previously only available through right-click are now 
available in a left-hand navigation area. Depending on what is selected, the available items in 
the navigation area change to only include valid actions. The information tabs for Services and 
Order Information have been separated so you can view one group without the other. The 
information tabs for a PSR also change based on what is selected in the hierarchy. Much of the 
information on the tabs can be edited directly. In addition, the Labels and Values have been 
added as a tab to the PSR user interface. 

To access this enhancement

Select Order Management on the navigation bar and click one of the following links:
New Product Service Request to create a new PSR.
Service Requests to search for and open an existing PSR.

For more information on this enhancement, see the following topics in the online Help: 

Creating a PSR
Product Service Request window

New windows include:

Create or Select a Customer for a New Product Service Request window
Product Service Request window
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Figure 41: Create or Select a Customer for a New Product Service Request window 
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Figure 42: Product Service Request - Order Information
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Figure 43: Product Service Request - Services

Attach linked documents
A Links tab has been added to ISR, ASR, LSR, PSR, and EWO. This tab allows you to add a 
link to a Web site, a file on the network, or an e-mail address. Created links are also accessed 
or deleted from this tab.

To access this enhancement in ISR

1. Select Order Management on the navigation bar, and click Service Requests.

2. Search by ISR.

3. Open the ISR you want to view.

4. Select the Links tab.
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To access this enhancement in PSR

1. Select Order Management on the navigation bar, and click Service Requests.

2. Search by PSR.

3. Open the PSR you want to view.

4. Click the Order Information link under Order Maintenance.

5. Select the Links tab.

To find out more about this enhancement, see the following topics in the online Help: 

Adding a Link to an ISR
Adding a Link to a PSR

New windows include:

Internal Service Request Window - Links Tab
Product Service Request Window - Order Information/Links Tab

The following figure shows the Links tab that appears in ISR and PSR.

Figure 44: Links tab
MetaSolv Solution What’s New 55



Chapter 4: 
Copy attributes
Copy Attributes is no longer specifically for circuits. You can copy attributes from other tabs 
(such as PIC Info, Access Info, Labels and Values) to other like items.

To access this enhancement

1. Search for or enter a PSR.

2. Click the Services link in the Order Maintenance section.

3. From the treeview, select the appropriate item under the corresponding parent product.

4. Right-click and select Copy Attributes from the pop-up menu.

For more information on this enhancement, see the following topics in Help: 

Copy Attributes Window
Copying/Updating Attributes in a PSR

Security
Security has a New From ability for users and groups. This enhancement lets you create new 
users or groups based on existing users or groups. You can also copy or merge users or groups.

To access this enhancement

1. Select Administration on the navigation bar, and click Security Users and Groups.

2. Select the Users or Groups folder.

3. Do one of the following:

Right-click an existing user or group and select New From the pop-up menu.
Right-click an existing user or group and select Copy from the pop-up menu.

For more information on this enhancement, see the following topics in Help: 

Creating a User
Creating a Group
Copying or Merging a User
Copying or Merging a Group
56 MetaSolv Software, Inc.



Trouble ticket templates
Trouble ticket templates
This enhancement lets you create a basic template for trouble tickets. These templates can then 
be associated with new trouble tickets and will automatically supply much of the information 
for the ticket.

To access this enhancement

1. Select Order Management on the navigation bar, and click Trouble Ticket Templates.

2. Click the Add New link.

For more information on this enhancement, see the following topics in the online Help: 

Creating a Ticket Template
Searching for a Ticket Template
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Work Management

Rules and behaviors
The Rules and Behaviors interface was redesigned to make the process of creating rules and 
behaviors more intuitive and streamlined. The procedures for defining rules, and adding task 
behaviors and gateway events to a rule, were moved from tabs to separate windows that act 
like a wizard to walk you through the process. Also, you can create more complex rules by 
using the new parentheses fields to group conditions that must be met for rule behaviors to 
initiate. 

To access this enhancement

1. Select Application Setup on the navigation bar, and click Work Management Setup.

2. Click the Rules and Behaviors link.

For more information on this enhancement, see the following topics in Help: 

Adding an Expression to a Rule
Adding a Gateway Event Behavior to Rule
Adding a Task Behavior to a Rule
Changing the Order of Task Behaviors
Creating a Rule
Rules and Behaviors
Rules and Behaviors Process
Setting the Priority for Gateway Event Behaviors

New windows include:

Rules and Behaviors window
Rule Window
Rule Summary window
Expression window
Task Behaviors window
Order of Task Behaviors window
Task Behavior window
Gateway Event Behaviors window
Gateway Event Behavior window
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Figure 45: Rules and Behaviors window
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Work Management
Figure 46: Rule window
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Figure 47: Rule Summary window
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Figure 48: Expression window
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Figure 49: Task Behaviors window
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Figure 50: Order of Task Behaviors window
MetaSolv Solution What’s New 65



Chapter 5: 
Figure 51: Task Behavior window
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Work Management
Figure 52: Gateway Event Behaviors window
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Figure 53: Gateway Event Behavior window
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Work Management
View order supplement history
Starting with this release, you can view how many supplements have taken place on an order, 
of what type and version, and notes captured during the supplement of that order on the new 
Supp History tab. In addition, a new task status type of SUP was added to indicate a 
supplement was processed against the order to which the task was associated.

To access this enhancement

1. Select Home on the navigation bar, and click My Work Queue.

2. Select a task for which you want to view the supplement history.

3. Select the Supp History tab at the bottom of the window.

4. To view the complete notes, double-click the supplement record.

For more information on this enhancement, see the following topics in Help: 

Accepting a Task
Viewing Order Supplement History
Work Queue Manager - Supp History tab
What do the task status types indicate?

New windows include:

Supplement History window
Work Queue Manager - Supp History Tab

Figure 54: Supplement History window
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New preferences
The following table lists preferences that were added to MetaSolv Solution for this release.

Table 1: New preferences

Preference
Location (from My 
Preferences on the 

Navbar)
Related Enhancement

Allow Users to Customize 
My Desktop

System Information Usability

System EWO Plan Inventory Management 
>Engineering Work Order

Engineering Work Order

User EWO Plan Inventory Management 
>Engineering Work Order

Engineering Work Order

Suppress Occupied 
Positions

Inventory 
Management>Equipment
>Equipment Inventory:

Filter Equipment Treeviews
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Appendix A: IDL changes from 5.2 to 6.0.2

ICM – EQUIPMENT API 

New IDL File: WDIEquipmentTypes_v3
This is a new IDL file created by copying and changing the existing WDIEquipmentTypes_v2 
IDL file.  The equipment specification exports previously returned the rate code for both port 
addresses and placeholders so both structures were be modified to include the Allow Lower 
Rates indicator.  The installed equipment exports previously supported  the rate code for port 
address but not the rate code for port address placeholders, so only one structure needed to be 
modified to include the Allow Lower Rates indicator. 
Change #ifndef WDI_EQUIPMENTTYPES_V2IDL to #ifndef WDI_EQUIPMENTTYPES_V3IDL.

Change #define WDI_EQUIPMENTTYPES_V2IDL to #define WDI_EQUIPMENTTYPES_V3IDL.

Change module WDIEquipmentTypes_v2 to WDIEquipmentTypes_v3.

Change // end module WDIEquipmentTypes_v2 comment to // end module 
WDIEquipmentTypes_v3.

WDI Notification changes
The following notification was added to the /// Equipment Specification section
void getEquipSpecSucceeded_v3(in long referenceNumber,

     in MetaSolv::CORBA::WDIEquipmentTypes_v3::EquipSpec aEquipSpec);

The following notifications were added to the /// Equipment Install section
void getEquipInstallSucceeded_v3(in long referenceNumber,

     in MetaSolv::CORBA::WDIEquipmentTypes_v3::InstalledEquipment

                    aInstalledEquipment);

void getEquipInstallMaintSucceeded_v3(in long referenceNumber,

     in MetaSolv::CORBA::WDIEquipmentTypes_v3::InstalledEquipmentMaint

                    aInstalledEquipmentMaint);
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void getPortAddressInstallSucceeded_v3(in long referenceNumber,

     in MetaSolv::CORBA::WDIEquipmentTypes_v3::InstalledPortAddressSeq

                    aInstalledPortAddressSeq);

New operations
SpecificationSubSession changes
void getEquipSpec_v3(in long referenceNumber, in WDINotification 
aWDINotification, in long equipSpecId) raises(MetaSolv::CORBA::WDI::WDIExcp);

InstallationSubSession changes
        /// returns equip tree for a piece of equipment

void getEquipInstall_v3(in long referenceNumber,

in WDINotification aWDINotification,

in boolean oneLevelOnly,     /// expand tree only one level

in boolean getPendingPortAddresses,

in long installedEquipmentID)

raises(MetaSolv::CORBA::WDI::WDIExcp);

/// returns port addresses for a piece of equipment

void getPortAddressInstall_v3(in long referenceNumber,

in WDINotification aWDINotification,

in boolean oneLevelOnly,     /// expand tree only one level

in boolean getPendingPortAddresses,

in long installedEquipmentID,

in long installedPortAddress)

raises(MetaSolv::CORBA::WDI::WDIExcp);

New fields
§Added to the SpecMountingPositionNext structure (after the rateCode field)

char             allowLowerRates;  //

equipment_spec_pa_placeholder.allow_lower_rates

Added to the SpecPortAddress structure (after the rateCode field)
char allowLowerRates;  //

equipment_spec_port_address.allow_lower_rates 

Added to the InstalledPortAddress structure (after the rateCode field)
char allowLowerRates;

//port_address.allow_lower_rates
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ICM – EQUIPMENT API
Existing IDL file: WDIEquipment.idl 
The section shows the changes created by the new API operation 
getPortAddressIPAddress_v2.

WDI notification changes
GetPortAddressIPAddressSucceeded_v2

New and changed operations
Added to Equipment Notification
void getPortAddressIPAddressSucceeded_v2(in long referenceNumber,

in MetaSolv::CORBA::WDIInfrastructureTypes::IPAddressResultSeq 
result);

Added to InstallationSubSession
void getPortAddressIPAddress_v2(in long referenceNumber,

in WDINotification aWDINotification,

in long equipmentId,in long portAddress)

raises(MetaSolv::CORBA::WDI::WDIExcp);

Change to InstallationSubSession 
void validateNetworkElementTypeMatch(in long referenceNumber,

in WDINotification aWDINotification, in long equipmentSpecId, 

in long networkNodeId) raises(MetaSolv::CORBA::WDI::WDIExcp);

New operation: getPortAddressIPAddress_v2
This operation returns an IPAddressResultSeq that contains the actual IP address.  The 
previous version of this method returned a sequence of number inventory IDs that required an 
additional Infrastructure API call to obtain the actual IP address.

Field changes
InstallationSubSession—Changed the last argument for the 
validateNetworkElementTypeMatch operation: from networkElementLocationId to 
networkNodeId.
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ICM – DLR API 

New IDL file: WDIActivationTypes_v2
This IDL file was created by copying the existing WDIActivationTypes IDL . Additional 
fields were added to support Optical.

WDI Notification changes
The following notifications were added
void getActivationInformationForOrderSucceeded_v2(

in long referenceNumber,

in MetaSolv::CORBA::WDIActivationTypes_v2::ActivationaActivation);

void getActivationInformationForNonOrderedItemSucceeded_v2(

in long referenceNumber, 

in MetaSolv::CORBA::WDIActivationTypes_v2::Activation aActivation);

void getNetworkSystemInformationSucceeded_v2(

in long referenceNumber,

in MetaSolv::CORBA::WDIActivationTypes_v2::NetworkSystem

aNetworkSystem);

New fields
Added to the NetworkSystem structure
/**

Indicates if the network requires the same channel assignment on each  
facility segment when assigning to multiple segments through a network.

*/

char sameChannelAssignmentInd; //ns_network_system.same_chnnl_assignmnt_ind

/**

Indicates if a second set of assignments is necessary to protect a circuit 
when provisioning a connection to an optical network.

*/

char inherentlyProtInd; // ns_network_system.inherently_prot_ind
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ICM – DLR API
Added to the OrderInformation structure

/**
First name of the customer 

*/
string firstName;    //ca.first_nm

/**Last name of the customer */
string lastName;    //ca.last_nm

 New operations
Added to the ActivationSubSession interface
void getActivationInformationForOrder_v2(

in long referenceNumber,

in WDINotification aWDINotification,

in MetaSolv::CORBA::WDI::WDIEvent anEvent)

raises(WDI::WDIExcp);

void getActivationInformationForNonOrderedItem_v2(

in long referenceNumber,

in WDINotification aWDINotification,

in MetaSolv::CORBA::WDI::WDIEvent2 anEvent)

raises(WDI::WDIExcp);

void getNetworkSystemInformation_v2(

in long referenceNumber,

in WDINotification aWDINotification,

in long networkSystemId)

raises(WDI::WDIExcp); 

New IDL file: IDL WDIDLRTypes_v5
This IDL was created by copying the existing WDIDLRTypes_v4 IDL

WDI Notification changes
The following notifications were added
void DLRGetSucceeded_v5(in MetaSolv::CORBA::WDIDLRTypes_v5::DLRRequest 
aDLRRequest, in MetaSolv::CORBA::WDIDLRTypes_v5::DLR aDLR);   
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void DLRGetFailed_v5(in MetaSolv::CORBA::WDIDLRTypes_v5::DLRRequest

aDLRRequest, 

in WDI::WDIErrSeq aWDIErrSeq);

void switchActivationGetFailed_v5(in MetaSolv::CORBA::WDI::WDIEvent

aWDIEvent, in WDI::WDIErrSeq aWDIErrSeq);

void switchActivationGetSucceeded_v5(in MetaSolv::CORBA::WDI::WDIEvent

aWDIEvent, 

in MetaSolv::CORBA::WDIDLRTypes_v5::SwitchActivation

aSwitchActivation);

void endUserSpecialTrunkActivationGetFailed_v5(in short requestID,

in MetaSolv::CORBA::WDI::WDIEvent aWDIEvent,

in WDI::WDIErrSeq aWDIErrSeq);

void endUserSpecialTrunkActivationGetSucceeded_v5(in short requestID,

in MetaSolv::CORBA::WDI::WDIEvent aWDIEvent,

in MetaSolv::CORBA::WDIDLRTypes_v5::

EndUserSpecialTrunkActivationSeq 

aEndUserSpecialTrunkActivationSeq);

void transportProvisioningGetFailed_v5(in

MetaSolv::CORBA::WDI::WDIEvent aWDIEvent,

in WDI::WDIErrSeq aWDIErrSeq);

void transportProvisioningGetSucceeded_v5(in

MetaSolv::CORBA::WDI::WDIEvent aWDIEvent,

in MetaSolv::CORBA::WDIDLRTypes_v5::TransportProvisioning

aTransportProvisioning);

New operations
The following new operations were added to the DLRSession interface
void getTransportProvisioning_v5(

in MetaSolv::CORBA::WDI::WDITransaction aWDITransaction,

in WDINotification aWDINotification,

in MetaSolv::CORBA::WDI::WDIEvent aWDIEvent

raises(WDI::WDIExcp);
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ICM – DLR API
void getEndUserSpecialTrunkActivation_v5(

in MetaSolv::CORBA::WDI::WDITransaction aWDITransaction,

in WDINotification aWDINotification,

in MetaSolv::CORBA::WDI::WDIEvent aWDIEvent,

in short requestID

raises(WDI::WDIExcp);

void getSwitchActivation_v5(

in MetaSolv::CORBA::WDI::WDITransaction aWDITransaction,

in WDINotification aWDINotification,

in MetaSolv::CORBA::WDI::WDIEvent aWDIEvent

raises(WDI::WDIExcp);

void getDLR_v5(

in MetaSolv::CORBA::WDI::WDITransaction aWDITransaction,

in WDINotification aWDINotification,

in MetaSolv::CORBA::WDIDLRTypes_v5::DLRRequest aDLRRequest

raises(WDI::WDIExcp);

New fields
The following fields were added to the DLRDesignLine structure: 

/**

A code used to identify a piece of equipment. 

*/
string<10>eqpType        ;//  
DLR_CIRCUIT_DESIGN_LINE.EQUIPMENT_TYPE_FACILITY_DESIG  VARCHAR2(10)

/**

A code that indicates floor, aisle and bay/cabinet in a central office where a specific piece of 
equipment is located. 

*/
string<10>relayRack    ;//  DLR_CIRCUIT_DESIGN_LINE.RELAY_RACK_FACILITY_TYPE  
VARCHAR2(10)
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/** 

Identifies the number assigned to a panel, shelf or case within

the bay/cabinet indicated in the relay rack field. 

*/

string<6>unit    ;//  DLR_CIRCUIT_DESIGN_LINE.UNIT_CHANNEL     VARCHAR2(6)

/**

Identifies the facility/cable designation used to provision this service. 

*/

string<5>  facDesg          ;   //  
DLR_CIRCUIT_DESIGN_LINE.EQUIPMENT_TYPE_FACILITY_DESIG  VARCHAR2(5)

/**

Identifies the facility type code.

*/
string<6>  facType          ;  //   
DLR_CIRCUIT_DESIGN_LINE.RELAY_RACK_FACILITY_TYPE      VARCHAR2(6)

/**

Identifies specific connection points(i.e. channel, jack, slot, pin or pair) within a facility or 
cable used to provision this service.

*/
long channel ;   //  DLR_CIRCUIT_DESIGN_LINE.UNIT_CHANNEL  NUMBER(5)

The following was added to the DLRAdminInfo structure: 

/**
Identifies the previous Exchange Company Circuit ID for Provider Initiated 
Network Groom Activity. This information is the same information found on the 
ICSC Confirmation Notice in the ECCKT field for new installations and on the 
ASR Form in the ECCKT field for subsequent change requests, outside moves and 
changes in capacity to existing circuit groups. This field should match the 
ECCKT previously provided.  This field is required when the ECIA field is "X", 
otherwise optional.

*/
string<53>  OLDECCKT        ;  //   

DESIGN_LAYOUT_REPORT.OLD_ECCKT                      VARCHAR2(53)
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Appendix B: What’s New in 6.0.3
This appendix documents enhancements that are new with version 6.0.3 of MetaSolv Solution.

Add external Web link
This enhancement was originally included in 5.2.13 and merged into 6.0.3.

This enhancement allows you to open external Web links from connection design and ISR. 
You can add a maximum of three links. You cannot add or delete parameters, but you can 
change parameter names if appropriate to match customer-named parameters in third-party 
systems. A new preference, Configure External Weblinks, was created. 

To access this enhancement and create links 

1. Select Home on the navigation bar, and click My Preferences.

2. Double-click System Information.

3. Double-click Configure External Weblinks.

4. From the functional area drop-down, select either Connection Design or ISR.

5. Click the New button.

6. Type in the Link name and the URL, and click OK.

To view links from an ISR 

1. Select Order Management on the navigation bar, and click Service Requests.

2. In the Search by drop-down, select ISR and enter search criteria.

3. Click the Search button.

4. Double-click an ISR to open it.

5. From the menu, click Options>External Links.

6. Select the link you want to open.

To view links from connection design 

1. Select Inventory Management on the navigation bar, and click Connection Design.

2. Enter search criteria, and click the Search button.
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3. Double-click a Connection ID.

4. Click the Connection Summary link.

5. In the Actions section, click the link you want to open in the External Links area.

New windows for this enhancement include the Maintenance window.

Figure 55: Maintenance Window

Architecture changes
This release of MetaSolv Solution moves to a new version of BEA WebLogic Server 8.1 SP3 
and a new version of the Oracle client, version 9.2.0.3. You can purchase BEA WebLogic 
software with MetaSolv Solution. For more information on what is available, contact 
MetaSolv Sales.
80 MetaSolv Software, Inc.



Associate IP Addresses to EPAs
Associate IP Addresses to EPAs 
This enhancement was originally included in 5.2.13 and merged into 6.0.3.

Associate IP Addresses to EPAs allows the user to assign and unassign IP addresses to enabled 
port addresses.

Associate IP Addresses to EPAs functionality is used in cases when a physical connection is 
assigned to a TDM facility that terminates into a router and the connection requires a /30 IP 
Address at the end point. Just like physical port addresses, physically enabled port addresses 
may only contain a single IP Address. 

However, enabled ports may be assigned either a Host Number IP Address or a subnet. Any 
subnet may be assigned at any time. Before the user is able to assign a host, certain validations 
must be performed. When a circuit is assigned to the enabled port, the software verifies that 
this IP assignment will not result in more than two pieces of equipment assigned to this circuit, 
either directly or indirectly, having IP Addresses assigned. Next, the software verifies that the 
new Host Number IP Address is in the same subnet as the existing hosts assigned to this 
circuit, either by direct port address assignments or indirectly by mapped circuit positions. If 
the validation passes, the user is prompted with a DLR Reconcile window stating how many 
design assignments will be affected. 

The user may continue with the assignment resulting in circuit reconciliation, cancel the 
assignment, or send the work to the background processor. If the user decides to continue, the 
cascade reconciliation process will kick off after the mass reconciliation has finished, when 
applicable. There is no prompt for the cascade reconcile, as it is required to keep the data up to 
date. For instances where the enabled port does not already have a circuit assigned, the 
software will verify that the new host is in the same subnet as any existing host(s) whose 
port(s) are enabled by the same parent circuit and circuit position that enable the port in 
question. When validation passes, the IP is assigned to the port and any child designs will 
automatically be reconciled, when applicable. Virtually enabled port addresses may contain 
multiple IP Addresses, consisting of both Host Number IP Addresses and Subnets. 

All hosts must be within the same subnet to exist on the same port. Any subnet may be added 
to these ports, and they have no impact on what hosts may be assigned. Just like when a circuit 
is assigned to a physical port, when assigned to a virtual port a circuit may not be assigned to 
more than two pieces of equipment which have IP addresses associated to the ports where the 
circuit is assigned. This validation takes place when the IP address is being assigned as well as 
when the circuit is being assigned to the equipment port. When a circuit is assigned to two 
pieces of equipment with Host Number IP Addresses, all of the hosts at both locations must be 
within the same subnet.

Whenever the IP Address associations are changed for a virtual port, the software checks for 
DLRs that need reconciliation as a result of the change and prompts the user to continue with 
the change. The user has the option to continue, cancel, or send the process to the Background 
Processor. 
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When updating DLRs, the software will not only place the IP addresses assigned to the port in 
question on the DLR in the MISC column, but will travel up the equipment hierarchy and 
gather the IP address information from the parent ports as well. For virtual ports with multiple 
IP address assignments, all of them will be placed on the DLR. All IP addresses placed on the 
DLR will occupy their own line. This holds true for direct equipment assignments, facility 
assignments, and assignments made directly to equipment's enabled port(s). To distinguish 
subnets from Host Number IP Addresses on the DLR, the subnet will contain the subnet 
address followed by a "/" and the masked prefix.

To access this enhancement from Equipment

1. Select Inventory Management on the navigation bar, and click Equipment Inventory.

2. Enter a network location.

3. Click the Search button.

4. Navigate to an enabled port address.

5. Right-click and select IP Address from the pop-up menu.

To access this enhancement from connection design

1. Select Inventory Management on the navigation bar, and click Connection Design.

2. Enter search criteria, and click the Search button.

3. Double-click to open a Connection ID.

4. Click the CLR/DLR Design link.

5. Open an equipment assignment, or click the Equipment link to add a new assignment.

6. Navigate to an enabled port address.

7. Right-click and select IP Address from the pop-up menu.

Auto-Assign IP Addresses
This enhancement allows you to auto assign an IP address to a PSR based on assignment rules 
you define in the inventory. If an IP address is not available to be assigned based on the rule, 
you can choose to auto create the address and have it assigned to the order. This feature allows 
you to limit the amount of IP address inventory you must manually create because you can 
automatically subnet your inventory as needed.

Double-clicking the IPASSIGN task in a work queue opens the new IP Assignment window 
instead of opening the PSR. The IPASSIGN task can now be a system task. The system queue 
will process the IPASSIGN task using the auto-assign rule for each service item. If an 
assignment fails and the auto-create does not meet the rule criteria, the task is sent to the 
exception queue.You can assign IP addresses to equipment in a network area. The IP Address 
Inventory tab is enabled on the Network Area Definition window - Network Items tab when 
you associate equipment.
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Auto-Assign IP Addresses
A new preference was created for this enhancement, Enable Network Areas for IP 
Addresses Only Preference -- Application Setup>Enable Network Areas. The new 
preference gives the user the ability to turn on Network Areas and use them for IP Addresses 
without having to implement Network Areas for telephone numbers as well.

To access this enhancement

Select Inventory Management on the navigation bar, and click IP Address Rules.

For more information about this enhancement, see the following topics in the online Help: 

Creating IP Address Rules
Automatically Assigning IP Addresses
Enable Network Areas for IP Addresses Only Preference
IP Address Rules Window
IP Address Rules Maintenance Window
IP Address Rules Maintenance Window - IP Rule Information Tab
IP Address Rules Maintenance Window - IP Rule Criteria Tab
IP Address Rules Maintenance Window - IP Rule Associations Tab

New windows for this enhancement include:

IP Address Assignment window
IP Address Rules Window
IP Address Rules Maintenance Window - IP Rule Information Tab
IP Address Rules Maintenance Window - IP Rule Criteria Tab
IP Address Rules Maintenance Window - IP Rule Associations Tab
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Figure 56: IP Address Assignment window

Figure 57: IP Address Rules Window 
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Auto-Assign IP Addresses
Figure 58: IP Address Rules Maintenance Window - IP Rule Information Tab 
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Figure 59: IP Address Rules Maintenance Window - IP Rule Criteria Tab 
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Bypass Selected PSR API Import Structure Validation preference
Figure 60: IP Address Rules Maintenance Window - IP Rule Associations Tab 

Bypass Selected PSR API Import Structure 
Validation preference

A new preference called Bypass Selected PSR API Import Structure Validation was 
created. When the preference is set to Yes, selected PSR API validation is not as strict. This 
functionality currently exists only for values and label validations. When a structure fails 
validation, it is not processed by the APIs and the incorrect information is not entered into the 
MetaSolv Solution database. However, the PSR is still saved in the system. The PSR is subject 
to validation at the time of completion.

To access this enhancement

1. Select Home on the navigation bar, and click My Preferences.

2. Select API > PSR Order Entry API > Bypass Selected PSR API Import Structure 
Validation
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Circuit Emulation 
Circuit emulation allows you to assign a virtual connection to ride a template-based facility (or 
any template-based channelized connection). The user must first modify templates and build a 
product catalog to allow the virtual connection to ride the facility.

This enhancement was added so that customers could assign virtual connections to facility 
connections. 

To access this enhancement 

1. Select Inventory Management on the navigation bar, and click Connection Design.

2. Enter search criteria and click the Search button.

3. Double-click to open the design lines for a virtual connection.

4. Click the Schematic Design link.

5. Add your connections.

6. Right-click the connection and select Specify Virtual Channel from the pop-up menu.

7. Right-click an unassigned port and select Assign Connection. 

8. Click OK.

To set up a template to use this enhancement, follow these process instructions. 

The following task descriptions are process examples only. This process is technology 
independent and your exact customer implementation is expected to be different.

1. Set up connection specs:

a. Select Inventory Management on the navigation bar.

b. Click Inventory Management Setup.

c. Click the Network Templates link.

d. Click the Connection Specs panel.

e. Double-click the connection spec for the Facility circuit the virtual will be riding.

f. On the Managing a Connection Spec window, click the Related Connection Specs 
link.

g. Double-click Relate Connection Spec.

h. Select the virtual that will be riding the facility.

i. In the Relationship Type drop-down, select Assignment, and click OK.
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Circuit Emulation
Figure 61:  Managing a Connection Spec

2. Set up template relationships:

a. Click the Network Templates panel.

b. Expand a technology type.

c. Double-click to open a network template.  

d. On the canvas, right-click the relationship for the connection you wish to modify and 
select Properties from the pop-up menu.

e. Click the Connection Specs link.

f. Double-click Associate Connection Spec. 

g. Select the facility connection spec you set up for the virtual to ride.

h. Click OK.
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Figure 62: Managing a Template Connection

i. Double-click the connection and check the network extension checkbox. 

j. Click OK and then click OK again to return to the canvas.
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Circuit Emulation
k. On the canvas, right-click the connection relationship for the virtual you will be 
ordering, and select Properties from the pop-up menu.

l. Click the Connection Specs link.

m. Double-click the virtual connection.

n. Click the Connection Specs link.

o. Double-click the virtual connection spec.

p. Click the Assignable Connection Specs link.

q. Double-click Add Assignable Connection Spec.

r. Expand the connection relationship for the virtual connection.

s. Check the checkbox next to the facility circuit.

Figure 63: Select Assignable Specs

t. Click OK until the canvas redisplays.

3. Set up the new product specification for the facility:

a. Select Order Management on the navigation bar, and click Order Management 
Setup.

b. In the PSR section, click the Products Specifications link.

c. Right-click and select Add Item from the pop-up menu.
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d. Add a product specification for the template-based facility as shown below:

Figure 64: Product specifications

e. Select File>Save from the menu.

f. Click the Network Templates Types tab.

g. Right-click the connection spec with the new facility and select Associate from the 
pop-up menu.
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Figure 65: Product specifications

h. Select File>Save from the menu.

4. Set up the product specification for the new virtual connection:

a. Right-click and select Add Item from the pop-up menu.

b. Add a product specification for the enterprise connection as shown below:
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Figure 66: Product specifications

c. Select File>Save from the menu.

d. Click the Network Templates Types tab.

e. Right-click the connection spec with the virtual connection and select Associate from 
the pop-up menu.

f. Select File>Save from the menu.

5. Create product bundle:

a. Right-click and select Add Item from the pop-up menu.

b. Create a product bundle as shown below:
94 MetaSolv Software, Inc.



Circuit Emulation
Figure 67: General

c. Select File>Save from the menu.

d. Click the Related Items tab.

e. Right-click the facility connection and select Add from the pop-up.

f. Click OK.
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Figure 68: Product specifications

g. Right-click the virtual connection and select Add from the pop-up menu.

h. Click OK.

i. Select File>Save from the menu.

j. Close out of product specs.

6. Set up the Product Catalog:

a. From the Order Management Setup window, click the Product Catalog link.

b. Right-click and select Add Item from the pop-up menu.

c. Select the new product bundle and click OK.
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Circuit Emulation
Figure 69: Product Catalog - Available Specifications

d. Enter required information, and select File>Save from the menu.

e. Right-click the product bundle item, and select Add Item from the pop-up menu.

f. Select the facility and click OK.

Figure 70: Product Catalog - Available Specifications

g. Right-click the product bundle item, and select Add Item from the pop-up menu.

h. Select the virtual connection and click OK.
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i. Select the facility connection and click the Network Template Types tab.

j. Right-click the connection type in the list, and select Associate from the pop-up 
menu. 

k. Select File>Save from the menu.

l. Repeat steps j-k for the virtual connection.

7. Order the product catalog item:

a. Select Order Management on the navigation bar, and click New Product Service 
Request.

b. Enter customer information and click OK.

c. Enter order information.

d. Click the Services link.

e. Click Global.

f. Click the Add New Item link.

g. Select the new product bundle and click Yes to configure the product.

h. Click the Add new customer locations link.

i. Add the primary customer location and click Add Another.

j. Add a secondary customer location and click Next.
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Figure 71: List of Locations

k. Click Next.
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Figure 72: PSR Ordering

l. Select all connections, and click Next.

m. In the Connection Type drop-down, select the facility connection.

n. Select both customer locations, and click the Add button.

o. In the Connection Type drop-down, select the virtual connection.

p. Select the connection between locations, and click the Add button.
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Circuit Emulation
q. Click Next.

r. Enter the attributes for each connection and click the Next Connection button, and 
click the Done button when all connections are complete.

s. Click OK.

t. Click the Finish Order link.

u. Click the Yes button, and generate tasks.

8. Design the facility connections:

Prerequisite: Identify connections on the order with the CKTID task.

a. Double-click the design task.

b. Double-click a facility connection.

c. Enter the element and network information.

d. Click the CLR/DLR Design link.

e. Make your connection assignments.

f. Select Change Status>Record Issued from the menu.

g. Close the window and click Yes to save.
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h. Repeat steps 1-5 for the second facility connection.

9. Design the virtual connection:

a. Double-click the virtual connection.

b. Enter the element and network information.

c. Click the Schematic Design link.

d. Select the facility connections.

Right-click each connection, and select Specify Virtual Channel from the pop-up menu to 
make the assignment.

Figure 73: Connection Design
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Copy cross-connects
Figure 74: CLR/DLR Design

e. Click Change Status>Record Issued from the menu.

f. Close the window and click Yes to save.

Copy cross-connects
This enhancement was originally included in 5.2.13 and merged into 6.0.3.

Copy cross-connects allows you to copy all the equipment from one location to another 
location with all the cross-connects. Now you can quickly copy equipment along with all 
cross-connects from one location to another.

To access this enhancement

1. Select Inventory Management on the navigation bar, and click Equipment Inventory.

2. In the blank area under the equipment, right-click and select Copy All Equipment from 
the pop-up menu.

3. Right-click the blank area under the equipment in the second location, and select Copy All 
Equipment To from the pop-up menu.
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4. Choose which date to use by selecting Yes or No.

5. Select Yes to copy equipment and all cross-connects.

For more information about this enhancement, see the Copying equipment and cross-
connects topic in the online Help.

Current and previous leased circuit information 
appears on change orders

This enhancement was originally included in 5.2.13 and merged into 6.0.3.

Current and previous leased circuit information now appears on change orders. This 
enhancement was added so that users can view the current and previous leased circuit history.

To access this enhancement from connection design

1. Click Inventory Management on the navigation bar, and click Connection Design.

2. Enter search criteria and click the Search button.

3. Double-click a connection ID to open the connection design window.

4. From the menu, select Options>Leased Circuit History.

To access this enhancement from work queue manager

1. Click Inventory Management on the navigation bar, and click My Work Queue.

2. Double-click a connection ID to open the connection design window.

3. From the menu, select Options>Leased Circuit History.

For more information about this enhancement, see the Viewing Leased Circuit Data topic in 
the online Help.

The new window for this enhancement is the Leased Circuit History window.
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Current and previous leased circuit information appears on change orders
Figure 75: Leased Circuit History window
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Function Code to Set for LNP Disconnects 
preference

A new preference was created to allow you to set the FOC for LNP numbers to either D 
(Disconnect) or U (Unlock).

To access this enhancement

1. Select Home on the navigation bar, and click My Preferences.

2. Select Service Request > Product Service Request > E911 > Function Code to Set for 
LNP Disconnects.

Limit rows retrieved in Work Queue Manager
This enhancement is a new system preference called Maximum Number of Rows to 
Retrieve in the Queue Manager. It allows you to set the maximum number of tasks that you 
want to retrieve when you select a queue from the Work Queue drop-down on the Work 
Queue Manager window.

To retrieve specific rows, use the queue manager filter which will allow you to narrow down 
retrieval based on task types, dates, and so on.

To access this enhancement

1. Select Application Setup from the navigation bar and click the Preferences link.

2. Double-click the Work Management folder, then expand the Work Queue Management 
folder.

3. Double-click the Maximum Number of Rows to Retrieve in the Queue Manager 
preference. 

For more information on this enhancement, see the System Preferences online Help topic.
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Migration tool
Migration tool
Next Generation Migration is a new tool accessed through MetaSolv Utilities. Migration is an 
iterative process that assists with the following:

Network Element Migration (NEM)--Migrating equipment to incorporate the new 
Network Element functionality.
Broadband Migration (BBM)--Migrating circuits, product catalog items, and service items 
on orders from the broadband module to template-based technologies.

This enhancement was done because the broadband module is being retired. The migration 
enables you to take advantage of the template-based technology modules and the new network 
element features. 

To access this enhancement

1. Click Utilities 6.0 in the MetaSolv program group. (See the MetaSolv Solution Setup 
Guide for instructions on using ZAC start page links.) 

2. When the log on window appears, use the same ID and password that you use for 
MetaSolv Solution. 

3. Select the database to which Utilities should connect.

4. Click the NG Migration button on the primary toolbar.

The Next Generation Migration window displays.
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New windows for this enhancement include the Next Generation Migration window. Multiple 
new windows are accessed via the Network Element Migration window.

Figure 76: Next Generation Migration window

To learn more about this enhancement, see the Next Generation Migration Guide.

Network elements can be added to standalone 
network system designs

Adding elements is an efficient way to add multiple network elements to a network system 
design. This method is used when standalone network elements exist. You can search for all 
network elements that are associated to component types allowed by the network template 
type, and that are not network extensions. You can select multiple network elements to be 
added to the canvas. 

In addition, you can use the Add Neighboring Elements feature to search for neighbors of a set 
of selected network elements and add them to the canvas. The system identifies neighboring 
elements by the equipment associated with the selected elements. Any circuits assigned to the 
equipment are followed to the equipment at the other end of the circuit to the highest level of 
equipment associated with a network element. 

The network elements appear as choices to be added to the canvas only if the network 
elements are component types allowed by the network template.
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Network elements can be added to standalone network system designs
To access this enhancement and add elements

1. Select Inventory Management on the navigation bar, and click Network Systems.

2. Click the Network Template List panel.

3. Expand a network template type.

4. Double-click to open a network system.

5. Right-click the canvas, and select Add Elements from the pop-up menu.

6. Enter at least one search criteria, and click the Search button.

7. Select one or more element names, and click the Finish button.

To add neighboring elements

1. Right-click a network element, and select Add Neighboring Elements from the pop-up 
menu.

2. Check the checkboxes next to the element names that you want to add to the network 
system design canvas.

3. Click the Finish button.

For more information about this enhancement, see the Adding Elements and Add 
Neighboring Elements topics in the online Help.

New windows for this enhancement include:

Add Elements window
MetaSolv Solution What’s New 109



Add Neighboring Elements window

Figure 77: Add Elements window
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Network hierarchy can be viewed in network tree-view
Figure 78: Add Neighboring Elements window

Multiple new windows are accessed via the Add Elements window and the Add Neighboring 
Elements window.

Network hierarchy can be viewed in network tree-
view

This enhancement allows you to view networks hierarchically in the network tree-view. You 
can also open embedded networks from this view.

To access this enhancement 

1. Select Inventory Management on the navigation bar, and click Network Systems.

2. Click the Network Template List panel.

3. Expand a network template type.

4. Expand a network system to view embedded networks.

5. Double-click an embedded network to open it.
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Override default value on PSR API Import when 
Label exists on Import Structure

A new preference was created to allow you to overwrite the default values for the 
importNGNPSR and importPSR_v3 methods before making the API call when the 
PSROrderItemValue2 structure is populated. You do not have to populate the value structure 
with the default value and an activity code for delete. You can populate it with the preferred 
value and an activity code of New.

When the preference is set to No (default), you must populate the default values and an 
activity code for delete.

To access this enhancement

1. Select Home on the navigation bar, and click My Preferences.

2. Select API > PSR Order Entry API > Override default value on PSR API Import 
when Label exists on Import Structure.

Perform custom validation at task completion 
Preference 

This enhancement was originally included in 5.2.13 and merged into 6.0.3.

The application previously performed custom validation before the Task Completion window 
opened. By adding the option to perform customer validation during task completion, the 
custom validation doesn't occur until the user clicks Yes on the Task Completion window. 
Therefore, any modifications (for example, a change to the Bill Activation Date) on the Task 
Completion window are saved or committed to the database and can be used for custom 
validation.

The Perform Custom Validation at Task Completion preference was changed to allow the 
following three options:

Perform custom validation before task completion opens  

MetaSolv’s software performs company-specific validation before the Task Completion 
window opens. Before the validation, you must enter the custom validation script in the 
SP_WM_CUSTOM_VALIDATION stored procedure and enable this preference.

Perform custom validation during task completion

MetaSolv's software performs custom validation after you click the Yes button on the Task 
Completion window.  Before the validation, you must enter the custom validation script in 
the SP_WM_CUSTOM_VALIDATION stored procedure and enable this preference.

Do not perform custom validation (default) 
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PSR custom pre-validation user exit
MetaSolv’s software does not perform custom validation before allowing users to 
complete tasks.

To access this enhancement:

1. Select Application Setup from the navigation bar and click the Preferences link.

2. Double-click the Work Management folder, then expand the Task Completion folder.

3. Double-click the Perform Custom Validation preference.

For more information on this enhancement, see the System Preferences topic in the online 
Help.

PSR custom pre-validation user exit 
The PSR custom pre-validation user exit has been added for release 6.0.3. This user exit can be 
coded to automatically pre-validate a PSR order. This exit is called when clicking the Validate 
button or Finish button on a PSR order and is called prior to MSLV’s validation and prior to 
the PSR Custom Validation user exit.

For details on user exits, see the MetaSolv Solution Administration Guide.
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Refresh button in Trouble Management
This enhancement allows you to refresh the New Ticket window. If changes are pending, the 
software prompts the user to see if they want to save their changes.

To access this enhancement

1. Select Order Management on the navigation bar, and click Trouble Ticket Queue.

2. Click the Add New link.

3. Do one of the following:

a. Click the Create Ticket Without Template button.

b. Click the Create Ticket With Template button, and select the template you want to 
use.

For more information about this enhancement, see the Creating a Ticket topic in the online 
Help.
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C

Appendix C: What’s New in 6.0.4
This appendix documents enhancements that are new with version 6.0.4 of MetaSolv Solution.

Engineering

Show Available Positions preference - IR 75675
There is a new preference that allows you to see the number of available positions on a facility 
circuit in Connection Hierarchy.

Show Available Positions Preference

Treeview Location: Inventory Management>Connection Hierarchy

Type: User

Options:

N (default)

MetaSolv Solution does not display the number of available positions on a facility circuit 
on the Connection Hierarchy window.

Y

MetaSolv Solution displays the number of available positions on a facility circuit on the 
Connection Hierarchy window.

This preference sets the default of the view you will see when you access the Connection 
Hierarchy window. Regardless of how you set the preference, you can choose to change your 
view. To do so, right-click and select View>Available Facility Positions. 

Reducing quantity of trunks - IR 39883
In previous releases, when supplementing to correct an order, you could not reduce the 
quantity of trunks when the trunks are in an 'In Progress' status (known as a partial cancel). 
Users were required to supplement to cancel the entire order. 

With this release, users can supplement to correct an order and the user is allowed to reduce 
the quantity of trunks when they are in an 'In Progress' status. Reduction in trunk quantity will 
take place even if designs have been drawn for the trunk connection.
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Auto-Populate TCICs preference - IR 74095
There is a new preference that allows you to shut off the automatic number of TCICs when 
creating trunks. 

Auto-Populate TCICs Preference

Treeview Location: Service Request>Connection

Type: System

Options: 

N (default)

MetaSolv Solution does not automatically fill in the TCICs when creating trunks.
Y

MetaSolv Solution determines the next available TCIC after the point codes are 
entered for trunks.

Accessing online Help for this enhancement
Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

List of Preferences
Service Request Preferences
Auto-Populate TCICs Preference

Method of TCIC Validation preference - IR 70984
There is a new preference that allows you to reuse TCICs that are on disconnect orders that 
have not been Due Date completed.

Method of TCIC Validation Preference

Treeview Location: Service Request>Connection

Type: System

Options: 

Point Code (default)

MetaSolv Solution performs TCIC validation using only the point codes.

Point Code / Location

MetaSolv Solution performs all TCIC validation based on the point codes as well as the A 
and Z location of the trunk group.  If at least one location of the new trunk group is 
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Engineering
different from the locations on the pending disconnect trunk group, the TCICs can be 
reused.

Accessing online Help for this enhancement
Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

List of Preferences
Service Request Preferences
Method of TCIC Validation Preference

Remove shared node enhancement - IR 74207
MetaSolv has added the ability to remove a shared node in the same manner in which nodes 
can be deleted. For example, if the user removes a shared node from a ring, instead of 
requiring the user to first delete the attached connections, the software will now open the 
delete node wizard and replace the broken segments of the ring with a new connection. Any 
provisioned connections to the broken segments will be moved to the new segment and if 
necessary a mass reconcile will occur. This is the current behavior for deleting a non-shared 
node. The rule of not allowing a node to be deleted if there are any drop nodes to it will now 
apply when 'Removing' a shared node. If any provisioned assignments to the shared node's 
network drop at the shared node, the node will not be allowed to be removed. 

SONET/Optical shared node enhancement - IR 74839
Users can share optical components with SONET nodes. When a SONET node is shared with 
an optical component, any changes made in the Managing an Element window to either the 
Name or the Network Element ID will be kept in sync with the Name and Target Identifier 
fields found on the Node Properties window which is accessed from SONET and vice versa.

In the Managing an Element window, the Status field will not be editable if the component is 
shared with a SONET node. A warning message appears if you try to edit the field.

Furthermore, validation in SONET will prevent a node from being deleted (or removed if the 
SONET network shares the node) if it is shared with an optical component and connections in 
the optical network terminate at the node.

Optical Provisioning enhancement - IR 73705
The optical provisioning assistant will find a path through a network when shared SONET 
nodes are used in a network.
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Browse Link Removed
In previous releases, there were two browse links used to search for and embed existing 
networks from the Managing an Embedded Network window. The browse link on the General 
view has been removed. Use the browse link on the Embedded Network Properties view to 
search for networks to be embedded.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Opening a Network System
Embedding a Network

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Managing an Embedded Network Window

Engineering Work Order

Purge orders
In MetaSolv Solution Utilities, you can now purge Engineering Work Orders.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Purging Service Requests with Active Circuits

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Order Purge Window

Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Purge Utility
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Engineering Work Order
Removing supplement to cancel EWOs - IR 74692
Previously, the remove functionality did not allow the users to remove canceled EWOs that 
were never assigned a task or connection. You can now remove supplement to cancel EWOs 
that do not have equipment, connections, or tasks.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Removing Engineering Work Orders

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Engineering Work Order - Search Window

Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Engineering Work Orders

Removing connections from EWO - IR 74238
In previous releases, users were unable to remove connections from an Engineering Work 
Order after the Connection Design window had been opened for any of the connections on the 
order.

Now, users can remove connections from Engineering Work Orders if there has been no 
connection design lines created for the connection even if the connection design task has been 
opened for connections on the order.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Removing Connections from an EWO

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Engineering Work Order - Search Window
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Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Engineering Work Orders

ISR

Processing the TRANS task - IR 40528
When processing the TRANS task for an ISR, the user will now be prompted to open either the 
tech translation sheet (default) or the Trunk Circuit Order report. Additionally, the tech 
translation sheet will now allow access to the trunk group window for an ISR. Access the 
Trunk Group Information window from the Options menu.

Accessing online Help for this enhancement
Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Tech Translation Sheet for Message Trunk Group Summary
Tech Translation Sheet for Special Trunk Group Summary

Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

TRANS Task
Smart tasks

PSR

Identifying Auth code and PIN code as unique - IR 73814
The software was allowing duplicate Auth Codes and PIN Codes for calling card products that 
are in Pending status, and the user wants more control over setting the unique indicator for 
Auth Codes and PIN Codes.  The user now has increased flexibility because the Unique 
checkbox on the Authorization/Account/PIN Code Maintenance window changed to a drop-
down list. The drop-down contains the following values:

a) Not Unique: System allows the duplicate values.

b) Single Use Only: Code is unique for any customer and any product catalog item.

c) By Customer: Code is unique for any product catalog items for that customer.

d) By Customer & Catalog Item: Code is unique for the same product catalog item for that 
customer.
120 MetaSolv Software, Inc.



PSR
If the Auth Code is used already, a message appears.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Creating an Authorization/Account/PIN Code
Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Authorization/Account/PIN Code Maintenance Window
Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Authorization/Account/PIN Codes

Ported in TNs have a FOC of U when being disconnected - IR 
72901

Ported in TNs when disconnected have a 911 FOC of U.  This is not always the best default, 
based on customer processes. A new preference in PSR lets the user control the default setting. 
The Function Code to Set for LNP Disconnects preference allows you to make the system set 
the function code to either a D or a U when disconnecting an LNP number. 

Function Code to Set for LNP Disconnects Preference

Treeview Location: Service Request>Product Service Request>E911

Type: System

Options: 

D - Delete (default)

The software sets the function code (FOC) to D when disconnecting an LNP number.

U - Unlock

The software sets the function code (FOC) to U when disconnecting an LNP number.

Accessing online Help for this enhancement
Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Function Code to Set for LNP Disconnects Preference
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Reconnect option to be available at any time prior to DD 
completion - IR 75769

The user does not want to remove the Reconnect option from a Disconnect order after that 
Disconnect order was DLRD completed.

A new preference was created in PSR called the Allow DLRD-Issued Lines to be Reconnected 
from Product Level preference.

Leaving the preference set to Yes (default) allows the user to reconnect at the product level 
even though the disconnect has been processed through the DLRD/RID task already.  If the 
user selects No and the disconnect order has been worked through the DLRD/RID task, the 
Reconnect option is hidden at the product level just like it is at the child level.

Allow DLRD-Issued Lines to be Reconnected from Product Level Preference

Treeview Location: Service Request>Product Service Request

Type: System

Options: 

Y (default)

When you supplement a PSR, you can right-click the disconnected product, and 
the Disconnect this item option appears. This option allows you to reconnect the 
product.
N

When you supplement a PSR, the Disconnect this item option does not appear 
when you right-click a disconnected product.

Accessing online Help for this enhancement
Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Allow DLRD-Issued Lines to be Reconnected from Product Level Preference

Assigning same quantity of telephone numbers to each line 
product - IR 75631

Previously, if the user wanted to assign the same number of telephone numbers to each line 
products in the Telephone Number Assignment window, they had to set the quantity of 
telephone numbers for each line product on the Quantity to Assign window.

This enhancement allows the user to click the Apply to All button on the Quantity to Assign 
window. If this button is clicked instead of the OK button, the selected quantity of telephone 
numbers is assigned to all remaining lines.
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Technical Framework
If the user chooses to assign a larger number of telephone numbers than are available, the 
system assigns the remaining telephone numbers. For example, if 10 telephone numbers are 
selected to be assigned to five lines, and a quantity of three is applied, lines 1 - 3 will be 
assigned three telephone numbers each, and line 4 will be assigned the remaining (10th) 
telephone number.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Assigning Telephone Numbers

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Telephone Number Assignment Window
Quantity to Assign Window

Supp cancel for PSR using MIP enhanced flow-through - IR 
74897

The user previously could import a supp cancel PSR, but the order would never actually get 
processed. So, the order would be disabled with cancel as a supplement, but the data was never 
actually updated.

This enhancement allows the user to supp cancel a PSR using the PSR API for the following 
item types: LINEPROD, CKTPROD, NPSPROD, SYSOPTION and OPTION as long as none 
of them have an assigned telephone number.  MetaSolv Solution does not currently support 
supp canceling any item types not listed above or any of the above item types with a telephone 
number assigned to them.

Technical Framework

Search criteria for Trouble Ticket Queue window
Current functionality allows the user to set up a view in the Trouble Ticket Queue window. A 
view is a set of criteria that filters the data that appears in the window. The view feature is 
currently staying in MetaSolv Solution without any changes.

Search criteria is the newer and preferred way to filter information in the Trouble Ticket 
Queue. It also allows you to determine what is displayed on the window. However, it 
processes much faster in the background. If you have created views that take a long time to 
MetaSolv Solution What’s New 123



appear in the Trouble Ticket Queue, use the Search Criteria feature to retrieve the results 
faster.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Set Up Search Criteria

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Ticket Queue - Search Criteria Window

Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Views & Search Criteria

Technical Infrastructure

Entity Type drop-down not available - IR 74821
You can only create internal entities for 11-byte CLLI’s, so the drop-down is not available for 
8-byte CLLI’s. The online help procedure was updated to reflect this requirement.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Defining a Building's Internal Entity

New wireless technology module
A new technology module has been added so customers can quickly build out their wireless 
networks. This technology module is a software option that can be purchased. There are four 
new network templates that are part of the wireless technology module: 

MetaSolv Wireless 3G UMTS TM 

This template is used when all services are over IP.

MetaSolv Wireless 2G TDMA TM
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Work Management
This template can also be used for CDMA when the rules are modified. This template is 
used for physical connections only.

MetaSolv Wireless 2.5G GSM/GPRS TM

This template is used for virtuals riding over ATM/FR and IP.

MetaSolv SS7 TM

This template is embedded in other wireless templates and is used for signalling only.

Accessing online Help for this enhancement 
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Opening the Network Template Maintenance Window
Viewing the Network Template Maintenance Window
Creating a Network System

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Network Templates Window

Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Network Templates
Network Design

Work Management

New From option added to rules and behaviors - IR 75654
You can now use New From functionality to create a new rule from an existing rule. When 
you click the New From link, all of the characteristics of the existing rule are carried over to 
the new rule, including all insert and delete task behaviors. This makes the process of creating 
new rules easier and faster.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure name in the Search field to learn how 
to use this feature. This procedure tells you how to open the windows used in this 
enhancement.
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Creating a Rule

Rebuild drawing option available on PERT chart - IR 74973
You can now correct a PERT chart drawing that may have become invalid on an order. Right-
click the PERT chart background and select Rebuild Drawing from the pop-up menu. The 
PERT chart will be rebuilt.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. This procedure tells you how to open the windows used in this 
enhancement.

Working With the PERT Chart

XML API option

New functionality for APIs
MetaSolv Solution now includes an XML API option that can be installed during the 
MetaSolv Solution installation. The XML API option includes the Metasolv Integration and 
Portal Toolkit, which provides an integrated development environment through the BEA 
WebLogic Platform. 

The Workshop component of the BEA WebLogic Platform allows you to create workflows 
simulating your XML API integration in a graphical environment. MetaSolv’s XML APIs are 
exposed through the use of BEA controls. Currently, four controls are in place for integration 
with MetaSolv Solution: Customer Management, Order Management, Inventory Management, 
and Event Management. You can use the methods for each control to build your integration 
application. XML schemas for the methods are fully documented.

Documentation for this enhancement
The following documents can be downloaded from the Oracle E-Delivery Web site:

Setup and configuration information—MetaSolv Solution 6.0.3+ Setup Guide
Using the XML APIs to integrate MetaSolv Solution—XML API Developer’s Reference
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Appendix D: What’s New in 6.0.5
This appendix documents enhancements that are new with version 6.0.5 of MetaSolv Solution.

Engineering

Group Assignment performance enhancement - IR 74978
Performance was significantly improved for group assigning trunk circuits to a facility circuit. 

Circuit Emulation Phase 2
You can create connections that have properties of both a non-NGN physical connection 
(trunks, specials, and facilities) and a NGN virtual connection, and these connections can be 
designed to ride bandwidth connections. 

The connection design window has a new bandwidth link that appears when you design a non-
NGN physical connection and you have one of the following technology modules: ATM, 
Ethernet, or IP.

When you design the connection to ride a bandwidth connection, the custom attributes tab and 
the bandwidth allocation report feature are enabled. These connections show up in connection 
hierarchy as their ecckt type riding parent bandwidth connections. And you can still use the 
group assign feature. 

There is some setup involved to use circuit emulation. In your network template, you must set 
up a virtual connection between the network elements that you want your non-NGN physical 
connections to emulate. You must also associate the virtual connection to the assignable 
bandwidth link connection specification so that the virtual connection (non-NGN physical 
connection) can ride the assignable bandwidth link. You should also set up custom attributes 
on your new connection similar to your virtual connection custom attributes.

Setting up templates to use circuit emulation
In your network templates, you need to set up a virtual connection specification between the 
network elements that can support the new connections and relate it to the assignable 
bandwidth connection between those network elements. 
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You can use an existing virtual connection specification or create a new virtual connection 
specification. In the example below a new virtual connection specification called CES 
(Connection Emulation Specification) will be created. Your virtual connection specification 
will represent the new connection (the physical connection that has virtual connection 
properties). For example, it can represent the physical trunk that can ride an assignable 
bandwidth connection. You must also relate the virtual connection specification to the 
assignable bandwidth connection between network elements.

You should also use the MetaSolv Utilities to add pertinent custom attributes to the newly 
created virtual connection specification.

In the following example an assignable bandwidth link connection exists between two ATM 
Switches. In this example, a new virtual connection specification is created and related to the 
assignable bandwidth link connection specification.

To set up a new virtual connection 
1. Select Inventory Management on the navigation bar, and click Inventory Management 

Setup.

2. Click the Network Templates link in the Network/Equipment section.

3. Click the menu icon on the Connection Specs panel, and select Add Connection Spec 
from the pop-up menu.

4. In the Connection Type Name field, select Virtual Connection.

5. In the Connection Spec Name field, type CES hybrid connection.

6. Enter other applicable information on the general view window.
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7. Enter any other applicable information on the Transmission Parameters and Custom 
Attributes windows, and click OK.

8. Associate custom attributes to the specification in MetaSolv Utilities.

To relate the new CES virtual connection spec to the parent bandwidth 
connection
1. Click the Connection Specs panel, and expand Bandwidth Link.

2. Double-click Assignable Bandwidth Link.

3. Click the Related Connection Specs link.

4. Double-click Relate Connection Spec.
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5. Expand Virtual Connection and select the CES Hybrid Connection check box.

6. In the Relationship Type drop-down, select Assignment and click OK.

To set up the virtual connection relationship in your network template
1. Click the Network Templates panel.

2. Expand a template type.

3. Double-click to open a network template.
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4. Right-click the connection relationship between the two network elements, and select 
Properties from the pop-up menu. In this example, the Intra connection between ATM 
switches.
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5. Click the Connection Specs link.

6. Double-click Associate Connection Spec.
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7. Scroll down the list and expand Virtual Connection.
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8. Check the CES Hybrid Connection check box, and click OK.

9. Double-click the CES Hybrid connection.

10. Select Use Next Available Bandwidth Parameter for Assignments check box to allow 
Group Assign to increment the parameters (VPI/VCI) based on the next available value.

11. Click the Assignable Connection Specs link.

12. Double-click Add Assignable Connection Spec.

13. Expand the connection relationship. In this example, the ATM Switch - Intranetworking - 
ATM Switch.
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14. Check the check box next to the Assignable Bandwidth connection relationship and click 
OK.

Assigning an emulated circuit to a bandwidth connection
1. From the CLR/DLR Design View or Schematic View for your non-NGN physical 

connection, click the Bandwidth Link.

The Bandwidth check box is selected for you.

2. Enter search criteria, and click the Search button. 

3. Right-click the bandwidth you wish to assign to, and select Assign Connection from the 
pop-up menu.

4. If there are multiple virtual connection specs, a list will appear. Select the virtual 
connection spec (CES Hybrid Connection) you want to use and click OK.

5. If allocation parameters are required, a message box will appear. Enter allocation 
parameters, and click OK.

This creates a bandwidth design block on the CLR/DLR design lines and the schematic 
design view.

6. Click the Properties link.
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7. Click the Custom Attributes tab.

8. Enter custom attributes.

9. Click the CLR/DLR tab.

The notes give the name of the Network Element. 
The LOCN column is the CLLI Location 
The EQPT TYPE/FACDSEG, RELAY RACK/FACTYPE and UNIT/CHANNEL 
columns wrap the network element ID for that end of the circuit.
If the network element ID is changed in network systems this network element ID will 
be reconciled. If there isn’t a network element ID the columns will be blank.
The second line is the bandwidth circuit the hybrid is riding. The circuit is formatted 
the same as a facility block. CLF, CLS and freeformat are formatted differently.
The MISC column represents the Allocation Parameters assigned to the hybrid 
connection.

10. Select Outputs>Bandwidth Allocation Report to view the Bandwidth Allocation 
Report.

11. Select Save>Save Current Issue to save the design lines.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Adding a Bandwidth Assignment

Plant Automation
When the user chooses to build cable pair assignments, the PRILOC and SECLOC 
information will be captured from the order. The default terminal location to the cable pairs 
assignment window will default as follows: If both locations are end user locations the default 
will be the terminals associated to the end user locations for the A and Z side of the circuit. If 
the assignment is for the I (interoffice) side of the circuit, no changes take place. If only one 
location is an end user location, then the terminal location is defaulted to the end user location 
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when the cable pair assignment is for the A and Z sides of the circuit. If neither locations are 
end user locations, the terminal location is "UNKNOWN".

Work Queue

Work Queue Manager EWO Bitmap
In the work queue manager "EWO" will display in the column ’cf_type_of_sr_txt’, and a blue 
notepad bitmap will appear in the ’cf_type_of_sr_bitmap’ column for tasks assigned to 
engineering work orders.

PSR

Switch Validation for TN Assignment - IR 75774
A new preference exists so users can decide whether or not to override the switch validation 
when assigning telephone numbers on an order.

Treeview Location: Service Requests > Product Service Requests - PSR

Type: System

Options:

Allow Manual Selection (default)
The Override Switch Validation checkbox appears on the TN Assignment window 
in PSR.

Always Validate
The software always validates if local telephone numbers are supported by the TN 
switch on the end user location.

Never Validate
The software never validates if local telephone numbers are supported by the TN 
switch on the end user location.

Accessing online Help for this enhancement
Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

TN Assignment Window

Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Switch Validation for TN Assignment Preference
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Updated service location not appearing - IR 69115
When the user updates the service location through Customer Profile, and the Customer 
Profile > Locations screen is refreshed, the location they just changed was not appearing in the 
Locations.

A new preference was created called Set Extract Indicator to 'Y' on Address Change to solve 
this issue.

Treeview Location: Service Requests > Product Service Requests - PSR > E911

Type: System

Options:

Y
When a service location/address is updated either by right-clicking on a service 
location and selecting Update Service Location from a PSR, or by updating the 
service location from Application Setup or Customer Profile, the Extract Indicator is 
set to Y when the related E911 is updated.
However, if the preference is set to Y and an address is updated and there are related 
E911 records that have a telephone number status of Disconnected, Transitional, 
Unavailable or Pooled, then when the related E911 is updated the Extract Indicator is 
set to N for those records. 

N (default)
The related E911 information is updated normally and the Extract Indicator is not be 
changed or updated.

Accessing online Help for this enhancement 
Open the online Help, and type the following preferences, concepts, and FAQs for additional 
information.

Set Extract Indicator to 'Y' on Address Change

Cannot remove required labels in product catalog - IR 71721
Users should have the ability to decide whether a required label in the product catalog shows 
up at order time or not for any particular product.

Setting the label as required in the product specification automatically makes the label appear 
in the product catalog for all items based on this product specification. However, you can 
remove the label from the item by right-clicking the label and selecting Remove Label from 
the pop-up menu.
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Accessing online Help for this enhancement 
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Adding a Label to a Product Specification

Telephone Number management improvements

Organizing international telephone numbers by sub-category
The category and sub-category feature has been enhanced to include categorizing international 
telephone numbers.

For example, if you want to designate a group of numbers to be used for VoIP, you can create 
a sub-category of VoIP for the category of Assignable Numbers. You can create the category 
and sub-category using the Telephone Number Categories link on the Inventory 
Management Setup page.

Searching for telephone numbers using geographic areas
If you want to use geographic areas to search for US or international numbers to assign to an 
order, you must have network areas enabled and create network areas with geograpic areas 
designated through structured formats. Then, you must associate the telephone numbers with 
the network area.

Using the Telephone Numbers window to search for numbers
After setting up your US or international telephone numbers, you can search for the numbers 
using the Telephone Numbers window from the Inventory Management navigation bar by 
clicking the Telephone Numbers link or from the PSR by right-clicking the product item and 
selecting Assign Telephone Numbers from the pop-up menu.

If you categorized your telephone numbers, you can use the Telephone Number Category 
and Telephone Number Sub-Category fields on the Search tab to limit your search.

When you are assigning telephone numbers to a PSR, you can assign them to both premise 
(service location) and non-premise (global) products. If you assign them to a premise product, 
you can use the Network Areas radio button on the Telephone Numbers window to search for 
the assignable telephone numbers in that network area. If you assign them to a global product, 
you can use the Geographic Areas radio button to find the numbers.

Note: You must have network areas enabled to use these two radio buttons. In addition, to use 
the Geographic Areas radio button, you must complete the Geographic Areas tab on the 
Network Area Definition window.
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Accessing online Help for this enhancement 
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Assigning Telephone Numbers
Creating a Telephone Number Sub-Category

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Telephone Numbers Window
TNI Categories Window

XML API enhancements

Integration flow-through package using MetaSolv Solution and 
ASAP demonstrates activation

The Flow-Through Package from MetaSolv Solution demonstrates how activation can be 
achieved with ASAP through the integration of the two products. Sample files delivered with 
6.0.5 show workflows in WebLogic workshop that demonstrate how to:

Manage events and messaging between the applications
Request the appropriate MetaSolv data for the service ordered
Decompose MetaSolv Solution data and map it to ASAP’s CSDL commands
Construct an ASAP order from the CSDL commands
Update Work Management using the responses from ASAP as the activation order is 
executed

Two technologies are detailed in the integration workflows: POTS and DSL. The process for 
each is fully documented with screen shots of the setup in MetaSolv Solution that ensures that 
the data required is collected for the ASAP activation.

The package shows the new activation API, an external API written to collect information 
from MetaSolv Solution, and new event methods that interpret responses from ASAP and 
update the Work Management Work Queue in the user interface.

To learn more about the flow-through packages for DSL and POTS, see the Flow-Through 
Packages Guide located on the Oracle E-Delivery Web site.
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XML API enhancements
New Methods
A new method called getActivationDataByKeyRequest has been added to the XML Order 
Management API. This method exports MetaSolv Solution order data needed to activate a 
service request on the network.
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Appendix E: What’s New in 6.0.6
This appendix documents enhancements that are new with version 6.0.6 of MetaSolv Solution.

Equipment

Adding a link to equipment
A Links tab was added to the Equipment Window and Equipment Specfication Window to 
allow you to add, edit and delete links to Web pages, documents, and so on.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Adding a Link to Equipment

XML APIs

New APIs

LSR XML API
LSR functionality can now be accessed through an XML API. All of the functionality 
available in the LSR CORBA API is available in the new LSR XML API. To use the new API, 
you must install the MetaSolv Solution core application with the XML API option. Once the 
core product is installed, you can install and configure LSR 6.10. To learn more about 
installing and configuring the LSR application for XML APIs, see the MetaSolv Solution LSR 
Setup Guide.

This enhancement provides a set of XML API methods for LSR compliant with LSOG6.  
These methods can be incorporated into an integrator's custom workflows using the WebLogic 
Integration toolkit. The following LSR XML API methods are provided using a Java control:
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Exports:

getLSRByKeyRequest—Exports a local service request (LSR) for a given order key.
getLRByKeyRequest—Exports a local response (LR) for a given order key.  
getLSRCMByKeyRequest—Exports a local service response/completion (LSRCM) for a 
given order key.  
getDLByKeyRequest—Exports a directory listing (DL) for a given order key. 

Imports:

createLRByValueRequest—Imports a local response (LR). 
createLSRCMByValueRequest—Imports a local service response/completion (LSRCM).  
createNPLSRByValueRequest—Imports a number portability local service request 
(NPLSR).  
createDSREDByValueRequest—Imports a directory service request error detail 
(DSRED).  
createDSCNByValueRequest—Imports a directory service completion notice (DSCN).  

Queries:

queryCCNARequest—Retrieves a list of all customer carrier name abbreviations (CCNA) 
in MetaSolv Solution.  
queryLSRRequest—Retrieves a list of LSR orders for a given purchase order number 
(PON).  
queryPONSForCCNARequest—Retrieves a list of PONs for a given CCNA.  
queryLSRForPONCCNAVERRequest—Retrieves an LSR order for a given PON, CCNA 
and version.

To learn about working with MetaSolv Solution XML APIs in WebLogic Workshop, see the 
MetaSolv Solution XML API Developer’s Reference.

E911 XML API
E911 functionality present in the current CORBA PSR Ancillary APIs has been added to the 
XML Inventory Management API. The E911 methods make it possible to export E911 data 
from MetaSolv Solution to an E911 service provider. For additional information on the E911 
method, see the XML API Developer’s Reference.

getE911DataRequest—Retrieves E911 records.
updateE911DataRequest—Updates the status of a set of E911 records.
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XML APIs
New methods

Transfer tasks
A transfer task method transferTaskProcedureValue has been added to the XML Order 
Management API. The transfer task makes it possible to move tasks from one work queue to 
another.
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Appendix F: What’s New in 6.0.7
This appendix documents enhancements that are new with version 6.0.7 of MetaSolv Solution.

Service Provider enhancement
This enhancement affects four areas of MetaSolv Solution: Organizations, Security, Customer 
Accounts, and Product Catalog. The Service Provider enhancement lets you set up an 
Organizations identifier (the service provider name) that can be associated with a customer 
account, security groups, and product catalog items. This association allows you to partition 
your data in useful ways using the service provider name. Two examples of how you might 
use this enhancement include:

Letting your company’s customers enter their own orders in MetaSolv Solution. You can 
set up the application so that one of your company’s customers can log on to MetaSolv 
Solution and enter an order. The customer sees only the data in the product catalog that is 
appropriate for the customer’s company.
Partitioning your company data by region. If your business is segmented by region, you 
can partition data so that users entering orders see only data that pertains to the region they 
are servicing.

To access this enhancement

1. Select Application Setup on the navigation bar, and click Organization Setup.

2. Click the Service Providers link.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn how 
to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Using the Service Provider Name to Partition Data
Creating a Service Provider
Associating a Service Provider with a Security Group
Assigning a Service Provider to a Product Definition
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New APIs
LSR 9 functionality can now be accessed through an XML API. All of the functionality 
available in the LSR 9 CORBA API is available in the new LSR 9 XML API. To use the new 
API, you must install the MetaSolv Solution 6.0.7 core application with the XML API option. 
Once the core product is installed, you can install and configure LSR 9. To learn more about 
installing and configuring the LSR application for XML APIs, see the MetaSolv Solution LSR 
Setup Guide.

XML Order Management API changes
New methods:

CNAM functionality present in the current CORBA PSR Ancillary APIs has been added 
to the XML Order Management API. The CNAM methods make it possible to export 
CNAM data from MetaSolv Solution to a CNAM service provider. For additional 
information on the CNAM method, see the XML API Developer’s Reference.

getCNAMDataRequest - Used to retrieve CNAM records.
updateCNAMDataRequest - Used to update the status of a set of CNAM records.

LIDB functionality present in the current CORBA PSR Ancillary APIs has been added to 
the XML Order Management API. The LIDB methods make it possible to export LIDB 
data from MetaSolv Solution to a LIDB service provider. For additional information on 
the LIDB method, see the XML API Developer’s Reference.

getLIDBDataRequest - Used to retrieve LIDB records.
updateLIDBDataRequest - Used to update the status of a set of LIDB records.

XML Inventory Management API changes
The queryInventoryManagementRequest has been enhanced with the ability to search for an 
MSAG address. So, now when calling the method queryInventoryManagementRequest, you 
have the choice of querying using one of the following: 

queryTelephoneNumberInventoryValue
queryMSAGInventoryValue 

An MSAG address range is returned by queryMSAGInventoryValue.
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Appendix G: What’s New in 6.0.8
This appendix documents enhancements that are new with version 6.0.8 of MetaSolv Solution.

BEA sp5 enhancement
BEA upgraded their software, and MetaSolv wanted to take advantage of the improvements 
that the BEA upgrade provided. Therefore, MSS 6.0.8 uses BEA sp5.

To access this enhancement

1. BEA sp5 can be downloaded from the Oracle E-Delivery Web site.

Service Order Activation (SOA) enhancement
Service Order Activation (SOA) allows a company to port a telephone number for a customer 
within a rate system from one switch to another. This allows a customer to keep the same 
telephone number when the service location changes.

To access this enhancement

1. Select Application Setup on the navigation bar, and click Order Management Setup.

2. Click the SOA link in the PSR section.

SOA Overview
MetaSolv Solution does not handle the actual porting of numbers. That process is handled by 
third-party software applications developed for that purpose. But MetaSolv Solution submits 
requests to have a number ported into its telephone number inventory and responds to requests 
from other companies to port out telephone numbers.

The mechanism that allows MetaSolv to communicate with third-party software applications 
is the SOA API. This API provides all of the request information necessary for the third-party 
application to perform and receives information from the third-party application to update 
MetaSolv Solution telephone number inventory records. 

The SOA API sends the appropriate data on the telephone number, the new and old service 
provider, due dates, and so on to the third-party application that communicates with the NPAC 
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SMS, a governing body for the telecom industry that tracks where numbers are ported from the 
original switch where they were placed in service. 

Numbers are ported in MetaSolv Solution by creating a PSR order with a SOA task associated. 
As a user, you will see a SOA task appear in the Work Queue task list, but you do not have to 
enter additional information to complete a SOA request. 

Process for creating a SOA request to port a telephone number
1. Get the relevant information from the customer for creating an order for porting the 

number.

2. Create a PSR order for a line product and place the numbers to be ported on the PSR order.

3. Select the Ported Telephone Numbers option when you are assigning telephone numbers 
for the PSR order.

This option is found on the Telephone Numbers window - Create tab.

4. Complete the PSR order.

5. Go to the Work Queue Manager and find the order.

6. When the SOA task associated with the order has a status of Ready, right-click on the SOA 
task and click Initiate to initiate the SOA gateway event.

This starts the SOA API communication with the third-party software application that 
manages communication with the NPAC SMS to port a telephone number from one 
service provider to another. When the SOA transactions are completed, the Work Queue 
Manager is updated to show the results.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure names in the Search field to learn 
how to use this feature. These procedures tell you how to open the windows used in this 
enhancement.

Searching for SOA Transactions
Viewing SOA Transactions Associated with an Order
Modifying a SOA Request

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

SOA List Window
SOA Message Request and Response Window
SOA Request Detail Window
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SOA Response Detail Window
SOA Search Criteria Window

Open the online Help, and type the following preferences, concepts, and FAQs in the Search 
field for additional information.

NPAC SMS Overview
Service Order Activation Overview
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Gateway event notes enhancement 
This enhancement allows a user who is working with tasks in the Work Queue Manager to 
send success and error events to an upstream system manually.

For this enhancement to work, you must enable the Allow to Maintain Gateway Event Notes 
Preference. To learn more about this preference see the following section named "New 
preferences."

To access this enhancement

1. From the Work Queue Manager window, select a task with gateway events associated.

2. On the Gateway Events tab, select the gateway event for which you want to view notes, 
then right-click and select Gateway Event Notes.

Accessing online Help for this enhancement
Open the online Help, and type the following procedure name in the Search field to learn how 
to use this feature. This procedure tells you how to open the windows used in this 
enhancement.

Managing Gateway Event Notes

Open the online Help, and type the following new window names in the Search field to view a 
list of procedures and field definitions for each window. You can use this list to secure these 
windows if you use MetaSolv Solution’s Security feature.

Gateway Event Notes List Window
Gateway Event Notes Window

Open the online Help, and type the following preferences, concepts, and FAQs in the Search 
field for additional information.

Allow to Maintain Gateway Event Notes Preference
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Groom Tool enhancement for Optical Networks
Groom Tool enhancement for Optical Networks
This enhancement provides a user who working in the MSS Groom Tool the ability to groom 
connections that are provisioned to an optical network.  

To access this enhancement

1. From the New Groom Facility window, select Base Connection(s).

SET UP
Before using the Groom Tool to perform this work, the user must first prepare the network for 
the pending changes. For example, to perform the add node function within the grooming 
workspace, the user must first build the new node and the connectors to and from the node 
within the Network Systems canvas. These connectors must also be fully auto-built out to the 
exact hierarchy as the connector they will be replacing.

USING THIS ENHANCEMENT
To groom these provisioned connections, the user simply selects the BASE CONNECTION(s) 
in the New Groom Facility window.  When these base connections are selected to be added to 
the workspace, new logic is triggered that will bring all of the channels, and equipment port 
assignments of the provisioned connection(s) riding the base connection(s), into the Groom 
workspace.

These connections may only be added to a workspace if, and only if, all connections in the 
workspace are part of the same optical network. Further, the provisioned connections may 
only be groomed to other base connections within the same network system.

To facilitate the possibility of grooming a large number of provisioned connections per base 
connection, a new menu option, "Groom Optical Hierarchy To", has been added to the 
connection hierarchy tree-views right-click menu within the Grooming workspace. This 
functionality will allow the user to move all of the channel assignments from one base 
connection to another. However, in order to user this functionality the base connections must 
have the same hierarchy. Also, the new base connection should not have any connections 
provisioned to it's hierarchy. The user will simply select the rows in the workspace that 
represent the assignments to be replaced and select the new menu option.

The software will then compare the hierarchies of the from and to base connections. When the 
hierarchies pass validation, the assignments will be mapped one-for-one from the existing base 
connection to the new base connection. The user will utilize existing functionality to modify 
the equipment port assignments of the provisioned connections.
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PSR Service Request Hierarchy enhancement 
regarding relating parent/child orders

This enhancement provides a user the capability to associate a PSR to another PSR that is part 
of a Service Request Hierarchy.    

To access this enhancement

1. Go to Order Management > Service Requests.

2. Search for service requests of type PSR.

3. From the Service Request Search Results window, select a PSR, right click, and choose 
Service Request Hierarchy from the pop-up menu.

4. From within the Service Request Hierarchy window, select a PSR, right click, and choose 
Associate Child Order from the pop-up menu.

5. From this point, the steps to associate a child are the same as when associating a child 
from the within the Service Request Search Results window, with the exception of the new 
checkbox that allows the user to search specifically for PSR orders. From here, a user can 
query for a list of PSR orders, and then select the PSR they wish to designate as a child 
order.
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New preferences
New preferences

Allow to Maintain Gateway Event Notes Preference
Treeview Location: Work Management>Work Queue Management>Gateways 

Type: System

Options:

N (default)

When this option is N, a user in the Work Queue Manager cannot send success and error 
events to an upstream system manually.

Y

When this option is Y, a user in the Work Queue Manager can edit the status and initiate a 
gateway event on a pending success or error event.

Process Allocation Threshold Check preference
Treeview Location: Inventory Management > Connection Design

Type: System

Options:

N (default)

When this preference is set to N, the allocation threshold check done when a GLR Save is 
executed does not occur. The threshold check can take a long time based on the number of 
bandwidths that a virtual connection is allocated to and the number of virtuals that each 
bandwidth has allocated to it.

Y

When this preference is set to Y, the allocation threshold check executes.
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XML APIs

New SOA XML API
The Service Order Activation (SOA) XML API is new for 6.0.8. SOA allows companies to 
port a telephone number for a customer within a rate system from one switch to another. See 
the description of SOA at the beginning of this appendix.

The following methods are included in the SOA XML API:

createSoaMessageRequest

This method will create a SOA request or a SOA response, depending on the input 
values provided for the method.

getSoaDefaultsRequest

This method will query for the list of valid values for several fields, and for several 
default fields. Based on the document number and telephone number as input, the 
following will be provided:

Spid value
Cause Code values
SvStatus values
LRN values
LRN default
Timer Type default
Business Hour default

getSoaInformationRequest

This method will query for the existing requests and existing responses. Additionally, 
it will give the fields for a transaction showing the default values that can be used for a 
new SOA request.

getSoaMessageToSendRequest

This method will query for those SOA transaction requests that need to be sent to 
NPAC via the gateway vendor. This is a flag that can be set for a SOA request 
transaction via the GUI.

getSoaTnsForOrderRequest

This method will query for the list of SOA telephone numbers within the order.

setTnSoaCompleteRequest

This method will set the internal MetaSolv request status on the last SOA request row, 
and the last SOA response row, to Success.
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XML APIs
Changes to existing XML APIs

XML Inventory Management API
The following methods were added to the XML Inventory Management API:

tnRecall

This method provides the ability to recall a single U.S. telephone number. A new 
instance of the input telephone number is created in TN inventory, except for TN, 
RESALE, and FOREIGN TNs.

updateTNRequest

This method provides the ability to update a single telephone number, contaminated or 
uncontaminated. 

XML LSR API
The following method was added to the XML LSR API:

createLSROrderByValueRequest

This method provides the ability to import an LSR order for port in or port out. The 
supporting methods used to send and recieve responses that are required by LSR 
orders are already available.

XML Order Management API
The following methods were added to the XML Order Management API:

addTaskJeopardyRequest

This method adds Task Jeopardy information to the input task number. Date and time 
information is stored in the database in Greenwich MeanTime (GMT).

getPSROrderByTN

This method returns detailed PSR Order informaiton based on the input TN.

getTaskDetailRequest

This method returns detailed task information based on the input document number 
and task number.

getTaskJeopardyRequest

This method returns a sequence of task jeapardy information based on the input 
document number and task number.

tnValidationRequest
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This method will "pre-validate" a desired action or request for a telephone number. 
The input object defines a telephone number, the type of validation needed, and the 
action proposed on the telephone number. 

Supported validation requests include:

PO  -  Port Out
PI  -  Port In
LO  -  Local Owned
R  -  Resell
T  -  Toll Free
F  -  Foreign

Supported activities include:

N  -  New
D  -  Disconnect
R  -  Restore
S  -  Suspend 

processSuppOrder

This method supports the supplemental processing of an existing order for the 
following scenarios:

supp-cancel
supp-change
supp-dueDate

updateEstimationCompletedDateRequest

???? No documentation available.....

createOrderRelationshipRequest

This method creates a relationship between the two input orders by inserting a row in 
the SR_RELATIONSHIP table.

The following existing methods were modified in the XML Order Management API:

createOrderByValueRequest, getOrderByKeyRequest, udpateOrderByValueRequest

These existing methods were enhanced to support:

port in.
service provider capabilities
user data.

getCustomerByKeyRequest, updateCustomerByKeyRequest
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XML APIs
These existing methods was enhanced to support service provider capabilities. Please 
note that a new customer is created via the createOrderByValueRequest, which was 
also enhanced to support service provider capabilities at the customer level, as well as 
at the orde level.

getProductCatalog

This existing method was enhanced to support service provider capabilities.

queryTNRequest

This existing method was modified such that "Old Block" logic was added. This 
means that the query now starts searching for TNs that match the input criteria based 
on the oldest block.

queryTNRequest and updateTNRequest

These existing methods were modified such that the structure returned by the 
queryTNResponse and the structure input to the updateTNRequest now define the 
same fields.

updateEntityByValueRequest

???? what was changed?
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Documentation
MetaSolv Solution 6.0.8 has two setup guides available on the portal, one for setting up 
MetaSolv Solution without the XML API option and one for setting up with the XML API 
option.
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Appendix H: What’s New in 6.0.10
This appendix documents enhancements that are new with version 6.0.10 of MetaSolv 
Solution.

SONET/SDH displays blocked channels
Customer Issue 201623

Within Network System Design, the hierarchical view of a SONET/SDH network now 
specifically indicates when a channel is blocked. Previously, blocked channels were displayed 
as part of the hierarchy, but there was no information to indicate that a particular channel was 
blocked. Now, the blocked channels display the text "(BLOCKED)", which is consistent with 
the way blocked channels display on the Connection Hierarchy page.

This enhancement allows you to make decisions while viewing a SONET/SDH network from 
within Network System Design, without having to validate the data against the Connection 
Hierarchy page to ensure any given channel is not blocked. Also, displaying this information 
is consistent with the way it displays on the Connection Hierarchy page.

To access this enhancement

1. Select Inventory Management on the navigation bar.

2. Click the Network Systems link. 

This opens the Network System Design page.

3. From the Network List, expand the list of SONET/SDH networks.

4. Select and open the appropriate network from the list of SONET/SDH networks.

5. Right-click within the canvas and select Hierarchical View from the pop-up menu.

6. Expand the appropriate connection to view the channels. (To see this enhancment, a 
connection that actually has blocked channels must be viewed.)
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Change circuit identifier on EWO
Customer Issue 201639 / Internal CR 136851

For engineering work orders (EWOs), a new Change Connection Id  link is available on the 
Manage Connections page. This link provides the ability to change a circuit identifier on an 
EWO after the Connection Id page is closed for the connection. Only one connection can be 
opened at a time. After the design is created for a connection, the EWO must be supplement-
corrected to change the connection identifier (ECCKT).

This enhancement allows you to change connection IDs. Previously, the only way to change a 
connection ID was to remove the connection and then re-enter it. Changing the connection ID 
when either or both of the connection locations change is a common practice because the 
CLLI representing the location is often part of the connection ID. Therefore, when either or 
both locations change, it should reflect in the connection ID to avoid confusion regarding the 
connection’s actual end points.

To access this enhancement

1. Choose path a or path b:

a. Open the Work Order Summary page for a new EWO:

Select Order Management on the navigation bar.
Click the New Engineering Work Order link.
Enter the required data on the Work Order Information window, and click the 
Save and Close button. 

b. Open the Work Order Summary page for an existing EWO:

Select Inventory Management on the navigation bar.
Click the Engineering Work Orders link. 

This opens the Engineering Work Order Search window.

Enter the appropriate search criteria and click the Search button.

This opens the Engineering Work Order Search Results window.

Select and open the appropriate EWO.

2. Click the Manage Connections link located under the Related Pages section. 

This opens the Manage Connections page.

3. Select the check box for the connection ID to be changed. Select only one connection ID 
at a time.
162 MetaSolv Software, Inc.



Change circuit identifier on EWO
4. Click the Change Connection Id link located under the Actions section. 

This opens the Circuit Identification page.

a. If more than connection ID is selected in step 3, when the Change Connection Id link 
is clicked the following error message is displayed: "Please select only one connection 
to change."

b. If designs are already created for a connection and the Change Connection Id link is 
clicked, the following error message is displayed: "Non supp’d ECCKT change not 
allowed because work has begun on circuit." To change the connection ID, return to 
the Work Order Summary page and click the Process Changes link. This supplements 
the order which allows the connection ID to be changed.

5. Enter the updated Circuit Identification and click OK.
MetaSolv Solution What’s New 163



Add/Review Notes link on Work Order Summary
Customer Issues 201854, 244958

A new Add/Review Notes link is now available on the Work Order Summary page. This link 
opens the same Service Request Notes window that opens from the Product Service Request 
page. Additionally, there is a new Notes section on the Engineering Work Order Report that 
reflects notes on the order. 

This enhancement allows you to enter notes on engineering work orders, which may be 
necessary for certain orders. Also, having notes on engineering work orders is consistent with 
the other types of orders throughout MetaSolv Solution.

To access this enhancement

1. Choose path a or path b:

a. Open the Work Order Summary page for a new EWO:

Select Order Management on the navigation bar.
Click the New Engineering Work Order link.
Enter the required data on the Work Order Information window, and click the 
Save and Close button. 

This opens the Work Order Summary page.

b. Open the Work Order Summary page for an existing EWO:

Select Inventory Management on the navigation bar.
Click the Engineering Work Orders link. 

This opens the Engineering Work Order Search window.

Enter the appropriate search criteria and click the Search button. 

This opens the Engineering Work Order Search Results window.

2. Click the Add/Review Notes link located under the Actions section. 

This opens the Service Request Notes list window.

3. Right-click within the window and select New from the pop-up menu. 

This opens the Service Request Notes window.

4. Enter appropriate data in the text box click OK.

5. To view the Engineering Work Order report Notes section, click the Print link located 
under the Actions section. (To see the notes on the Engineering Work Order report, notes 
must exist on the order.)
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Network Connection Specs Hierarchy displays Connection Status
Network Connection Specs Hierarchy displays 
Connection Status
Customer Issue 201900

The Network Connection Specs Hierarchy treeview, located on the Managing a Connection 
page, now displays the connection status to the right of the connection.

This enhancement allows you to make decisions while viewing a network from within 
Network System Design, without having to validate the data against the Connection Hierarchy 
page to determine connection statuses. Also, displaying this information is consistent with the 
way it displays on the Connection Hierarchy page.

To access this enhancement

1. Select Inventory Management on the navigation bar.

2. Click the Network Systems link. 

This opens the Network System Design page.

3. From the Network List, expand the appropriate type of network to display the list of 
networks.

4. Select and open the appropriate network from the list of networks.

5. Double-click the appropriate Component Relationship. 

This opens the Managing a Connection page which contains the Network Connection 
Specs hierarchy treeview.

6. Drill down the hierarchy. The connection status displays on all levels of connections 
throughout the hierarchy.
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Re-use TCICs on pending disconnect trunk groups 
Customer Issue 205755

When a trunk member is disconnected, the TCIC assigned to that trunk member is now be 
available for re-use. This availability occurs when the disconnect action is placed on an order, 
which is prior to the trunk member being disconnected by Due Date processing. When a TCIC 
on a pending disconnect order is re-used, the disconnect order must be completed before the 
order containing the re-used TCIC is completed. Finally, there are edits in place that do not 
allow a disconnect order to be canceled if it has TCICs that are being re-used until the new 
order is cancelled or removes/changes the TCICs to something other than the TCICs on the 
disconnect order.

This enhancement allows you to re-use TCICs that were assigned to a trunk member that has 
been disconnected without having to wait until the disconnect order is due date completed. 
This frees up TCICs much faster, which is important because they are limited in their 
uniqueness based on location combination or location / point code, which is defined by an 
existing user preference.

To access this enhancement

Procedurally, there is nothing new with this enhancement; all changes were done to processing 
that takes place behind-the-scenes. Specifically, from a user perspective, the process of 
disconnecting a trunk or assigning a TCIC to a trunk hasn’t changed; what has changed is that 
TCICs become available for re-use faster because you do not have to wait until the disconnect 
order is due date completed. 

Visually, there is one new error message that is encountered if the disconnect order that has its 
TCICs being re-used is supp-canceled. The error message states "You are attempting to 
process a cancel order that has circuits with TCICs re-used on a different order. Please change 
TCICs on order nnn before processing this Supp-Cancel."
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PSR to LSR Mapping enhancement for MAPPORT
PSR to LSR Mapping enhancement for MAPPORT
Customer Issue 206649

PSR to LSR Mapping now supports the item type MAPPORT when it is added to a change 
order. Specifically, when an existing service is modified by a change order that adds an item 
based on the item type of MAPPORT, the PSR to LSR Mapping page is now rendered. This 
allows the item to be mapped and create an LSR order.

This enhancement allows for a more efficient way to enter this type of data. Manually entering 
a seperate LSR and then relating it to the PSR is no longer necessary because the MAPPORT 
item on the change order now maps to an LSR. 

To access this enhancement

Procedurally, there is nothing new with this enhancement; all changes were done to processing 
that takes place behind-the-scenes. Specifically, the process of entering a change order that 
includes a MAPPORT item has not changed; what has changed is that the presence of the 
MAPPPORT item on the change order now triggers the rendering of the PSR LSR Mapping 
page. 

Equipment installed under structure items sorted
Equipment installed under structure items are now sorted alphabetically. MetaSolv re-used the 
existing logic that currently sorts equipment not installed under structure items to perform this 
sort. The sorting mechanism is based on the existing user preference titled Equipment 
Description, which determines what/where equipment information is displayed in the 
Equipment Inventory treeview. By doing this, no matter what is selected in the user 
preference, the data is always sorted alphabetically by what is viewable.

This enhancement allows you to view, alphabetically, equipment installed under structure 
items. The sort mechanism used to display the equipment alphabetically is adaptable in that if 
the user preference for Equipment Description changes, the sort still displays the equipment in 
the correct alphabetical order. Also, displaying this information is consistent with the manner 
it is displayed for equipment not installed under structure items. 

To access this enhancement

1. Select Inventory Management on the navigation bar.

2. Click the Equipment Inventory link. 

This opens the Equipment Inventory Search window.

3. Enter the appropriate search criteria and click the Search button. 

This opens the Equipment Inventory Search results window.

4. Select and open the appropriate equipment. (To see the results of this enhancement, 
equipment hierarchies that utilize structure items, and that have equipment installed under 
the structure items, must be selected.)
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This opens the Equipment Hierarchy page.

5. Expand the appropriate structure item(s) to view the sorted equipment.

Deploy option for MSS Samples application
The installer has a new option that deploys the MSS Samples application. When 
selected, this new option extracts the mss_samples.ear file to the deploy directory, 
defined under the specified METASOLV_HOME directory. All ear files that reside in 
the deploy directory are automatically deployed by the BEA WebLogic server when it 
is started. Additionally, the new option automatically creates the queues required by 
the MSS Samples application. These queues are:

SamplesIntegrations.queue.AsyncDispatcher
SamplesIntegrations.queue.AsyncDispatcher_error
Samples.queue.AsyncDispatcher
Samples.queue.AsyncDispatcher_error

This enhancement allows for a cleaner and more efficient installation. Previously, the installer 
simply copied the MSS Samples file to the appserver/samples directory, which later had to be 
manually extracted and deployed. Also, the queues required by the MSS Samples application 
had to be created manually. 

To access this enhancement

Refer to the 6.0.010 MSS Setup Guide (XML API version) for details regarding the 
installation of the MSS application, and the MSS Samples application.
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Outside moves for global connections
Outside moves for global connections
Outside moves can now be performed on PSR global connections. Outside moves refers to the 
ability to change a connection’s PRILOC/SECLOC while leaving the characteristics of the 
connection intact. Specifically, the PRILOC/SECLOC can be changed without having to 
disconnect the connection and re-add it as a new connection to reflect the appropriate change 
in the PRILOC/SECLOC. 

This enhancement includes a new user preference titled Allow PRILOC/SECLOC Location 
Change for In Service Connections, which is described in the New Preferences section of this 
document. In addition, this enhancement has made the PRILOC/SECLOC tab visible for 
PSR global connections. MetaSolv re-used existing functionality that supports the "Refresh 
from Order" button on the Circuit Identification window by copying it into a stored procedure 
and calling it from a new place: the Service Request Connection list window, which opens 
when the CKTID task is double-clicked. This window’s existing pop-up menu now has a new 
menu option called "Refresh from Order".

This enhancement allows you to change locations in a more efficient manner. Previously, 
when the PRILOC/SECLOC needed to be changed on an existing connection, the 
connection had to be disconnected on one order, and re-added as a new connection on a 
separate order. This included having to re-design the connection. 

To access this enhancement

1. Set the new preference titled Allow PRILOC/SECLOC Location Change for In Service 
Connections to Y. (Refer to the New Preferences section of this document for detailed 
information regarding this preference.)

2. Create a new PSR change order, or supp-change an existing order, to get to the Product 
Service Request window.

3. Click the Services link.

4. Drill down the Global hierarchy and select the appropriate connection.

5. Click the PRILOC/SECLOC Info tab.

6. Click the Edit link on PRILOC, or click the Edit link on the SECLOC. 

This opens the PRILOC/SECLOC Assignment window.

7. Click the PRILOC tab, or click the SECLOC tab.

8. Make the appropriate changes and click OK.

9. Process the order. 

10. From he Work Queue Manager, double-click the CKTID task associated with the order. 

This opens the Service Request Connections window.

11. Select the appropriate connection or connections.
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12. Right-click within the blue space and select "Refresh from Order" from the pop-up menu.

13. The following information message is displayed: "The selected circuits have been 
successfully updated from the Order."

AUTO_ISS system task
AUTO_ISS is a new system task that automatically Record Issues all designs on an order. This 
new task should come after the design task within a provisioning plan.

For orders that use a provisioning plan with this new task, you no longer need to issue the 
designs on the design task (for Change or Record Activity orders only). After the design task is 
completed, the System Task Server picks up the AUTO_ISS task and will automatically 
Record Issue all the designs on the order.

If one or more circuits on the order are not able to be issued, either because the circuit does not 
contain an issue for the order in question or the status is not in an appropriate state, the 
AUTO_ISS task is sent to the exception queue as defined in the preference.

The AUTO_ISS task has the same double-click action as the DLRD task, therefore, it also 
opens the Service Request Connections window. Here, errors on non-issued circuits can be 
corrected. The Group Print window can be opened from here to manually issue the designs, or, 
after the corrections are made, the task may be transferred back to the system work queue to 
get picked up by the System Task Server. After the AUTO_ISS task is completed, the DD task 
can be completed.

This enhancement will support future automation functionality. You will see this new task in 
the task list, however, the true benefit of this task will be realized in the next release.

To access this enhancement:

1. Select Application Setup on the navigation bar.

2. Click the Order Management Setup link.

3. Click the Provisioning Plans link. 

4. Click the Add New link at the bottom of the page to create a new provisioning plan, or 
double click an existing provisioning plan that is displayed in the list. 

5. On the Task Assignment tab, select the AUTO_ISS task from list of available Task Types 
and click the "up arrow" to add it to the provisioning plan.

This task can not be accessed from a work queue because it is a system task. Therefore, when 
the task status becomes Ready, the System Task Server automatically completes the task.
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Sequentially assign channels across facilities
Sequentially assign channels across facilities
It is now possible to sequentially assign available channels across multiple facilities with the 
single click of the Assign All button on the Group Assignment window. 

In a scenario where you have multiple trunks to assign to multiple facilities, you can group the 
available facilities under a Group treeview item. Additional Groups and facilities can be added 
to the treeview and the facilities can be arranged in the appropriate order by using the drag-
and-drop feature. When facilities are grouped, clicking the Assign All button targets the first 
facility for assignment, starting with the first trunk, or the first selected trunk. When all 
available channels are assigned on the first facility, assignments will sequentially continue 
with the next facility. 

This enhancement allows you to assign channels in a much more efficient manner. Previously, 
the ability Group Assign channels was only available for a specific facility. For example, to 
assign 672 trunks to 28 T1s, you used to have to pull in each T1 separately to target it for 
assignment. Now, you can group the T1s, click the Assign All button, and the system targets 
the channels on all 28 T1s for assignment.

To access this enhancement

1. Select Home on the navigation bar.

2. Click the My Work Queue link. 

This opens the Work Queue Manager page.

3. From the list of tasks in the work queue, select and open a design task (DLRD or RID).

This opens the Service Request Connections window. 

4. Select the appropriate connection or connections.

5. Select Options from the menu bar, and then select Group Assignment. 

This opens the Group Assignment window.

6. Click the Assign All button. 
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New preferences

Connection Cross-Reference Default Type Preference
Customer Issue 201188

This preference saves data entry time every time a cross reference is set up on a connection. 
When this preference is set, the value it is set to defaults in the Type field on the Synonym 
Reference window, located in Connection Design > CLR/DLR Design > Cross-Reference. 

Treeview Location: Inventory Management > Connection Design

Type: System

Options:

Alias

When this option is Alias, Alias is defaulted in the Type field on the Synonym Reference 
window, located in Connection Design > CLR/DLR Design > Cross-Reference.

Child/(Ecckt)

When this option is Child/(Ecckt), Child/(Ecckt) is defaulted in the Type field on the 
Synonym Reference window, located in Connection Design > CLR/DLR Design > Cross-
Reference.

CKR/Cust

When this option is CKR/Cust, CKR/Cust is defaulted in the Type field on the Synonym 
Reference window, located in Connection Design > CLR/DLR Design > Cross-Reference.

Synonym (default)

When this option is Synonym, Synonym is defaulted in the Type field on the Synonym 
Reference window, located in Connection Design > CLR/DLR Design > Cross-Reference.
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New preferences
Automatically Include Schematic Design when printing the CLR
This preference allows the user to default the choice of printing the schematic design as part of 
the CLR. The preference affects a new checkbox located on the Print window. The new 
checkbox is titled Include Schematic, and is located directly below the Include CLR checkbox. 
Note that the Include Schematic checkbox is disabled when the Include CLR checkbox is 
unchecked. Conversely, when the Include CLR checkbox is checked, the Include Schematic 
checkbox is enabled, and can be changed by the user regardless of what it was defaulted to by 
the preference choice. 

Treeview Location: Inventory Management > Connection Design

Type: User

Options:

N (default)

When this preference is N, and the Include CLR checkbox is checked on the Print window, 
then the Include Schematic checkbox on the Print window will be enabled and unchecked.

When this preference is N, and the Include CLR checkbox is unchecked on the Print 
window, then the Include Schematic checkbox on the Print window will be disabled and 
unchecked. 

Y

When this preference is Y, and the Include CLR checkbox is checked on the Print window, 
then the Include Schematic checkbox on the Print window will be enabled and checked.

When this preference is Y, and the Include CLR checkbox is unchecked on the Print 
window, then the Include Schematic checkbox on the Print window will be disabled and 
unchecked.
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Allow PRILOC/SECLOC location change for In Service 
Connections

This preference supports the functionality for the Outside Moves enhancement.

Treeview Location: Service Request > Product Service Request

Type: System

Options:

N (default)

When this preference is N, a PRILOC/SECLOC location for In Service connections under 
the Global area can not be changed.

Y

When this preference is Y, a PRILOC/SECLOC location for In Service Connections under 
the Global area can be changed.
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Appendix I: What’s New in 6.0.11
This appendix documents enhancements that are new with version 6.0.11 of MetaSolv 
Solution.

Inventory Management enhancements

Reconcile—Updating ICSC and CCNA 
Customer Issue 202117

This change is part of the ongoing reconcile enhancement theme that resulted from User 
Group.

Prior to this enhancement, any modifications to the following fields required a manual 
reconciliation of the cross reference for all affected connections.

Access Customer record’s Name Abbreviation field or Name field
ICSC record’s Name field

Now, any modification to the fields listed above will initiate the cascade reconcile process. All 
connection references containing the modified Access Customer and/or ICSC information will 
be updated. Also, all connections associated with those connection references will be updated 
with the modified information.

Reconcile—Updating equipment CLLI code
Customer Issue 201299

This change is part of the ongoing reconcile enhancement theme that resulted from User 
Group.

Prior to this enhancement, any modification to a network location equipment CLLI updated 
the network location equipment CLLI, but the update did not cascade to all the connections 
terminating on the port equipment. 

Now, any modification to the network location equipment CLLI will initiate the cascade 
reconcile process. All connections terminating on the port equipment of the modified network 
location equipment CLLI will be updated with the modified information.
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Building network systems without graphics
Customer Issues 241486, 242608, 250942

Existing functionality allows you to build network systems using the network canvas. This 
enhancement provides the ability to build network systems without graphics (excluding 
SONET/SDH). Instead, a treeview hierarchy of the network system is used.

The new functionality works very similar to existing functionality that builds networks using 
the canvas. To access a network system in this new manner, the network must first be created. 
Once it is created, simply right-click on the network system and select Open without 
Graphics from the pop-up menu.

This enhancement allows you to build complex networks without graphics, because the 
network canvas can become very difficult to read with large networks.

Accessing online Help for this enhancement
Open the online Help and type the following new procedure names in the Search field to learn 
how to use this feature.

Creating a Network System without Graphics
Associating a Component/Element with a Network without Graphics
Associating a Component/Element with Equipment without Graphics
Connecting Components in a Network System without Graphics
Embedding a Network without Graphics
Finding a Component, a Component Relationship, or a Connection

The following are existing procedures that have been updated to reflect the enhancement:

Creating a Network System
Opening a Network System
Viewing Network Systems
Building a Network’s Facilities
176 MetaSolv Software, Inc.



Inventory Management enhancements
Viewing installed equipment visually
The Equipment Inventory window has been enhanced to provide a visual view of equipment 
installed on a relay rack, in addition to the existing hierarchical view. The new Equipment 
Visualization window displays a visual view of a relay rack that includes a listing information 
such as name, manufacturer, part number, acronym, mounting positions, and description. Each 
shelf on the relay rack is represented by a horizontal light blue line. A pop-up description of 
the shelf information appears when the cursor moves over the shelf. Each slot on the shelf if 
separated by a vertical dotted line. Each empty slot is represented by a vertical grey line. Each 
card that populates a slot is represented by a vertical dark blue line. A pop-up description of 
the card information appears when the cursor moves over the card.

This enhancement allows you to visually see a relay rack and any equipment installed on it, 
including shelves, slots, and cards.

Accessing online Help for this enhancement
Open the online Help and type the following new window name or new procedure name in the 
Search field to learn how to use this feature.

Equipment Visualization Window
Viewing Equipment Installed on a Relay Rack Visually

The following existing procedure has been updated to reflect the enhancement.

Viewing Equipment Installed on a Relay Rack
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Order Management enhancements

Automating group disconnect
GRPDISC is a new system task that will automatically disconnect a group of connections on 
an order. This system task can be defined in any provisioning plan for any order type. The task 
will only perform actions for ordered connections with an activity of ‘Disconnect’. For all 
such connections on the order, the task will automatically complete the same actions that are 
performed by the GUI Group Disconnect option, which is accessed from the Service Request 
Connections window when opened from the design task (DLRD, RID).

After the predecessor task completes, the System Task Server picks up the GRPDISC task and 
will automatically disconnect the group of connections on the order. Therefore, orders that use 
a provisioning plan with this new task no longer require you to manually perform a Group 
Disconnect from the Service Request connections window.

If one or more circuits on the order are not able to be disconnected, the GRPDISC task is sent 
to the exception queue as defined in the preference. The GRPDISC task has the same double-
click action as the RID or DLRD tasks, therefore, it also opens the Service Request 
Connections window. Here, errors can be corrected, and the Group Disconnect window can be 
opened to manually perform the disconnects. After the corrections are made, the task can be 
completed manually as mentioned previously, or it can be transferred back to the system work 
queue to get picked up by the System Task Server. 

The GRPDISC may be completed manually from the work queue task list, if it was unmarked 
as a system task at task generation.

This enhancement saves you time because the time spent manually working tasks to perform a 
group disconnect can now be done automatically. 
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Order Management enhancements
Automating equipment installation
EQINST is an existing task that can now be defined as a system task. When defined as a 
system task, it will automatically perform equipment installations based on the EQUIPMENT 
item types defined in the product catalog. The following criteria must be followed when using 
EQINST task, or the system task server will throw an error:

Only active equipment specs can be installed using the EQINST task.
Only base equipment can be installed using the EQINST task, because when the task 
completes automatically there is not a way to define installation specifics such as shelf, 
slot number, etc.
Only one end user location can be defined for the global product bundle, because when the 
task completes automatically there is not a way to determine at which location the 
equipment should be installed. 
If used in conjunction with the system tasks PCONDES and VCONDES (which is not 
required), the order of the tasks within the provisioning plan must be EQINST, followed 
by PCONDES, and then VCONDES. 

After the predecessor task is completes, the System Task Server picks up the EQINST task and 
will automatically install the base equipment on the order. Therefore, orders that use a 
provisioning plan with this new task no longer require you to manually install the equipment.

If one or more pieces of equipment on the order are not able to be installed, the EQINST task 
is sent to the exception queue as defined in the preference. The EQINST task has double-click 
action that opens the Service Request Equipment window. Here, errors can be corrected, and 
the equipment can be manually installed. After the corrections are made, the task can be 
completed manually as mentioned previously, or it can be transferred back to the system work 
queue to get picked up by the System Task Server. 

The EQINST may be completed manually from the work queue task list, if it was unmarked as 
a system task at task generation.

This enhancement saves you time because the time spent manually working tasks to perform 
equipment installs can now be done automatically.
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Automating design of physical and virtual connections
PCONDES is a new system task that will automatically perform connection design for new 
physical connections on the order that the workflow is processing. VCONDES is a new system 
task that will automatically perform connection design for new virtual connections on the 
order that the workflow is processing. If used together, or in conjunction with the system task 
EQINST (neither of which is required), the order of the tasks within the provisioning plan 
must be EQINST, followed by PCONDES, and then VCONDES.

After the predecessor tasks are completed, the System Task Server picks up the PCONDES or 
VCONDES task and automatically designs the physical or virtual connection. Therefore, 
orders that use a provisioning plan with these new tasks no longer require you to manually 
design new physical or virtual connections.

Due to the complexity of designing connections, the use of these tasks require extensive, and 
very specific setup of numerous areas within the application. Part of that set up includes the 
following new system preferences, located under Preferences>Inventory 
Management>Automation. These preferences have been added to online Help.

New preferences:

EC DSGCON
EC TEL
EC MCO
EC OCO
Maximum Number of Hops
Design Mode

Exporting gateway event notes
The ability to enter notes on a Gateway Event was introduced in a previous release. Gateway 
Event Notes can now exported with the gateway event with which they associated. The 
existing structure, EventData, was modified to define a sequence of the new structure 
GatewayEventNote.

This allows you to export Gateway Event Notes to the integration server.
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Order Management enhancements
Viewing server Logs / searching for server logs
The Work Queue Manager window has been modified regarding the viewing of server logs. 
Specifically, there is a new Server Logs tab where the following informational fields 
regarding server logs can viewed. The information displayed on this tab is per task, so 
selecting a different task results in a change of data that is displayed. 

Additionally, the Server Log option on the right-click pop-up menu has been moved to the 
Options menu. Selecting Server Log from the Options menu opens the new Server Log 
Search window, where existing records in the SERVER_LOG table can be retrieved by 
selected dates, filtered and printed. The retrieval limit for this search window will be based on 
the existing Search Retrieval Limit preference. The choice of selected dates includes the 
following, which automatically set the From and Through date fields on the search window.

Accessing online Help for this enhancement
Open the online Help and type the following new window name or new procedure name in the 
Search field to learn how to use this feature.

Work Queue Manager Server Logs Tab
Viewing Server Logs
Server Log Search Window
Searching for Server Logs based on Dates

The following existing window online Help has been updated to reflect the enhancement.

Work Queue Manager Window

Order Number

Task Type

Date/Time

Description

Custom This Quarter
Last Month This Quarter to Date
Last Quarter This Year
Last Week This Year to Date
Last Year Today
This Month Tomorrow
This Month to Date Yesterday
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Defining item type relationships
The following new relationships between existing item types are now valid:

The EMAIL item type can be a child of the SYSOPTION item type.
The EQUIPMENT item type can be a child of the CONNECTOR item type, but only 
when the CONNECTOR item type is set up as a physical connection.

This enhancement allows you to add equipment through the ordering dialog using an item type 
hierarchy of Product Bundle>Network Connection>Customer Premise Equipment. 
Previously, to install equipment in conjunction with a product bundle, a service location was 
also required.

Configuring geographic areas to network areas
The existing functionality of configuring Geographic Areas to Network Areas has been 
enhanced. Specifically, the Geographic Area tab on the Network Area Definition window has 
been modified to dynamically display up to seven fields as defined by the Geographic Area 
associated with the Country specified on the General tab of the same window. Previously, the 
Geographic Area tab displayed a maximum of only three fields, and the field names were 
hard-coded to be Country, State, and City, regardless of the Geographic Area components 
defined in the MSS Utility application.

This enhancement allows you to configure Geographic Areas, up to seven levels, to Network 
Areas, and with more clarity because the component names are now correct.

Searching for telephone numbers based on geographic area
The existing functionality of searching for telephone numbers based on geographic area has 
been enhanced. Specifically, the Search tab on the Telephone Numbers window has been 
modified to dynamically display up to seven fields as defined by the geographic area 
associated with the country specified on the window. This change is visible when ‘Geographic 
Area’ is selected for the Search By radio button. Previously, the Search tab displayed a 
maximum of only four fields and no corresponding field names were ever displayed.

This enhancement allows you to search for telephone numbers based on geographic areas, up 
to seven levels, and with more clarity because the component names are now visible.
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Order Management enhancements
Updating port parameters
Another change to the Telephone Numbers window includes the ability to update port 
parameters. Specifically, if a number is either ported in or ported out, you now have the ability 
to update the parameters by right-clicking on the a telephone number on the Results tab and 
selecting Update Port Parameters from the pop-up menu. This opens the new Update Port 
Parameters window which defines the following field names and their corresponding values 
that can now be updated.

Port Status
Port Activity
Other Service Provider SPID
LRN
Foreign/Sub LRN

Each field has a checkbox next to it that you check to indicate you wish to update the field 
with the modified value. There is also a Column field with a corresponding checkbox which, 
when checked, automatically checks all the fields. 

Accessing online Help for this enhancement
Open the online Help and type the following new procedure name in the Search field to learn 
how to use this feature.

Updating the Port Parameters

Creating LRNs
The Switch Details window, where you create an LRN, has been enhanced to include the 
definition of an LRN type, and to define a default LRN per type. Now, when creating a new 
LRN you must define an LRN type of ‘Lerg’ or ‘Service Provider Assigned’. If only one LRN 
is defined per type, each LRN is designated as the default. If multiple LRNs of the same type 
are defined, the first one created initially becomes the default, but the system allows you to 
change it and specify which LRN is to be the default.

When multiple LRNs are defined, this enhancement allows you to differentiate types of LRNs, 
as well as specify default LRNs.

Accessing online Help for this enhancement
Open the online Help and type the following procedure name in the Search field to learn how 
to use this feature. This existing procedure was updated to reflect the enhancement.

Adding a Location Routing Number to a Switch Detail
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Viewing transformed XML document attachments
The existing preference, Configure External Weblinks, allows you to define external links that 
can be accessed from the functional areas of Connection Design, ISR, or PSR. The 
configuration requires you to specify the functional area, define a Link Name, and define a 
corresponding URL. This enhancement provides a pre-defined URL, 
http:\\serverName:portNumber\Attachments.do, that enables you to define an external link 
that will display transformed XML documents that are associated with a particular PSR.

When the defined link is selected from Options>External Links>Link Name on the Product 
Service Request window, the new Attachments list window appears. This window lists the 
attachments in the order that they were created. Note that there is a new XML API method 
createAttachmentRequest that is used to create the attachments viewed by the external link. 
Selecting an attachment from the Attachments list window opens the new Attachments 
window, which displays the transformed XML document. 

It is important to note that for this enhancement to work, some set-up is required. Otherwise, 
when the attachment is pulled up, the application will not be able to successfully transform the 
XML document and an error message will display. The set-up includes the following:

The xsl stylesheet used to perform the transformation must be written.
The xsl stylesheet must be loaded into the database table 
MS_ATTACHMENT_TRANSFORM, where it is stored as a clob.
A SQL script used to perform this database load must be written.
The createAttachmentRequest must specify an Attachment ID, Attachment Name, and 
Transformation Name that resides on the MS_ATTACHMENT_TRANSFORM table. 

This enhancement allows you to view transformed XML documents that are associated with a 
particular PSR. The association is made via the new XML API method 
createAttachmentRequest.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the System Information link, and 
then click the Configure External Weblinks link to read about this preference. Once the 
preference is set up, you can access the link by following these steps:

1. Open a PSR.

2. Click Options on the main menu bar, and select External Links>Attachments.

The Attachments list window appears.

3. Click an attachment to be viewed.

The Attachments window appears, displaying the transformed XML document.
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New preferences
New preferences

Enforce MSAG Validation
Customer Issue 243233

This existing preference, when enabled, allowed for the first two options listed below. The 
third option is new with this release.

Treeview Location: Service Request>Product Service Requests - PSR

Type: System

Options:

All three MSAG validation options use full and partial validations. For a full validation, the 
software looks for a complete match of the address. When a full validation fails, a partial 
validation is performed. For a partial validation, the software looks for a match on parts of the 
address and allows the user to select the correct location from a list of partial matches. The list 
is generated based on partial matches with locations entered on the End User Location 
Maintenance window. 

Standard Validation (default)

Validates the end user address against the National Emergency Number Association 
(NENA) 3 format. 

Enforce NENA 2.0 for Partial Match MSAG Validation

Validates the end user address against the National Emergency Number Association 
(NENA) 2.0 format. This form of validation overwrites any value in the Community field 
with the information from the MSAG Community Nm field on the MSAG Validation List 
window.

Perform Optional Community MSAG Validation

Validates the end user address against the National Emergency Number Association 
(NENA) 3 format. This form of validation is based on the Community field, as opposed to 
the City field. 

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Service Request>Product 
Service Request link, and then click the Enforce MSAG Validation link to read more about 
this preference.
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Display Service Provider on End User Location Maintenance
Customer Issue 243233

Treeview Location: Service Request>Product Service Requests - PSR

Type: System

N (default)

The Service Provider field does not appear on the End User Location Maintenance 
window MSAG - E911 tab.

Y

The Service Provider field appears as a required field on the End User Location 
Maintenance window MSAG - E911 tab.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Service Request>Product 
Service Request link, and then click the Display Service Provider on End User Location 
Maintenance link to read more about this preference.
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New preferences
Security Password Expiration Preference
Customer Issue 246241

This preference allows MSS administrators to have a choice of defining MSS password 
expiration principles, or deferring the expiration principles to the database administrator while 
allowing the database alert messages to display in MSS.

Treeview Location: Security

Type: System

Options:

Y (default)

The system uses MSS password expiration principles defined by the MSS administrator 
for each user.

N

The system uses the password expiration principles defined by the database administrator 
for each user’s Oracle profile. Oracle triggers alert messages when a password is within 
the specified expiration grace time and at the end of the specified password life time. 
These messages are displayed when the user logs onto MSS. 

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Security link, and then click the 
Security Password Expiration link to read more about this preference.
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MSS Utility Enhancements

Custom Attributes
You can now copy Custom Attributes from one Process Point / Action to another.

There are two new fields on the Process Point and Action Layout window entitled Copy 
from Process Point and Copy from Action. These fields provide the capability to copy 
Custom Attributes defined for one Process Point / Action to another Process Point / Action 
without having to re-define the entire Layout. Additional changes to the copied Custom 
Attributes can be made after the copy is performed.

You can now associate Custom Attributes with Equipment.

There is a new Custom Attribute Category of Equipment, and a new Building Block Type 
of Equipment. The following lists the Process Points defined for the Equipment Building 
Block Type, and their capabilities. The double-asterisk indicates that the Process Point is 
applicable to the Planning Module only.

**Equipment Description - Display only
Equipment Install - Display only, Render for Entry
**Equipment Mass Change - Render for Entry
**Equipment Search - Criteria, Results
Equipment Update - Display Only, Render for Entry
**Planned Equip Mass Change - Render for Entry

You can now associate Custom Attributes with Network Locations.

There is a new Custom Attribute Category of Location, and a new Building Block Type of 
Location. The following lists the Process Points defined for the Location Building Block 
Type, and their capabilities. The double-asterisk indicates that the Process Point is 
applicable to the Planning Module only.

Loc Maint - Copy Bldg To Entity
Location Maintenance
**Location Search

Note that Custom Attributes associated with an 8-byte CLLI are automatically associated 
with any 11-byte child CLLIs. This works for existing parent/child Network Location 
relationships, as well as new parent/child Network Location relationships. For example, if 
Custom Attributes are added, modified, or deleted from a parent Network Location that 
has existing relationships with child Network Locations, the same addition, modification, 
or deletion will automatically be applied to all related child Network Locations. 
Conversely, if an 8-byte CLLI has Custom Attributes associated with it but no child 
Network Locations, any new child Network Locations defined for that parent Network 
Location will automatically get the same Custom Attributes associated with it.
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MSS Utility Enhancements
Purging Server Logs
You can now purge server log records from the SERVER_LOG table. The server log purge 
can be performed one of two ways from the new Server Log Purge window.

By Purge Date

When the Type of Server Log Purge drop-down is set to ‘By Purge Date’, you can 
specify year, month, and day intervals that are used to calculate the purge date by 
subtracting the intervals from the current date. When this type of purge is requested, only 
records with a date on or before the calculated purge date will be deleted.

All Records

When the Type of Server Log Purge drop-down is set to ‘All Records’, every record on 
the table will be deleted.

Click the Start icon to initiate the purge process. A confirmation response window will appear 
that informs you of the number of records that will be deleted. Click Yes or No to start the 
purge. A progress bar shows the progress of the purge. You have the option to cancel the 
purge, but any records deleted up to the point of cancellation cannot be recovered.

This enhancement allows you to better maintain the size of your database SERVER_LOG 
table.

Accessing online Help for this enhancement
Open the online Help and type the following new window name or new procedure name in the 
Search field to learn how to use this feature.

Server Logs Purge Window
Purging Server Logs

The following existing online Help concept has been updated to reflect the enhancement.

Purge Utility
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XML API Schema Enhancements

XML Customer Management API
deleteCustomerAccountRequest

This method provides the ability to delete an existing customer/billing account. This 
method replaces existing method terminateCustomerAccountRequest.

XML Order Management API
createAttachmentRequest

This method provides the ability to attach an XML document to a PSR order, which can 
then be viewed from a PSR order within the application by defining an external link. See 
enhancement description for Viewing Transformed XML Document Attachments.

reopenTaskRequest

This method provides the ability to reopen a task that had previously been completed.

processSuppOrderRequest

This method provides the ability to perform the same actions through the API as would be 
accomplished by manually processing a supplement order from the MSS application. 

XML Service Order Activation API
All of the existing XML API SOA functionality has been enhanced to handle WTN 
telephone numbers. Previously, the XML API SOA functionality handled only ported in 
and ported out telephone numbers.
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XML API Schema Enhancements
XML Inventory Management API
getAvailablePhysicalPortsRequest

This method provides the ability to retrieve available physical ports based on network 
node key (internal identifier of a network element) and rate code. A port is considered 
available if is not assigned to a connection and does not have a ‘block’ condition code. 
The query looks for available ports in the equipment directly associated to the network 
element, as well as equipment below it in the equipment hierarchy.

getIpAddressesRequest

This method provides the ability to retrieve IP Address information based on Network, or 
based on the IP Address itself.

getNetworkAreasByGeoAreaRequest

This method provides the ability to retrieve network areas based on a geographical area.

getNetworkComponentsRequest

This method provides the ability to retrieve network components based on network area. 
The input criteria allows you to filter the result set by optionally requesting a particular 
component type, a particular component status, or requesting network elements only.

queryInventoryManagementRequest

This existing method’s logic, when the input structure is QueryMSAGInventoryValue, has 
been modified. The method can now validate an MSAG address based on Optional 
Community MSAG validations, in addition to standard validations and Nena 2 for partial 
match validations. (Refer to the documented new preference Enforce MSAG Validation). 

Additional functionality allows you to optionally create an audit trail for MSAG 
validations. As a separate call to the control auditTrailRecording, you can pass in the 
response structure from this request, QueryMSAGResponse, and the control will call the 
custom stored procedure SP_PSR_MSAG_CUSTOM_VALIDATION. You can customize 
this stored procedure based on your business requirements.

queryTNRequest / queryInventoryManagementRequest

Both of these existing methods provide the ability to query for a telephone number. 
Because of the duplication, queryTNRequest was removed. The same functionality is 
available with the queryInventoryManagemetnRequest when the input structure of choice 
is QueryTelephoneNumberInventoryValue.

updateTNRequest

This method provides the ability to update a telephone number. A telephone number can 
be Contaminated or Uncontaminated. You can supply the following information in a 
telephone number object that includes the telephone number, primary key of the telephone 
number (nbrInvId), type of current telephone number (telNbrTypeCd) or type of telephone 
number after the update and 8 additional attributes of the telephone number.
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Appendix J: What’s New in 6.0.12
This appendix documents enhancements that are new with version 6.0.12 of MetaSolv 
Solution.

Architecture changes
This release of MetaSolv Solution is now supported on a new version of Oracle, version 10G, 
a new version of Solaris, version 10, and a new version of Citrix, Citrix Presentation Server 
3.0.

Inventory Management enhancements

Reconcile—Circuit position mapping change
Customer Issue 201439

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Prior to this enhancement, circuit designs were not being reconciled when changes were made 
on a facility channel to equipment port position mappings. This problem affected any position 
mapping change, regardless of the window on which the change occurred (Connection Design, 
Connection Hierarchy, or Equipment Installation).

Now, any change made to a facility channel’s equipment port position mapping will initiate 
the reconcile process.

Reconcile—Hard-wired cross-connect change
Customer Issue 201455

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Prior to this enhancement, reconcile was incrementing DLR issues on circuits that were not 
affected by a change on a hard-wired cross-connect.

Now, reconcile will not increment DLR issues on circuits that are not affected by a change on 
a hard-wired cross-connect.
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Reconcile—Create new issue from appropriate active issue
Customer Issue 201429

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Prior to this enhancement, reconcile could potentially encounter the following problems when 
creating a new issue from an active issue:

1. The new issue could be created from an incorrect active issue.

Previously, reconcile always created a new issue from the max active issue. This problem 
may or may not have been encountered, depending on the dates of the active issues, and 
the date of the new issue to be created. For example, if you had pending issues dated 7/1, 
8/1, and 9/1, and you created a new issue dated 9/15, this problem would not be 
encountered because the new issue would happen to be created from the correct pending 
issue dated 9/1. However, if you created a new issue dated 7/15, this problem would be 
encountered because the new issue would be created from the incorrect pending issue 
dated 9/1 when it should have been created from the pending issue dated 7/1.

2. When bumping up issues after creating a new issue, additional issues could be created that 
did not need to be created had the new issue been based on the correct active issue.

Previously, reconcile always created a new issue from the max active issue, and then 
bumped up all pending issues regardless of dates. This problem may or may not have been 
encountered, depending on the number of pending issues. For example, if had one pending 
issue, and you created a new issue, this problem would not be encountered because the 
new issue happened to be based on the correct active issue. The pending issue would be 
bumped up, and no additional issues would be created. However, if you had pending 
issues dated 6/1, 7/1, 8/1, and 9/1, and you created a new issue dated 8/15, you were not 
only creating the new issue from the incorrect pending issue dated 9/1, but all four 
pending issues were bumped up. Had the new issue been based on the correct pending 
issue of 8/1, and dates were taken into consideration, only the pending issue of 9/1 would 
have needed to be bumped up.

Now, reconcile will create a new issue based on the correct active issue. It no longer bases 
the new issue on the max active issue, rather, it looks at the dates of the active issues and 
bases the new issue upon the correct one. Specifically, reconcile will select the active issue 
with the date is either the same as, or the max issue prior to, the date of the new issue to be 
created. In this manner, not only is the new issue created from the correct active issue, but 
creating additional issues when bumping up the issues can be avoided.
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Inventory Management enhancements
Reconcile—Duplicate delete lines removed
Customer Issue 201429

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

The enhancement addresses how pending assignments for parent connection(s) are displayed 
on child DLRs when those assignments map down to the child level. Currently, both Pending 
and Pending Disconnect assignments of the parent connection display on child DLRs. This 
may cause confusion because the Pending assignment will replace the Pending Disconnect 
assignment once the Due Date task of the order against the parent connection is completed. 
However, looking at the DLR of the child, it appears that both assignments coexist, which is 
not the case.

To resolve this issue, the application now uses the due dates of the order(s) to determine which 
assignment(s) should and should not be displayed on the child DLR(s). The general rule is to 
compare the due date of the order for the child issue against the due date of the order against 
the parent connection; if the child issue's order has already been completed, the actual 
completion date is used. Using these dates, the logic determines which assignment(s) on the 
parent order will be "active" at the time the child order is to be due date completed, and 
displays the appropriate equipment on the DLR.

For example, a child T1 is assigned to a channel on a parent T3. The parent T3 has an open 
change order whose due date is two months away and the design task has been worked. For 
this order, an equipment assignment has been replaced by another which places this port 
assignment in a Pending Disconnect status while the new assignment is in a Pending status. 

Using this example, for an issue of the child circuit whose due date is only one month away, 
the DLR will display the equipment whose status is Pending Disconnect on the parent order. 
This is because at the time the order of this issue is to be completed, the active assignment is 
still the Pending Disconnect equipment assignment. In contrast, the Pending assignment will 
not display on the DLR of this issue because this assignment will not be active for another full 
month.

Using the same example, consider another pending issue for the child circuit whose due date is 
three months away. On the DLR for this issue, the Pending equipment assignment will display 
while the Pending Disconnect assignment will not. Again, this is because the active 
assignment at the time this issue is to be due date completed is the Pending issue. The Pending 
Disconnect assignment will have been removed for a full month at this time and therefore will 
not display on the DLR.

For those times when the due date of the order against the child is the same as the due date of 
the order against the parent, both the Pending Disconnect and the Pending assignments will 
display on the child's DLR. 
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API Checkout Id field added to TN Search window
Customer Issue 253769

The API Check Out Id field has been added to the Telephone Number Search window. This 
new field is a system generated number that is set by the API when a telephone number is 
exported. With the API Check Out Id set, the telephone number is not available to other API 
users, or to GUI users. The API Check Out Id is reset to null by the API during the pre-
assignment process when the Release Indicator (and API parameter) is set to Y.

This change was the result of enhancements made to existing Pre-Assign Telephone Number 
functionality that is part of the Number Inventory API. Refer to the XML API Schema 
Enhancements > XML Inventory Management API section of this document for details 
regarding these enhancements.

Accessing online Help for this enhancement
Open the online Help and type the following new field name, or the existing window name to 
which the field was added, in the Search field to learn how to use this feature.

API Check Out Id Field
Telephone Numbers Search Window

Network Node Name field added to Groom Maintenance
Customer Issue 235838

For ease of use, the Network Node Name has been added to the Groom workspace for 
equipment port grooming scenarios. This information will appear in parentheses after the node 
address information in both the "Unassign From Equip" and "Assign To Equip" columns. If 
the equipment does not contain any node address data, the Network Node Name will display 
by itself, when applicable.

This data will provide additional information to the technician when performing cut activities. 
The Network Node Name is derived from the equipment hierarchy of the piece of equipment 
being groomed. For example, if the user is grooming to a piece of equipment that is not 
associated to a Network Node, but its parent equipment is associated to a Network Node, that 
node's name will appear in the Groom workspace. This data is available for new projects as 
well as existing projects.

Two new columns, labeled "from_node_name" and "to_node_name", have been added to the 
Cut Sheet. These new columns are positioned just before their respective node address 
information.

A new identifier has also been added to the workspace to inform the user when a circuit has 
been deleted from the inventory. Currently, when the user opens a completed project whose 
"Unassign From Connection ID" circuit is no longer in inventory because it has been deleted, 
this column is blank. Now, this column is populated with "*** Connection deleted ***" to 
inform the user that this circuit is no longer in inventory.
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Inventory Management enhancements
Change Connection Id on EWO for type CONNECTOR
In a previous release, the ability to change the connection id on an EWO was added through 
the Change Connection Id link on the Work Order Summary>Manage Connections page. This 
previous enhancement, however, did not include the ability to change the connection id on an 
EWO for a connection based on the item type CONNECTOR. This enhancement now 
provides that ability.

Connections based on the item type CONNECTOR can only be created outside of an EWO. In 
other words, creating a new connection on an EWO, by selecting one of the links under the 
Create New section on the Work Order Summary>Manage Connections page, does not result 
in a connection based on the item type CONNECTOR. Therefore, the only way to for a 
connection based on the item type CONNECTOR to exist on an EWO is to pull it into the 
EWO by selecting one of the links under the Retrieve Connections For section. This 
enhancement deals with changing a connection id, therefore, the logic affected is behind the 
Change Connection link, located under the Retrieve Connections For section. Specifically, the 
Change Connection Link renders the Select Connection for Change window, which where the 
visible changes were made.

Previously, the Select Connection for Change window excluded the selection of connections 
based on the item type CONNECTOR. Now, the Select Connection for Change window 
includes a Circuit Type checkbox which, when selected, will dynamically modify the query to 
include the selection of connections based on the item type CONNECTOR. This window was 
also modified to include a group of checkboxes that can be selected to further define the search 
criteria. The checkbox field names are dynamically displayed, based on the user defined Valid 
Values for the Valid Value Category of Connection Type.

The end result of this enhancement is that connections based on the item type CONNECTOR 
can now be pulled into an EWO where the existing Change Connection Id link can be accessed 
to change the connection id on a connection based on the item type CONNECTOR.

Accessing online Help for this enhancement
Open the online Help and type the following existing procedure in the Search field to learn how 
to use this feature. 

Changing a Connection Id
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Order Management enhancements

Reconcile—Automating create and save of new design issue
This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

New menu option
Group Save is a new menu option on the Service Request Connections window that will 
automatically create and save a new design issue. The Service Request Connections window is 
opened from the Work Queue by double-clicking a DLRD or RID task, or from an EWO by 
clicking the RID/DLRD link. When the window is opened from the Work Queue, the menu 
option will be enabled for Change orders. When the window is opened from an EWO, the 
menu option will be enabled if there are any connections that have a C-Change Activity Status. 

The logic of the Group Save will function as if the connection is opened and the issue is saved. 
When a design is opened, the logic creates and copies the information to a new issue. Group 
Save automates this process, which saves time by preventing you from having to open each 
connection just to create a new design and save it. 

Group Save can be executed multiple times. The code will check to see if an issue was already 
created for the current order. If an issue was already created, the code will not create a new 
issue for the order. 

New system task
AUTOSAVE is a new system task that will automatically create and save a new design issue 
on an order. This system task can be defined in provisioning plans that will be assigned to 
Change orders. For all connections on the order, the task will automatically complete the same 
actions that are performed by the GUI Group Save option, which is accessed from the Service 
Request Connections window.

After the predecessor task completes, the System Task Server picks up the AUTOSAVE task 
and will automatically create and save a new design for the connections on the order. 
Therefore, orders that use a provisioning plan with this new task no longer require you to 
manually open each connection to create a new design and save. 

If a problem is encountered while completing the AUTOSAVE task, the task is sent to the 
exception queue as defined in the preference. The AUTOSAVE task has the same double-click 
action as the RID or DLRD tasks, therefore, it also opens the Service Request Connections 
window. Here, errors can be corrected. After the corrections are made, the task can be 
completed manually, or it can be transferred back to the system work queue to get picked up 
by the System Task Server. 
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Order Management enhancements
The AUTOSAVE task may be completed manually from the work queue task list, if it was 
unmarked as a system task at task generation.

PSR New From existing functionality enhanced
The existing PSR New From window has been enhanced to include the option of copying 
Order Elements from the original order to the new order. The Order Elements include 
Contacts, Links, Sales Module, and User Data. These four Order Elements have been added to 
the PSR New From window in the form of checkboxes that can be selected/de-selected to be 
copied/not copied from the original order to the new order. Additionally, four new system 
preferences have been added that allow for a default setting for each of these Order Element 
checkboxes. Refer to the New preferences section of this document for further details 
regarding these new preferences.

Accessing online Help for this enhancement
Open the online Help and type the following new field name, or existing window name to which 
the field was added, in the Search field to learn how to use this feature.

Copy Order Elements Checkboxes
New PSR Order From Existing PSR Order window
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PSR Order Split
Customer Issue 262335

Order Split is a new menu option that provides the ability to split a PSR order into two 
separate orders. This new menu option is located on the Service Request Search list window’s 
right-click pop-up menu, and is enabled for open PSR orders. 

The split is accomplished by selecting items from the original order that are to be split out to a 
second order. Order Information is defaulted from the original order, but can be changed on 
the new order. Order Elements of User Data, Contacts, Sales Module, and Links can be copied 
over to the new order. Also, the option of relating the two orders, as either parent/child or 
child/parent, is available at the time of the split.

As stated previously, splitting an order is only applicable to open PSR orders. Specifically, the 
Order Split menu option will be disabled in the following cases:

Order status is Due Date Task Completed or All Tasks Completed.
Supplement Type is Cancel.
Order has an associated Gateway Event with a status of Waiting, Sending, In Progress, or 
Error.

Currently, the split functionality is limited based on the following:

Only items based upon Level 1 item types of PRBUNDLE, NPSPROD, and CKTPROD 
will be available for selection. 
Only Level 1 and Level 2 items will be available for selection.
Items that have Pricing, or items that have child items that have Pricing, will not be 
available for selection.

Accessing online Help for this enhancement
Open the online Help and type the following new field, concept, window, or procedure in the 
Search field to learn how to use this feature.

Copy Order Elements Checkboxes
Order Split
PSR Order Split Selection Window
Splitting an Order
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Order Management enhancements
Last Log Entry—Entered By field added to Ticket Log Entry
Customer Issue 256597

The Last Log Entry - Entered By field has been added to the Ticket Log Entry window. This 
window was previously enhanced to add several additional fields that provide the user with a 
better context of what is going on with the ticket while adding a new log entry. As per a 
customer request, this additional field has been added. The field displays the User Id 
associated with the Work Force Employee who created the last log entry. Previous to this 
change, the last log entry was displayed, but the User Id who created it was not displayed.

Accessing online Help for this enhancement
Open the online Help and type the following new field, or existing window name to which the 
field was added, in the Search field to learn how to use this feature.

Last Log Entry - Entered By Field
Log Entry window

Effective To field added to Domain Info tab
The Effective To field has been added to the Domain Info tab. The Domain Info tab is 
associated with service items that are based on the item type of Domain, and therefore is only 
present when items of this type are part of the PSR order. The new field, which actually 
appears twice on the Domain Info tab -- once for the domain, and once for the sub-domain -- is 
for view only. Specifically, the user will not be able to edit this field in the GUI.

Accessing online Help for this enhancement
Open the online Help and type the following new field, or existing window name to which the 
field was added, in the Search field to learn how to use this feature.

To Effective Field
Product Service Request Window - Services/Domain Tab
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Application-wide enhancements

Custom extensions
Customer Issues 247140, 247174, 262331

Custom Extensions are introduced with this release, and additional functionality will continue 
to be added over the next few releases. A brief description of Custom Extensions follows; to 
read more about them, refer to the Custom Extension Developer’s Reference.

A logic extension provides the ability to extend the MetaSolv Solution business logic layer 
with any additional logic specific to your organization. Logic extensions can be configured to 
execute in a synchronous or asynchronous fashion. When a Process Execution Point is 
synchronous, data is expected to be returned to MetaSolv Solution from the user's custom 
code; whereas, an asynchronous call will not be expecting any data to be returned. When an 
asynchronous extension is invoked, the user will receive a configurable email notification.

The user may define a custom java class to be executed when a predefined Process Execution 
Point is encountered during execution of a feature/functionality. The java class executes 
within the scope of a separate transaction than the one that initiated the invocation. 

A Process Execution Point is identified based on three predetermined values:

"Process point
"Action type
"Building block 

The Process Execution Point extension can be invoked from any of the three execution areas, 
i.e., the User Interface, Polling Servers running within the appserver, CORBA-API or XML-
API. A base data SQL script will be provided to create the new process points, action types 
and building blocks.

Accessing online Help for this enhancement
Open the online Help and type the following new window and procedure names in the Search 
field to learn how to use this feature.

Extensions window
Extension window
Extension Summary window
Execution Point Search and Results window
Execution Points window
Extension Parameters window
Opening the Extension Summary window
Creating a new Extension
Editing an existing Extension
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Application-wide enhancements
Deleting an existing Extension
Editing an Extension Parameter
Searching for an Execution Point
Associating an Execution Point to an Extension
Disassociating an Execution Point from an Extension
Toggling between Execution Point Search and Results
Filtering the Extensions list
Filtering the Execution Points list
MetaSolv Solution What’s New 203



New preferences

Allow Deletion of Service Request Notes
Customer Issue 253505

This existing preference was enhanced to include the third option of U.

Treeview Location: Service Request

Type: System

N

You cannot delete Notes (manually entered or system generated) from the Service Request 
Notes window in the Order Management and Work Management subsystems.

Y (default)

You can delete Notes (manually entered or system generated) from the Service Request 
Notes window in the Order Management and Work Management subsystems.

U

Some users are able to delete manually entered Notes, based on user group. Manually 
entered Notes can be deleted by users of the same user group that created the Notes. 
System generated notes can be deleted regardless of user group with this option.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Service Request link, and then 
click the Allow Deletion of Service Request Notes link to read more about this preference.
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New preferences
Copy Contacts Default
This new preference was added to support the enhanced PSR New From functionality.

Treeview Location: Service Request>Product Service Request>New From

Type: System

N (default)

When creating a new PSR using the New From option, Contacts will not be copied from 
the original order to the new order.

Y

When creating a new PSR using the New From option, Contacts will be copied from the 
original order to the new order.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request>New From, and then click the Copy Contacts Default 
link to read more about this preference.

Copy Links Default
This new preference was added to support the enhanced PSR New From functionality.

Treeview Location: Service Request>Product Service Request>New From

Type: System

N (default)

When creating a new PSR using the New From option, Links will not be copied from the 
original order to the new order.

Y

When creating a new PSR using the New From option, Links will be copied from the 
original order to the new order.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request>New From, and then click the Copy Links Default link 
to read more about this preference.
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Copy Sales Module Default
This new preference was added to support the enhanced PSR New From functionality.

Treeview Location: Service Request>Product Service Request>New From

Type: System

N (default)

When creating a new PSR using the New From option, the Sales Module will not be 
copied from the original order to the new order.

Y

When creating a new PSR using the New From option, the Sales Module will be copied 
from the original order to the new order.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request>New From, and then click the Copy Sales Module 
Default link to read more about this preference.

Copy User Data Default
This new preference was added to support the enhanced PSR New From functionality.

Treeview Location: Service Request>Product Service Request>New From

Type: System

N (default)

When creating a new PSR using the New From option, User Data will not be copied from 
the original order to the new order.

Y

When creating a new PSR using the New From option, User Data will be copied from the 
original order to the new order.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request>New From, and then click the Copy User Data Default 
link to read more about this preference.
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New preferences
Default Search to Telephone Numbers on TN Search
Customer Issue 257129

Treeview Location: Service Request>Product Service Request - PSR

Type: System

N (default)

TN Search is not defaulted to Telephone Numbers, so it is either Geographic Area or 
Network Area.

Y

TN Search is defaulted to Telephone Numbers.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Service Request>Product 
Service Request - PSR link, and then click the Default Search to Telephone Numbers on 
TN Search link to read more about this preference.
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Delete Reserve Group only if No Telephone Numbers are in the 
group
Customer Issue 235271

This new preference was added to give users the option of preventing the deletion of a Reserve 
Group that still has telephone numbers defined.

Treeview Location: Inventory Management>Reservations

Type: User

N

When deleting a row from the Number Inventory Reservation list window, the following 
pop-up warning will display: "Are you sure you want to delete this row?" To delete the 
row, simply click Yes. 

Y (default)

When deleting a row from the Number Inventory Reservation list window, the following 
pop-up message will display: "Reserve Group cannot be deleted until all TNs are removed 
from the Reserve Group." To delete the reserve group, all the telephone numbers must be 
deleted from the group prior to deleting the reserve group itself.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Inventory 
Management>Reservations link, and then click the Delete Reserve Group only if No 
Telephone Numbers are in the group link to read more about this preference.
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New preferences
Enable LNP Validation
This new preference was added to give users the option of bypassing LNP validation. This is 
applicable to both the GUI and the API. 

Treeview Location: Service Request>Product Service Request - PSR

Type: System

Y (default)

Standard Local Number Portability validations will be performed by the GUI and the API. 

N

Standard Local Number Portability validations will be bypassed by the GUI and the API.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Service Request>Product 
Service Request - PSR link, and then click the Enable LNP Validation link to read more 
about this preference.
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Filter Auto Generated Notes on Service Request Search
Customer Issue 251632

This new preference was added so that users can have the option of filtering out Auto 
Generated Notes.

Treeview Location: Service Request

Type: User

N (default)

Auto Generated Notes are not filtered on the Service Request Search window.

Y

Auto Generated Notes are filtered on the Service Request Search window.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the Service Request link, and then 
click the Filter Auto Generated Notes on Service Request Search link to read more about 
this preference.
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XML API Schema Enhancements
XML API Schema Enhancements

XML Inventory Management API
createNewInventoryItemRequest 

This new method supports the import of new inventory items, including domains and sub-
domains.

createInventoryAssociationRequest 

This new method supports the establishment of parent/child relationship between two 
existing inventory items.

updateEntityByValueRequest (Customer Issue 253769)

This existing method, which handles varying update requests based on the input data 
structure, has been modified such that the existing input data structure 
updatePreAssignTelephoneNumberValue defines three new fields. These fields are 
category, subCategory, and releaseDate. An error is thrown if the category is not 
populated. If populated, the category field is validated, and, if populated (not required), 
the sub-category field is also validated. Additionally, when the subCategory is populated, 
the category/subCategory is checked for a valid combination.
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Appendix K: What’s New in 6.0.13
This appendix documents enhancements that are new with version 6.0.13 of MetaSolv 
Solution.

Inventory Management enhancements

Reconcile—Suppress cascade reconcile at due date completion
Customer Issue 201194

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

New logic has been added to suppress cascade reconcile when it is not necessary. Specifically, 
for new orders containing new connections that were already reconciled during the design 
save or during the completion of the design task, reconcile will be suppressed at due date task 
completion. This is accomplished by checking the setting of the user preference Process 
Cascade Reconciliation for Pending Assignments, and then determining if any changes took 
place that would require a reconciliation at due date task completion. This new logic, which 
may suppress reconcile at due date task completion, decreases the number of issues created for 
a connection, decreases the amount of data stored in the database, and decreases the amount of 
data through which you must navigate.

Reconcile—Due date change
Customer Issue 201170

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Release M6.0.12 introduced new logic that determined which assignments were displayed on 
child connection designs, based on due dates. The logic compares the due date of a parent 
equipment assignment with the due date of the order associated with the issue of a child 
connection to determine which equipment assignments should and should not display on the 
child's DLR. Because of this new logic, the application now needs to re-evaluate this 
comparison whenever the due date of an order is modified.
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This enhancement provides new functionality that determines whether or not to trigger the 
cascade reconciliation process when the due date of an order is modified. The due date of an 
order can be modified several ways, such as a due date supplement or physically changing the 
due date of the DD task on the Task Maintenance window. This new logic is triggered for the 
following types of orders: Engineering Work Order (EWO), Internal Service Request (ISR), 
Access Service Request (ASR), and Product Service Request (PSR).

On the EWO Work Order Summary window, within the Work Order Information section, you 
can initiate a due date supplement by clicking the Change link, located next to the Desired Due 
Date field. When this date is modified, new logic is called that determines whether or not the 
change affects any DLRs. If any affected DLRs are found, a message displays stating the due 
date change affects "x" number of connections/assignments. You are then given the option to 
proceed, not proceed, or send the reconciliation to the background processor. When the logic 
determines that reconciliation is needed, you may not complete the date change without 
initiating the reconciliation.

When you accept the reconciliation, either by clicking Yes or Background, the Task 
Maintenance window is opened as before, but there are some slight changes. Because you are 
in the middle of processing a due date supplement, and the new due date was used to 
determine what should and should not display on child DLRs based on this date, you cannot 
modify the date of the DD task on this window. This restriction is necessary to maintain data 
integrity. If you need to modify this date, simply enter another due date supplement with the 
correct date.

For the other types of orders, a due date supplement or modifying the date of the DD task 
through the Task Maintenance window performs the same actions as described above. 
However, performing a due date supplement is the preferred method over changing the date of 
the DD task.

For jobs sent to the background processor, the description of the job reads "Due Date 
Change—scheduled by: [time]" under the Mass DLR Reconcile job type description. For a 
more detailed description of what information displays on the DLR based on due dates, review 
the M6.0.12 enhancement entitled Reconcile—Create new issue from appropriate active issue.
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Inventory Management enhancements
Reconcile—Node address change no longer reconciles 
unaffected ports

This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Prior to this enhancement, when a node address was changed with a soft override on the 
Equipment window’s Port Addresses tab, all connections associated with the equipment were 
reconciled instead of just those connections associated with the particular port address that 
changed. This resulted in new issues needlessly being created for connections.

New logic has been added such when you change a node name, only connections associated 
with the changed port address are reconciled. This new logic decreases the number of issues 
created for a connection, decreases the amount of data stored in the database, and decreases 
the amount of data through which you must navigate.

Reconcile—Reverse sequencing of blocks
This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Prior to this enhancement, locations of a reconciled block did not always end up in the correct 
sequence. For example, the following reconciled blocks should reflect the Block 2 locations in 
reverse sequence: Block 1—AB, Block 2—CB, Block 3—CD.

Now, logic has been added to reverse sequence reconciled blocks based on their locations. 
This change affects Equipment, Facility, EPA, Optical, SONET/SDH, DLC, and Protected 
Network Route blocks. The logic that dictates whether or not to reverse sequence the locations 
of a block is listed below. Note that the use of the term "match" in the following list means the 
locations are either identical or are in the same building.

If location A and location Z of the reconciled block are identical, no reverse sequencing 
occurs.
If there is no adjacent block either above or below the reconciled block, no reverse 
sequencing occurs.
If there are adjacent blocks both above and below the reconciled block, reverse 
sequencing occurs if the reconciled block's location A matches the location A of the block 
below AND if the reconciled block's location Z matches the location Z of the block above.
If there is only an adjacent block above the reconciled block, reverse sequencing occurs if 
the reconciled block's location Z matches the location Z of the adjacent block.
If there is only an adjacent block below the reconciled block, reverse sequencing occurs if 
the reconciled block's location A matches the location A of the adjacent block.
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Reconcile—Run in the background
This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

A new system preference has been added entitled Automatically Send all Equipment and 
Equipment Spec Edits to the background. Refer to the New preferences section for details 
regarding this preference. 

When this new preference, which is applicable for equipment and equipment specification 
edits only, is set to "Y", the code stops counting affected DLRs when at least one is found. A 
new message appears asking, "One or more designs will be affected. Do you want to 
continue?". If Yes is selected, the job is automatically sent to the background and a second 
message appears asking for your background print options. If No is selected, nothing is sent to 
the background and the changes that triggered the reconcile are not saved. You are returned to 
the Equipment or Equipment Specification window.

Note that this new preference is independent of existing functionality that counts affected 
DLRs and makes the determination to run in the foreground vs. the background based on the 
existing preference entitled Maximum Number to Reconcile in Foreground. If the new 
preference is set to "N", this existing functionality still runs. If the new preference is set to 
"Y", the existing functionality is overridden with the new functionality.

The new preference is located in a new folder: Inventory Management>Reconcile. 
Additionally, the following existing preferences have been moved to this new folder:

Allow Cascading Reconciliation when Pending Assignments are Saved
This preference was renamed to Process Cascade Reconciliation for Pending 
Assignments, and its choices were changed. For details on this change, refer to the 
New preferences section of this chapter.

Commit Each Mass Reconciled Design
Maximum Number to Reconcile in Foreground
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Inventory Management enhancements
CLR Cross Connect Report changes
Customer Issues 202369 and 202370

The following changes affect the links for Preview CLR/DLR and Print CLR/DLR.

The existing Cross Connect section of the Cross Connect Report has been renamed to SONET/ 
SDH Cross Connect section. Previously, this section displayed the assignments alphabetically. 
Now, this section displays assignments ordered in the way the assignments were made. 

A new section, the Optical Cross Connect section, has been added to the Cross Connect 
Report. This section displays two new sub-sections: Working Path and Protect Path. The 
information in these sub-sections includes the network location, NEID/TID, network, port in, 
and port out.

Additionally, the ability to access the Cross Connect Report has changed. Specifically, the 
CLR Cross Connect Report was previously accessible from a tab that was only visible for 
SONET/SDH. Now, that same tab is visible for optical as well.

PCONDES task enhanced to handle change orders
Customer Issue 264016

In M6.0.11, the Physical Connection Design (PCONDES) task was introduced as a system 
task that automatically performs connection design for new physical connections on new 
orders.

In M6.0.13, the PCONDES task has been enhanced to handle change orders as well as new 
orders. Specifically, the PCONDES task now allows for change orders to disconnect the 
existing assignments to the element for a physical connection, and re-assign a new port if the 
rate code changed.

Note that this enhancement does not include the ability to move assignments from one 
DSLAM to another.
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Expiration dates for condition codes
Expiration dates can now be specified for condition codes assigned to the types of resources 
listed below. When one of these resources is used, the expiration date is checked to see if the 
condition code is expired or not. A new Expiration Date field has been added to the Condition 
Code Assignment window, and to the Condition Code Range Assignment window. 
Additionally, the Equipment Inventory window now states the expiration date next to the 
equipment, for example: DS3CARD [BLOCKED through mm/dd/yyyy]. Following are the 
resource types to which this enhancement applies:

Circuit position
Cable pair
Mounting position
Port address

Accessing online Help for this enhancement
Open the online Help and type the following new field name, or the existing window names to 
which the field was added, in the Search field to learn how to use this feature.

Expire Date field
Condition Code Assignment window
Condition Code Range Assignment window—Mounting Position Condition Codes tab
Condition Code Range Assignment window—Port Address Condition Codes tab

Optical group assign
Currently, optical group assign path analysis is performed for each group-assigned optical 
connection, but the analysis only picks up the endpoints of the base connection and selects the 
first available path between those points. This path may or may not be the same path that is 
used by the base connection. The purpose of this enhancement is to change optical group 
assignment functionality so the group-assigned connections use the same path as the base 
connection.

Now, when you group-assign optical connections, the system uses the same working and 
protect path as the base connection. If an available channel cannot be found, an error displays 
the connection of the first segment that did not have available channels and the owning 
network of the connection. If the Same Channel Assignment Ind for a network is checked, and 
an equivalent channel cannot be found across the path while group assigning, an error message 
displays the network name where the equivalent channels could not be found.
218 MetaSolv Software, Inc.



Inventory Management enhancements
Project field added to Service Request Search window
Customer Issue 241135

The Service Request Search window has been modified to include a new search field. Now, 
when "Telephone Number" is selected in the Search By drop-down field, the new Project field 
is available to use in your search criteria.

Accessing online Help for this enhancement
Open the online Help and type the following new field name, or the existing window names to 
which the field was added, in the Search field to learn how to use this feature.

Project field
Service Request Search window: Search by PSR Telephone
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Order Management enhancements

Network Location Search window now available from the PSR 
PRILOC/SECLOC tab
Customer Issue 253509

When assigning a network location on the PSR PRILOC/SECLOC tab, the network location is 
selected from a drop-down list. The drop-down list is generated based on the data entered prior 
to clicking the drop-down arrow. While this functionality remains in place, you can now also 
select a network location by using the Network Location Search window.

To accomplish this, new functionality has been added behind the existing Locations button. 
Previously, the Locations button was only visible on the PRILOC/SECLOC tab when the End 
User radio button was selected. Now, the Locations button is also visible when the Network 
Location radio button is selected. When clicked while on the PRILOC/SECLOC tab, it still 
brings up the End User Location Search window. When clicked while on the Network 
Location tab, it now brings up the Network Location Search window. This is the same search 
window that is accessed by clicking Inventory Management>Inventory Management 
Setup>Network Areas, and then selecting Associate Network Location from the pop-up menu 
on the Network Location tab. The only difference is when the Network Location Search 
window is opened from Network Areas, you can select multiple network locations. When the 
Network Location Search window is opened from the PSR PRILOC/SECLOC tab, it only 
allows you to select one network location.

Network Area field added to IP Address Assignment window
Customer Issue 202180

The Network Area field has been added to the IP Address Assignment window. The new field 
is a drop-down, such that typing the initial letters of the network area generates a drop-down 
list based on matching criteria. The existing Network Item field has been modified such that it 
is now a drop-down list that is generated based on the selected network area.

Accessing online Help for this enhancement
Open the online Help and type the following new field name, or the existing window name to 
which the field was added, in the Search field to learn how to use this feature.

Network Area field
Ip Address Assignment window
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Order Management enhancements
User-defined task reject reason codes
You can now specify your own task reject reason codes that can then be selected when a task 
is rejected.

A new category of "Reason the Task was Rejected" is now available in the Category drop-
down list on the Valid Values Maintenance window within Application Setup>Valid Values. 
This enables you to specify your own reject task reason codes.

The Reject Task window includes a new drop-down field, Task Reject Reason. A new 
preference, Enable Task Reject Reason Codes, controls whether or not this new drop-down 
field is enabled or disabled. If enabled, you can select a Task Reject Reason from the drop-
down list which is generated based on the valid values that you defined in Application Setup. 
When the Task Reject Reason field is enabled, it is not required to be entered; however, the 
application requires that one of the fields, either the new Task Reject Reason field or the 
existing Service Request Note—Reject Reason text field, be entered.

Finally, if a Task Reject Reason is selected on the Reject Task window, a service request note 
is automatically generated that reflects the task reject reason.

Accessing online Help for this enhancement
Open the online Help and type the following new field name, or the existing window names to 
which the field was added, in the Search field to learn how to use this feature.

Task Reject Reason field
Reject Task window

Trouble e-mail notifications
Customer Issue 252208
Previously, trouble e-mail notifications were sent from the Background Processor Server 
through the MicroSoft Outlook client, which had to be installed on the server. Now, trouble e-
mail notifications are sent using Java mail utilities. The from address used on the trouble e-
mail notifications, and the server from which the notifications are sent, can now be specified 
through user preferences. Refer to the New preferences section below for the preferences 
entitled From Mail and Host Name.
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Application-wide enhancements

Custom extension enhancements
In M6.0.12, custom extensions were introduced which included ten supported execution 
points. M6.0.13 introduces three additional supported execution points which are briefly 
described below. For detailed information regarding custom extensions, including the new 
execution points introduced with this release, refer to the Custom Extension Developer’s 
Reference "Appendix A: Supported Execution Points".

Task Complete
MetaSolv Solution provides the ability to complete a task assigned to an order. This execution 
point enables you to extend logic that will execute when a task completes, either manually 
from the gui or automatically from the System Task Server.

Select Component or Element
MetaSolv Solution provides the ability to automatically design physical connections through 
the PCONDES task. This execution point enables you to extend logic that is triggered when 
the PCONDES task is executed, either manually from the gui or automatically from the 
System Task Server. The extension logic enables you to select the appropriate component or 
element to use in the physical design of the connection. It executes prior to the existing 
PCONDES auto-provisioning logic. If a component or element is successfully selected by the 
extension logic, the existing PCONDES auto-provisioning logic is bypassed. If a component 
or element is not selected by the extension logic, the existing PCONDES auto-provisioning 
logic still executes. 

Select Port Address
MetaSolv Solution provides the ability to automatically design physical connections through 
the PCONDES task. This execution point enables you to extend logic that is triggered when 
the PCONDES task is executed, either manually from the gui or automatically from the 
System Task Server. The extension logic enables you to select the appropriate port address to 
use in the physical design of the connection. It executes prior to the existing PCONDES auto-
provisioning logic. If a port address is successfully selected by the extension logic, the existing 
PCONDES auto-provisioning logic is bypassed. If a port address is not selected by the 
extension logic, the existing PCONDES auto-provisioning logic still executes.

Operational Reports upgrade
The Operational Reports tool kit and universes have been upgraded to be compatible with 
Business Objects XI.  The reports are backward compatible with previous M6 releases so that 
existing customers can use the new version.
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New preferences
New preferences

Automatically Send all Equipment and Equipment Spec Edits to 
the background

This new preference supports the enhancement entitled Reconcile—Run in the background, 
described previously in this chapter.

Treeview Location: Inventory Management>Reconcile

Type: System

N (default)

Reconcile may or may not be performed in the background, depending on the number of 
affected DLRs and the value specified in the existing preference "Maximum Number to 
Reconcile in Foreground".

Y

Reconcile is performed in the background.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management>Reconcile, and then click the Automatically Send all Equipment and 
Equipment Spec Edits to the background link to read more about this preference.
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Enable Task Reject Reason Codes
This new preference supports the enhancement entitled User-defined task reject reason codes, 
described previously in this chapter.

Treeview Location: Work Management>Work Queue Management

Type: System

N (default)

The Task Reject Reason field on the Reject Task window is disabled.

Y

The Task Reject Reason field on the Reject Task window is enabled.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Work Management> 
Work Queue Management, and then click the Enable Task Reject Reason Codes link to 
read more about this preference.

Make Transfer Order Editable
Prior to this enhancement, PSR transfer orders could only be opened as View Only. Now, PSR 
transfer orders have the option to be opened as Edit, based on this new preference. 

Treeview Location: Service Request>Product Service Request - PSR

Type: System

N (default)

Transfer orders are opened as View Only.

Y

Transfer orders are opened as Editable.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request, and then click the Make Transfer Order Editable link 
to read more about this preference.
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New preferences
From Mail
Customer Issue 252208

This new preference supports the enhancement entitled Trouble e-mail notifications, described 
previously in this chapter.

Treeview Location: Trouble>Mail Notification

Type: System

Text field

Enter a valid e-mail address ID that is used for the "From Address" on e-mail trouble 
notifications. For example, jsmith@metasolv.com.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Trouble>Mail 
Notificaiton, and then click the From Mail link to read more about this preference.

Host Name
Customer Issue 252208

This new preference supports the enhancement entitled Trouble e-mail notifications, described 
previously in this chapter.

Treeview Location: Trouble>Mail Notification

Type: System

Text field

Enter a valid host name from which e-mail trouble notifications are sent. For example, 
STMP1.metasolv.com (where STMP1 is a machine name).

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Trouble>Mail 
Notification, and then click the Host Name link to read more about this preference.
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Process Cascade Reconciliation for Pending Assignments
This preference was previously named "Allow Cascading Reconciliation when Pending 
Assignments are Saved". The preference previously resided in the folder Inventory 
Management>Connection Design, and the choices were Y/N. A prodfix SQL script provided 
with the release resets the value of this preference as follows:

If it was previously set to Y, it is now set to Save of Design.
If it was previously set to N, it is now set to Due Date completion.

Treeview Location: Inventory Management>Reconcile

Type: System

Process cascade reconcilation for pending assignments during:

Save of Design (default)

Reconcile occurs when the design is saved.

Design Task Completion

Reconcile occurs when the design task is completed.

Due Date Completion

Reconcile occurs during Due Date completion.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management>Reconcile, and then click the Process Cascade Reconciliation for Pending 
Assignments link to read more about this preference.
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Appendix L: What’s New in 6.0.14
This appendix documents enhancements that are new with version 6.0.14 of MetaSolv 
Solution.

Architecture changes
This release of MetaSolv Solution is now supported on HP Itanium, which supports HP-UX 
11.23 64 Bit and 64 Bit JAVA. Jbroker is not supported, and is therefore not installed, with 
M6.0.14 when the HP Itanium platform is selected. As a result, all API access must be done 
through the XML-APIs.

Inventory Management enhancements

Reconcile—Run in the background and specify print options
This change is part of the ongoing Reconcile enhancement theme that resulted from the User 
Group.

Prior to this enhancement, the option to run reconcile on the background processor was based 
on a combination of two things:

The setting of the preference entitled Number of DLRs to Reconcile in the Foreground.
The actual number of DLRs found to be reconciled.

This option is still available, but now there is also a preference available that allows you to 
indicate that reconcile should always run on the background processor. In addition to this new 
preference, entitled Send All Mass and Cascade Reconcile Jobs to the Background Processor, 
there are nine new print option preferences that let you specify how you would like the Circuit 
Layout Report to print. The print option preferences are all user preferences, while the Send 
All Mass and Cascade Reconcile Jobs to the Background Processor preference is a system 
preference. For detailed information on all ten of these preferences, refer to the “New 
preferences” section of this document.
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PCONDES and VCONDES task enhancements
Customer Issue 264016

In M6.0.11, the Physical Connection Design (PCONDES) task and Virtual Connection Design 
task (VCODES) were introduced as system tasks that automatically performed connection 
design for new physical and new virtual connections on new orders. In M6.0.13, the 
PCONDES task was enhanced to handle change orders as well as new orders. Specifically, the 
PCONDES task allowed for change orders to disconnect the existing assignments from the 
element for a physical connection, and re-assign a new port if the rate code changed. It was 
noted that the enhancement did not include the ability to move assignments from one DSLAM 
to another.

In M6.0.14, the PCONDES task now has the ability to move assignments from one DSLAM to 
another for a change order involving a rate code change. Prior to this enhancement, the 
PCONDES task only searched for an available port on the same DSLAM. If an available port 
was not found, an error was thrown. Now, if the PCONDES task searches for an available port 
on the same DSLAM and does not find one, the search continues on another DSLAM until an 
available port is found or until searching all defined DSLAMs is exhausted.

The VCONDES task was also enhanced to help support the new PCONDES task functionality. 
The PCONDES task starts the process by finding the available port, and the VCONDES task 
finishes the process by moving the all virtual connections to the new port. Prior to this 
enhancement, the VCONDES task was only capable of moving all the virtual connections to 
another port on the same DSLAM. Now, the VCONDES task has the ability to move all the 
virtual connections to another port on a different DSLAM. It is important to note that when 
dealing with virtual connections, the PCONDES task must precede the VCONDES task in the 
provisioning plan.

Performance improvement—creation of optical design block
Customer Issue 255180

On the Connection Design window, the creation of optical design blocks performance has 
been improved. A new user preference was added to support this enhancement. For detailed 
information on the new preference associated with this enhancement, refer to New Preferences 
section of this document for the description of the preference “Prompt to Save Issue Before 
Design Changes for Optical Network”.
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Inventory Management enhancements
Performance improvement—path analysis
Within the Provisioning Assistant, path analysis performance has been improved. Changes 
were made to two separate parts of the logic—path validation and path algorithm. To support 
this enhancement, two new fields have been added to the Provisioning Assistant: Select Exit 
Network Element window. The new fields are the Use Rapid Path Validation checkbox, and 
the Custom Tuning drop-down field.

Use Rapid Path Validation checkbox
Select the Use Rapid Path Validation checkbox to run the new path validation which provides 
faster response time for large networks. Therefore, you would want to select the checkbox for 
large networks, or for networks with a large number of paths. The checkbox should remain 
unselected for: 

SONET networks.
networks requiring same channel assignments.

Custom Tuning drop-down field
Previously, the path analysis algorithm always returned the same number of paths. Now, you 
can select one of the following choices from the Custom Tuning drop-down field which 
impacts either the processing time or the number of paths returned. The choices are similar to 
a sliding scale where the two ends of the scale equate to maximum speed / fewest paths 
returned and maximum paths returned / slowest processing time.

It is important to note that the maximum number of hops and the maximum number of paths 
were, and still are, limiting factors in the paths returned. Therefore, if you truly want all 
available paths returned, the values for these fields need to be set to large values so they do not 
limit the available paths returned.

The Custom Tuning drop-down choices, and their corresponding descriptions, are:

Fastest results

The algorithm processes in the quickest manner and returns the fewest paths. If you need 
only one path, or just a few paths, this would be the best setting.

Faster results

The algorithm returns more results than the previous choice, but takes slightly more time 
to process the results.

Balanced results

The algorithm spends longer looking for additional paths, and may or may not return more 
paths.

More paths
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The algorithm spends even longer than the previous choice looking for additional paths, 
and may or may not return more paths.

Most paths

The algorithm spends the longest amount of time looking for additional paths. If you need 
to analyze a significant number of available paths with less regard to processing time, this 
would be the best setting.

Accessing online Help for this enhancement 
Open the online Help, and type the following existing procedure name, or new field names, in 
the Search field to learn how to use this feature.

Provisioning Assistant - Select Exit Drop Nodes
Use Rapid Path Validation Checkbox
Custom Tuning field
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Inventory Management enhancements
Fiber Based Broadband Delivery technology module
A new technology module has been added that supports topographical designs of various HFC 
and FTTx networks. This technology module is a software option that can be purchased. For 
detailed information, refer to the Fiber Based Broadband Delivery Technology Module Guide. 
To locate this guide, click the Knowledge tab on the Oracle MetaLink Web site (https:// 
metalink.oracle.com).

Five new network templates comprise the Fiber Based Broadband Delivery technology 
module. Note that new component relationships (connections) have been modeled into the 
network templates. These connections are comprised of physical connections between various 
components and virtual connections between customer site and various originating points.

New network templates:

Access Node Network
CMTS Network
Hybrid Fiber Coax
Transmitter/Receiver Network
Video Network

In addition to the new network templates, changes have been made to the existing network 
template under IP called MetaSolv TM IP Network. Specifically, new component types have 
been added to this existing network. New component relationships have also been added that 
connect these components. The new components are:

Call Manager
Voice Gateway
Signal Gateway
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Order Management enhancements

Searching for trouble tickets based on user data
Customer Issue 250653

In a previous release, the Trouble Ticket Queue window was enhanced for performance 
improvement. Specifically, the Search Criteria link was added to the Trouble Ticket Queue 
window which, when clicked, opens the Ticket Queue - Search Criteria window. The Search 
Criteria window allows you to change the actual retrieval sql. Previously, the Trouble Ticket 
Queue window always ran the same sql statement and then filtered the returned records. 
Adding the Ticket Queue - Search Criteria window improved runtime because it reduced the 
number of returned records, as opposed to returning a large number of records and then 
applying a filter to them.

This enhancement builds on the previous performance improvement enhancement by allowing 
you to further refine the sql statement. Specifically, the Column Name drop-down field on the 
Ticket Queue - Search Criteria window now includes Trouble user defined data fields. This 
allows you to search for trouble tickets based on user data, which can improve performance by 
reducing the number of tickets returned.

The following provides an example of how this works: if you defined a user data field entitled 
Maiden Name on the Trouble Management User Data window (Application Setup>Order 
Managmenet Setup> User Data - Trouble), the field Maiden Name would then appear in the 
Column Name drop-down field on the Ticket Queue - Search Criteria window.

Accessing online Help for this enhancement
Open the online Help, and type the following existing window, procedure, or field name in the 
Search field to learn how to use this feature. The procedure and field name have been updated 
to reflect this enhancement.

Ticket Queue - Search Criteria window
Setting up search criteria
Column Name
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Order Management enhancements
PSR Order Split (phase two)
Customer Issue 262335

In M6.0.12, the Order Split menu option was introduced. The Order Split menu option is 
located on the Service Request Search list window’s right-click pop-up menu, and is enabled 
only for open PSR orders. This provided the ability to split a PSR order into two separate 
orders.

The split is accomplished by selecting items from the original order that are to be split out to a 
second order. The order information defaults from the original order, but can be changed on 
the new order. Order Elements of User Data, Contacts, Sales Module, and Links can be copied 
over to the new order. Also, the option of relating the two orders, as either parent/child or 
child/parent, is available at the time of the split.

Prior to this release, only Level 1 item types of PRBUNDLE, NPSPROD, and CKTPROD, 
and their Level 2 child items, were available for selection on an order split. Now:

If the Level 1 item is selected, or if the Level 1 item is selected and all of the Level 2 items 
are selected, then the Level 1 item and all of its children are moved to the new order.
If some of the Level 2 items are selected, then the selected Level 2 items and all of their 
children are moved to the new order, and the Level 1 parent item is either duplicated or 
copied to the new order, depending on the following:

If the Level 1 parent item is type PRDBUNDLE, NPSPROD or CKTPROD, then the 
Level 1 item is duplicated—i.e. a new instance of the Level 1 item is created—on the 
new order.
If the Level 1 parent item is type LINEPROD, SYSTEM, ISDNTRKPRD, 
LDTRKPRD or DTTRKPRD, then the Level 1 item is copied—i.e. its the same 
instance of the Level 1 item—to the new order. In this scenario, an MPO situation 
occurs because the Level 1 item is copied, not duplicated, from the selected order to 
the new order.

As stated previously, splitting an order is only applicable to open PSR orders. Specifically, the 
Order Split menu option is disabled for the following cases:

Order status is Due Date Task Completed or All Tasks Completed.
Supplement Type is Cancel.
Order activity is Suspend.
Order has an associated Gateway Event with a status of Waiting, Sending, In Progress, or 
Error.

The Order Split menu option opens the Order Split window. On the Order Split window, 
functionality is applicable only to:

Items that do not have pricing.

Items with pricing—this includes items with child items that have pricing—are not 
available for selection.
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Level 1 and specified Level 2 items.

All Level 1 items are available for selection, however, not all Level 2 items are available 
for selection. Only Level 2 items based upon following Level 1 item types are available 
for section:

CKTPROD
LINEPROD
DTTRKPRD
LDTRKPRD
ISDNTRKPRD
NPSPROD
PRBUNDLE
SYSTEM

The following table further illustrates this point:

Table 2: Product Names and order split availability

Product 
name

Item available 
for selection

Circuit Product Level 1 and Level 2

Line Product Level 1 and Level 2

Dial Tone Trunk Product Level 1 and Level 2

Long Distance Trunk Product Level 1 and Level 2

ISDN Trunk Product Level 1 and Level 2

Non Premise Product Level 1 and Level 2

Product Bundle Level 1 and Level 2

Network System Level 1 and Level 2

Directory Request Level 1 only

Internet Dial up Level 1 only

Message Trunk Product Level 1 only

Web Host Level 1 only
234 MetaSolv Software, Inc.



Order Management enhancements
Accessing online Help for this enhancement
Open the online Help and type the following updated fields, concept, window, or procedure in 
the Search field to learn how to use this feature.

Copy Order Elements Checkboxes
Order Split
PSR Order Split Selection Window
Splitting an Order
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New preferences

Send All Mass and Cascade Reconcile Jobs to the Background 
Processor

This new preference replaces the existing preference entitled Automatically Send All 
Equipment and Equipment Spec Edits to the Background. This is one of ten new preferences 
that supports the enhancement entitled “Reconcile—Run in the background and specify print 
options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile

Type: System

N (default)

Reconcile may or may not be performed in the background, depending on the number of 
affected DLRs and the value specified in the existing preference entitled Maximum 
Number to Reconcile in Foreground.

Y

Reconcile is performed in the background.

When this preference is set to Y, the notification regarding a reconcile job being needed is 
not displayed. In the previous release, the Background Print Options window would 
always appear prior to running a reconcile job in the background. With this release, the 
Background Print Options window only appears the first time the user runs a reconcile job 
in the background; after that, the window no longer appears.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile, and then click the Send All Mass and Cascade Reconcile Jobs 
to the Background Processor link to read more about this preference.
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New preferences
Include CLR
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

N

CLR information is not included in the Circuit Layout Report.

Y (default)

CLR information is included in the Circuit Layout Report.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Include CLR 
link to read more about this preference.

Include DLR
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

N (default)

DLR information is not included in the Circuit Layout Report.

Y

DLR information is included in the Circuit Layout Report.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Include DLR 
link to read more about this preference.
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Include GLR
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

N (default)

GLR information is not included in the Circuit Layout Report.

Y

GLR information is included in the Circuit Layout Report.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Include GLR 
link to read more about this preference.

Lines to Print
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

All Lines (default)

All design lines are printed on the Circuit Layout Report.

Printable Lines

Design lines that have the Print checkbox selected are printed on the Circuit Layout 
Report.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Lines to Print 
link to read more about this preference.
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New preferences
Number of Copies
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

Enter the number of copies of the Circuit Layout Report to be printed. If not set, the 
number of copies defaults to 1.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Number of 
Copies link to read more about this preference.

Print List of Circuits
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

N (default)

The list of circuits is not included in the Circuit Layout Report.

Y

The list of circuits is included in the Circuit Layout Report.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Print List of 
Circuits link to read more about this preference.
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Print List of Exceptions
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

N (default)

The list of exceptions is not included in the Circuit Layout Report.

Y

The list of exceptions is included in the Circuit Layout Report.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Print List of 
Exceptions link to read more about this preference.

Printer
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

Viewable only. This value defaults to the printer selected the first time a job was sent to 
the background processor.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile > Background Print Options, and then click the Printer link to 
read more about this preference.
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New preferences
Suppress Background Print Options Window
This is one of ten new preferences that supports the enhancement entitled “Reconcile—Run in 
the background and specify print options”, described previously in this chapter.

Treeview Location: Inventory Management>Reconcile>Background Print Options

Type: User

N (default)

The Background Print Options window appears, allowing you to enter background print 
options for the Circuit Layout Report that are applicable at the user level.

Y

The Background Print Options window does not appear.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Reconcile>Background Print Options, and then click the Suppress 
Background Print Options Window link to read more about this preference.
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Prompt to Save Issue Before Design Changes for Optical 
Network

This new preference supports the enhancement entitled “Performance improvement—creation 
of optical design block”, described previously in this chapter. This preference is utilized by the 
Connection Design window when the Network link is clicked. Specifically, the design must be 
saved prior to entering the optical network design, and this preference gives each user a choice 
of how to save the design.

Treeview Location: Inventory Management>Connection Design

Type: User

Prompt user with save options before entering optical design. (default)

When you click the Network link on the Connection Design window, a prompt window 
appears stating "The design must be saved prior to adding or updating optical block design 
lines. Do you want to save a new issue?". The available choices are:

Yes—save the design as a new issue.
No—save the design as the current issue.
Cancel—exit back to the Connection Design window.

Automatically save current issue before optical design.

When you click the Network link on the Connection Design window, the design is 
automatically saved as the current issue. A new issue is not created.

Save a new issue before entering optical design.

When you click the Network link on the Connection Design window, the design is 
automatically saved as a new issue. A new issue is created.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management > Connection Design, and then click the Prompt to Save Issue Before Design 
Changes for Optical Network link to read more about this preference.
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New preferences
Retrieve Child Connections Riding Provisioned Connections in 
Sonet Hierarchy

This preference was added to improve performance on the Sonet Hierachy window. 
Previously, child connections were always displayed in the hierarchy. Now, you have the 
option to exclude child connections from displaying in the hierarchy by setting this preference 
to N.

Treeview Location: Inventory Management>Network System

Type: System

N

Child connections riding provisioned connections are not displayed in the Sonet 
Hierarchy.
Y (default)

Child connections riding provisioned connections are displayed in the Sonet 
Hierarchy.

Allow Old Non-Recurring Prices Assignable to Product
This preference was added to provide the ability to assign an expired non-recurring price to a 
product for an existing customer that is currently being charged that price. Previously, once a 
non-recurring price was expired in the product catalog, it was no longer available for selection 
on an order. 

For example, an existing customer has phone service X that has an associated non-recurring 
price of $35. Three months later, that $35 non-recurring price is expired in the product catalog 
and changed to $40. Afterwards, the customer who is being charge $35 for phone service X 
calls and requests the same phone service for her son. Because she is an existing customer that 
is currently being charged the original price of $35, the application can now display both the 
old $35 price and the new $40 price (if preference is Y). 

Treeview Location: Service Request>Product Service Request - PSR

Type: System

N (default)

Non-recurring prices that are expired in the product catalog are not available for selection 
on an order.

Y

Non-recurring prices that are expired in the product catalog are available for selection on a 
change order for a customer that is currently being charged the expired non-recurring 
price.
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XML API Schema Enhancements

XML Inventory Management API
Customer Issue 248159

queryNetworkLocation

This new method supports the retrieval of multiple network locations from the MSS 
database based on input criteria.

queryEndUserLocation

This new method supports the retrieval of multiple end user locations from the MSS 
database based on input criteria.

getLocationRequest

This new method supports the retrieval a specific location from the MSS database based 
on the location ID.

deleteLocationRequest

This new method supports the deletion of a specific location in the MSS database based on 
the location ID.

updateLocationRequest

This new method supports the update of a specific location in the MSS database based on 
the location ID.

createLocationRequest

This new method supports the import of a location to the MSS database.

LSR Management API
A new version of LSR, LSR10, is now available with M6.0.14. The methods defined for this 
new release are identical to those defined in the previous LSR release, LSR9. Therefore, the 
methods are not listed here.
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Appendix M: What’s New in 6.0.15
This appendix documents enhancements that are new with version 6.0.15 of MetaSolv 
Solution.

Inventory Management enhancements

Reconcile—Pending mappings
Customer Issue 201172

Previously, pending mappings were supported by moving mappings to the latest queued up 
pending add assignment when making channel and port assignments. However, design line 
blocks with embedded enabled port assignments (EPAs) that were reconciled, either through 
mass reconcile or the circuit reconciliation window, lost their embedded equipment if the 
parent circuit had its mappings removed due to a queued up assignment.

Now, design line blocks do not lose their embedded EPAs when reconciled after mappings are 
moved to a queued up port or channel assignment.

Save CLR/DLR/TCO as an HTML file
Customer Issue 6418258

You can now save CLR, DLR, and TCO layout reports as an HTML file. This feature is 
available for special, facility, and trunk circuits; it is not designed for NGN connections.

When using this feature, each report for each circuit (selected on the Circuits tab of the Print 
window) will be stored in a separate file with an .htm (.html) extension. Saving a layout report 
as an HTML file can be done in addition to, or in place of, the existing printing and faxing 
features.

This feature is available by performing one of the following tasks:

Selecting Options>Group Print on the Service Request Connections window.
Processing a DLRD task (or a task with DLRD task behavior) in Work Management.
Using the Print TCO menu option on the TCIC tab of the Trunk Group Information 
window (for trunk groups only).
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This functionality is controlled by a new system preference entitled Allow Save of CLR/DLR/
TCO in HTML Format from Group Print. When the preference is selected, the Save As HTML 
checkbox will appear on the Group Print window for report types of CLR, DLR, and TCO. 
You can make selections for printing and saving options at the same time. 

If the Save As HTML option(s) is selected and you press the OK button, one of the following 
will occur:

If there are multiple circuits, a warning message will be displayed showing the number of 
circuits selected and targeted to be saved in the report. At this point, you can decide 
whether or not to continue, or press No to cancel the message and change your selections.
The File Save window will open and prompt you to select a directory and file name for 
each report. 

TCO
If the Save As HTML option was selected for a Trunk Circuit Order (TCO), there will be only 
one report per trunk group. The title of the File Save window will display either “TCO 
Summary”, or “TCO Detail”, based on your selection.

CLR/DLR
If the Save As HTML option was selected for a CLR (DLR), the report will be generated for 
each selected circuit on the Circuits tab. The title will display the report type (for example, 
CLR) and the ECCKT, so you can decide whether to save that particular report, or skip it. If 
you choose to skip it (by clicking Cancel on the File Save window), another message will 
show the number of remaining selected circuits, and will ask whether or not to continue with 
saving reports, or to skip those remaining. Note that the Print function, if selected, will not 
depend on the Save function. Therefore, the CLR (DLR) reports will be printed for all listed 
circuits.

Additional information
To save the report, you must select the appropriate directory, type a meaningful file name, and 
click the Save button. It is not necessary to type the file extension, because it will be defaulted 
to .htm. 

The Save to File button will also be available on the Print Preview window. Clicking this 
button opens the File Save window in the same manner as described above; however, it will 
open only once, and the saved file will only store the information that is displayed on the 
selected tab of the window (for example, CLR Admin, CLR Notes).
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Order Management enhancements
Order Management enhancements

PON and BAN fields added to ISR orders
Customer Issue 6381715

The Purchase Order Number (PON) and Billing Account Number (BAN) fields were added to 
the Administration section of ISR orders. These fields will be displayed on the corresponding 
ISR Print (Preview) forms. 

This functionality was added to allow using the PON as criteria when retrieving ISR orders by 
Service Request, by Connection, and by Tasks from the Service Request Search window. You 
will also be able to enter search criteria in the newly added BAN field when searching for ISR 
orders by Service Request. Note that the BAN field will not appear on any engineering 
windows or print forms.

Accessing online Help for this enhancement
Open the online Help and type one of the following new field names, or the name of the existing 
window to which the field was added, in the Search field to learn how to use this feature:

PON field
BAN field 
Administration Section

Application-wide enhancements

Custom extension enhancement
This release introduces a new execution point for custom extensions. For detailed information 
on custom extensions, including the new execution point introduced with this release, refer to 
the Custom Extension Developer’s Reference "Appendix A: Supported Execution Points".

Select Component or Element for virtual connections
MetaSolv Solution provides the ability to automatically design virtual connections through the 
VCONDES task. This execution point enables you to extend logic that is triggered when the 
VCONDES task is executed, either manually from the GUI or automatically from the System 
Task Server. The extension logic enables you to select the appropriate component or element 
to use in the virtual design of the connection. It executes prior to the existing VCONDES auto-
provisioning logic. If a component or element is successfully selected by the extension logic, 
the existing VCONDES auto-provisioning logic is bypassed. If a component or element is not 
selected by the extension logic, the existing VCONDES auto-provisioning logic still executes.
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New Preferences

Allow Trunk Group TCIC Renumber Preference
This new preference enables renumbering on the TCIC Maintenance tab when the Trunk 
Group Info window is opened from Inventory Management. This preference does not affect 
the behavior of the Trunk Group Information window when accessed from an order.

Treeview Location: Inventory Management>Connection Design

Type: System

N (default)

The TCIC Maintenance tab will not allow renumbering when accessed from Inventory 
Management – Trunk Group. 

Y 

The TCIC Maintenance tab will allow renumbering when accessed from Inventory 
Management – Trunk Group.

The benefit that this enhancement provides is that it allows TCIC renumbering when opened 
from Inventory Management. There may be companies that want their Engineering groups to 
update the TCICs on trunk groups without having to go through the process of creating an 
order. For example, TCIC information might not be available at order entry time and therefore 
might have to be added at a later time during the provisioning process.

Note: The trunk group tables are live tables, meaning that any modifications made to the 
TCICs will appear on the trunk group, regardless if the trunk group is on an order or not.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management>Connection Design, and then click the Allow Trunk Group TCIC 
Renumber Preference link to read more about this preference.
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New Preferences
Timeout Period (in minutes)
This preference provides timeout functionality that ends your session after the application has 
been idle for the period of time specified. When there is no mouse movement or keyboard 
activity for the specified period of time, your session ends and a message displays stating 
"Your session has timed out. Please login again if you need to continue working in the 
application."

The system administrator sets the Timeout Period in minutes. The Timeout Period must be set 
to ten minutes or higher. When a Timeout Period of less than ten minutes is entered, a message 
displays stating, "Please set the timeout minutes to a minimum of 10 minutes." The default for 
the preference is 0, which disables the timeout functionality. The system administrator should 
set the Timeout Period to a reasonable amount of time (15 minutes or more) to ensure that 
long-running processes have enough time to complete before being terminated.

Treeview Location: System Information

Type: System

Enter a minimum of 10 minutes to set your desired timeout period. This field defaults to 0. 

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the link for System Information, 
followed by the Timeout Period (in minutes) link to read more about this preference.

Allow Save of CLR/DLR/TCO in HTML Format from Group Print
This new preference enables you to save a layout report as an HTML file for CLRs, DLRs, and 
TCOs.

Treeview Location: Inventory Management>Connection Design

Type: System

N (default)

The Save As HTML option (checkbox) will not appear on the Group Print window.

Y 

The Save As HTML option (checkbox) will appear on the Group Print window for report 
types of CLR, DLR, and TCO.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management>Connection Design, and then click the Allow Save of CLR/DLR/TCO in 
HTML Format from Group Print link to read more about this preference.
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Prefix Last 2 digits of parent circuit for virtual facility designation 
in Optical Network

This new preference was added to prefix the last two digits of the parent connection with the 
designations created for the child connections. 

Treeview Location: Inventory Management>Network System

Type: System

N (default)

Only the first digit of the parent connection will be retained with the designations created 
for the child connections.

Y 

The last two digits of the parent connection will be prefixed with the designations created 
for the child connections. 

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management>Network System, and then click the Prefix Last 2 digits of parent circuit for 
virtual facility designation in Optical Network link to read more about this preference.

Always Enable User Data 
This new preference enables you to modify and save the fields in the Product Service Request 
User Data pop-up for all orders.

Treeview Location: Service Request>Product Service Request - PSR>New From

Type: System

N (default)

The fields in the Product Service Request User Data pop-up cannot be modified.

Y 

The fields in the Product Service Request User Data pop-up can be modified and saved for all 
orders.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request – PSR>New From, and then click the Always Enable 
User Data link to read more about this preference.
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New Preferences
Enable Auto Copy of Req/Standard items 
This new preference enables that the Standard and Required items will not get copied along 
with the selected items to a change order.

Treeview Location: Service Request>Product Service Request - PSR>New From

Type: System

N

Required and Standard items will not get copied along with the selected items to a change 
order.

Y (default)

All Required and Standard items will get copied along with the selected items to a change 
order.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Service 
Request>Product Service Request – PSR>New From, and then click the Enable Auto 
Copy of Req/Standard items link to read more about this preference.
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Appendix N: What’s New in 6.0.16
This appendix documents enhancements that are new with version 6.0.16 of MetaSolv 
Solution.

Supported software changes

Support for Adobe Acrobat 8
PDF reports generated in MetaSolv Solution now support Adobe Acrobat 8.

Support Internet Explorer 7
MetaSolv Solution now supports Internet Explorer 7. See the Setup Guide for details on 
registry settings that need to be changed.

Inventory Management enhancements

Trunk Group Search Capability
Customer Issue 6417967

This enhancement allows the user to search for a trunk group by either the “A” or “Z” location.

The trunk group search capability will be similar to the search capability within connection 
design in that the user can specify one location and the query will search both A and Z 
locations. The same search capability will occur when searching by Trunk Group Number 
(TGN) or Point Code. This allows maximum flexibility when searching for a trunk group and 
will eliminate the need for several different searches to locate the trunk group that the user 
wishes to use or view, etc.
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Add New Link on Trunk Group Search Window
Customer Issue 6417968

The user will now be able to create a new trunk group from the Trunk Group Search window. 
With this enhancement, an “Add New” link is available on the trunk group search window, 
which will allow the user to create a new trunk group and eliminate extra keystrokes.

Reusing Two Six Codes
Customer Issue 6872609

This enhancement enables the user to reuse the Two Six Code (TSC) of a trunk group. The 
system will check the status of the trunk group and if all trunk circuits in the trunk group are in 
“Pending Disconnect” status, the user will be able to reuse the TSC.

Router Host ID
Customer Issue 6658985

Prior to the 6.0.16 release, MetaSolv Solution did not populate the device hostname on the 
DLR for network assignments as is done for equipment assignments. This information, found 
in the Name field on the Managing an Element window within Network System Design, will 
now be populated in the MISC column on the DLR for network assignments.

To enable this functionality, new code was added to the logic that builds the network 
assignment DLR lines. All new network assignments will now contain this information, if 
applicable. To display this information on existing designs, the design block will simply need 
to be reconciled.

Order Management enhancements

Addition of Work Queue Column to Task tab of the Service 
Request Search Window
Customer Issue 6907112

For the 6.0.16 release, the Work Queue column was added to the display on the Tasks tab of 
the Service Request Search window. This will allow the user to see which Work Queue each 
task on the order is assigned to by clicking on the Tasks tab after searching for an order.

Expanding Location Name Field
Customer Issue 6372706

The End User Location Name Field (used throughout MetaSolv Solution) is only 25 characters 
long. Often location names in European and Asian geographies are truncated to conform to 
this field length. This enhancement expands the length of the End User Location Name Field 
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Application-wide enhancements
to 50 characters throughout the application except for areas where industry standards and 
regulations require 25 characters. Since OBF ASOG and LSOG specify 25 characters, the 
ASR and LSR applications will not be changed by this enhancement.

Provide Additional Information for Template-based Connections 
in PSR Tree View
Customer Issue 6854500

Prior to the 6.0.16 release, MetaSolv Solution did not populate the connection type name for a 
template-based connection in the PSR tree view. This often made it difficult to determine the 
correct connection when looking at the tree view prior to a circuit ID being assigned to the 
connection.

New logic was added to display the connection type name in the PSR tree view for a template-
based connection if the connection has not yet been assigned a circuit ID. Once the connection 
has been assigned a circuit ID, the circuit ID will be displayed in the tree view (as in prior 
releases). This will make it easier for a user to identify the correct connection in the tree view 
prior to a circuit ID being assigned.

Display of Order Number Along with Circuit IDs in the List of 
Circuits/Connections
Customer Issue 6394915

An order number link has been added for each connection on the ‘List of Circuits/
Connections’ Web page (accessible from the Customer Profile). This link will display the 
most recent PSR order number for any connections that have had a design issued. This 
enhancement will allow customer service representatives to more easily identify and open the 
last order used to create/update a circuit/connection. When this new Order Number link is 
clicked, the user will be taken to the Order Summary page where they can see additional 
details about the order. The user can then choose to open the PSR maintenance window to 
view/edit the order.

Application-wide enhancements

Support for Customer-defined Password Compliance
Customer Issue 6818058

Many enterprises (including Service Providers) have begun implementing more complex and 
sophisticated security policies. These policies often include a variety of validation rules and/or 
guidelines for how a user may define his/her password for logging into an application. 
However, MSS currently has its own built-in password validation rules that may or may not be 
consistent with these newly-defined security policies. 
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For these security policies to be effective and enforceable, the MSS administrator must have 
the option to disable the password validation within the MSS application. With the default 
password validation disabled, it becomes the responsibility of the administrator to replace this 
validation with an external set of rules. For example, these rules may be defined within the 
database profiles of the Oracle instance, or by another application entirely.

Along with this flexibility comes the necessity of the administrator to provide these rules to 
the user community. The MSS application must provide a means to display these 
administrator-defined rules whenever a user is prompted for his/her password. 

To allow an MSS administrator to define his/her own password policy, an existing system 
preference has been expanded which will allow the administrator to disable the system-
defined password validation rules. To disable the system-defined rules, the administrator will 
simply turn off the system preference. This preference is located in the Security folder and was 
previously identified as “Use MSS Password Expiration”. Because the functionality of this 
preference has been expanded, the name has changed accordingly to “Use MSS Password 
Validation, including Password Expiration”. When this preference is checked (default), MSS 
password validation will run; when it is not checked, the MSS password validation logic will 
be bypassed. Please note that even when MSS password validation logic has been turned off, 
the user will not be able to use the following three characters in his/her password: ‘{‘, ‘}’, and 
‘”’ (double quote).

Additionally, this enhancement provides the ability for an administrator to define a customer-
specific password compliance policy which will be displayed wherever a user has the option to 
change his/her password. The new Password Policy window is accessed under the 
Administration section of the navigator bar. An administrator must first enable the new 
Password Policy System Settings Checkpoint for this window under Security Permissions 
before he/she will be able to access the window.

Once a password policy has been defined, a “Show Password Policy” link will display 
wherever a user has the ability to change his or her password. For example, users will now 
have the ability to view the defined password policy when changing their password through 
the System Preferences window for User Information.

XML API enhancements

New Workflow to Process Billing Telephone Number
A new workflow, ProcessBillingTelephoneNumber, has been created to process billing 
telephone numbers. The functionality is the same as that of the CORBA API. Refer to the 
XML API Developer Reference for more details.
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New Preferences
New Element for portEquipmentName in the Response 
Structure for GetActivationDataByKeyRequest API

The Activation Report in MetaSolv Solution had a port equipment name column displayed 
that is now being exported as part of the response structure for the 
GetActivationDataByKeyRequest API. 

Annotated Schemas
The annotated XML API schemas are now in the Annotated_XML_API_Schemas.jar. This 
JAR file will be located under the MetaSolv Solution Developer Documentation Pack in the 
MetaSolv Solution 6.0 Developer Reference CD.

New Preferences

E-mailing of CLR/DLR/TCO
This enhancement enables customers to save CLR, DLR, and TCO reports to the MetaSolv 
Solution database in HTML format, and provides the ability to invoke a custom extension 
from the same screen where you print the CLR, DLR, or TCO reports. 

Treeview Location: Inventory Management>Connection Design

Type: System

N (default)

When the preference is set to N, the Email option will be unavailable in the Print window.

Y 

When the preference is set to Y, the user will be able to e-mail the CLR/DLR html page of 
ordered facilities and special circuits and the CLR/DLR/TCO html page of ordered trunks to 
all the associated employees in the following places:

Work Queue Manager>Options menu>Print Circuit Design, right-click menu of Design 
task>Print Circuit Design
Service Request Connections window>Options menu>Group Print
Connection Summary page of Connection Design window>Outputs menu>Print CLR/
DLR

Now the CLR/DLR html page of facility and special circuits and the CLR/DLR/TCO html 
page of trunks created via non-ordering scenarios can be e-mailed to all the associated 
employees from:

Outputs menu>Print CLR/DLR in Connection Summary page of Connection Design 
window
Options> Group Print in case of trunks in Connection Design Search window
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There are several different ways this custom extension can be used. One possible use of this 
extension is to retrieve the saved HTML files from the database and e-mail the files to the 
appropriate recipients. Other possibilities include displaying the HTML files on an Intranet or 
providing access to the HTML files from other applications.

For customers who want to create an automatic process for e-mailing reports, this 
enhancement provides the ability to associate e-mail addresses with employees and associate 
employees with network locations. These associations are used to determine the recipients of 
the reports. If employees that have been associated with the locations match those on the 
connections or the locations of the equipment, the employees will be included as recipients of 
the reports. 

A sample custom extension is provided for e-mailing the reports. For more information on 
how to design and implement custom extensions in MetaSolv Solution, refer to the Metasolv 
Solution Custom Extensions Developer’s Reference. 

Note: The trunk group tables are live tables, meaning that any modifications made to the 
TCICs will appear on the trunk group, regardless if the trunk group is on an order or not.

Accessing online Help for this enhancement
Open the online Help from the preferences window, click the links to Inventory 
Management>Connection Design, and then click the Enable HTML Email Preference link 
to read more about this preference.
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